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Getting Started with Light-O-Rama

Welcome to Light-O-Rama

Light-O-Rama is a computerized lighting system designed to control elaborate or simple lighting
displays. The Light-O-Rama system can be applied to almost any lighting situation, from stand-alone
controllers to synchronizing hundreds of controllers.

This page gives a high-level oveniew of how to start controlling your lights using Light-O-Rama:

e Getting Help about Light-O-Rama

e Important Terms and Information

e Connecting the Lights Using Light-O-Rama Controllers
o Creating a Show

For more detailed information, please see Light-O-Rama Concepts and the Light-O-Rama Software
Package.

Experienced users may wish to see what's new in the latest version of Light-O-Rama.

Getting Help about Light-O-Rama

This help file contains a lot of information about the Light-O-Rama Software Suite. If you need more
help, please \sit the Light-O-Rama website. Click the word "Support" at the top of the page to find
links to more resources, including tutorials, Frequently Asked Questions, our User Forum, and our
Help Desk.

Important Terms and Information

Companion Unit

A companion unit is a Light-O-Rama controller that receives lighting commands from another
source - either a PC running Light-O-Rama software, or from another controller known as a director
unit.

Control Panel

The Light-O-Rama Control Panel is a program that can be used to manage the Light-O-Rama
system on your PC. The Control Panel runs in the system tray (where the PC's clock is displayed).
Light-O-Rama is made up of a number of different programs, and the Control Panel is a convenient
way of accessing them. The Control Panel must be running in order to control shows from your PC.

Daisy Chain

This is the term generally used to describe the manner in which Light-O-Rama light controllers are
connected. A wire goes from the source (a PC running Light-O-Rama software or a director unit) to a
companion unit. Another wire goes from that companion unit to another companion unit, and so on,
until all companion units are "chained" together.

© 2022 Light-O-Rama, Inc.
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Do not put "Y"s or forks in the data cable. Only connect the units in this daisy chain configuration.
Data Cable

Light-O-Rama controllers can be connected using both data cables and phone cables, but you must
know which type of cable it is (for the purposes of Light-O-Rama, a cable is considered a data
cable if its wires are connected straight through).

How do you know if it is a data cable? Well, most likely the only cable that you will see that is not a
data cable is a wire that is intended specifically for phones. If you go to your local hardware store
and purchase a phone extension cable, then that wire is not a data cable. The distinction between
data cables and phone cables is important, because the wires are swapped around. There are
selectors or jumpers on most Light-O-Rama controllers that allow you to specify which wire type you
are using.

Only the wire coming into a controller (from the previous controller or from a PC running Light-O-
Rama software) should be used to determine which selector setting to use. The wire leaving a
controller (if there is one) can be of any type, and has no bearing on which selector setting should be
used. For example, if a controller has a phone cable coming in from the previous controller, and a
data cable leaving to the next controller, the selector should be set for "phone cable".

Director Unit

A director unit is a Light-O-Rama controller that sends lighting commands to other controllers
(known as companion units). Controllers can run individually in standalone mode, but to synchronize
multiple controllers together, they must be directed either by a PC running Light-O-Rama software,
or by a director unit.

Standalone sequences may contain lighting commands for a number of different units. A director
unit is a unit that is running standalone - i.e. not connected to a PC - that contains lighting
commands for other units cabled to it (the companion units). The director unit can also control its
own lights, simultaneously.

There is no difference in the hardware of a director unit and a companion unit - the only difference is
the mode that they are in.

A PC running Light-O-Rama software can also be thought of as a director unit, in that it can send
lighting commands to Light-O-Rama controllers. There must be one and only one director unit (or
PC running Light-O-Rama software) on a daisy chained group of controllers.

Hardware Utility

The Light-O-Rama Hardware Utility is a program that can be used to set up and test the hardware
used to control lights, as well as download sequences to standalone controllers or director units.

Phone Cable

Light-O-Rama controllers can be connected using either data cables or phone cables, but you must
know which type of cable you are using. See data cables for details.

Preview
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A preview is a representation of your light display. It defines the lighting elements, how they are
arranged, and what channels they use. Creating a preview is required before you can create a
sequence. One preview can be associated with multiple sequences. Update the preview once, and
the next time you open any sequence associated with that preview, the update will automatically be
applied. The display elements in a preview are referred to as ‘props'. You must add a prop to the
preview for every display element that you want to control. A prop could be a single string of lights, a

wireframe, an arch, a wreath, or a tree. In fact you can model just about any lighting element in a
preview.

The Sequencer program is used to create and modify previews.

Schedule

A schedule specifies when a show is to be played.

If the Light-O-Rama Control Panel is running on a PC, and its "Play Shows" section is set to Show
Player, then the schedule will be monitored, and shows will be started and stopped at the
appropriate times.

A show's schedule can be created or modified while a show is being edited in the "Create Shows"
section of the Control Panel.

Sequence

A sequence is a file that contains a set of lighting commands to be sent to Light-O-Rama
controllers. There are two types of sequences: musical sequences, which have an associated
music or video file that is to be played at the same time, and animation sequences, which do not.

Before creating a sequence, you must create a preview. The lights you can control in the sequence
are defined by the props in the preview.

Sequences can be grouped together into shows.

The Sequencer program is used to create and modify sequences.

Show

A show is a file that contains a number of sequences, and the order in which they should be played.
A schedule can be created to specify the times at which a show should be played.
The "Create Shows" section of the Control Panel is used to create and modify shows.

Standalone

A Light-O-Rama controller can be controlled by another controller (or a PC running Light-O-Rama
software), or it can control itself and/or other controllers, in standalone mode. A sequence,
created using the Sequencer, can be downloaded to a standalone controller using the Hardware
Utility. The controller can then be set up to run this sequence whenever it has power, or, if the unit
is a model with an internal clock, it can be instructed to run the sequence during a particular time.

© 2022 Light-O-Rama, Inc.



Getting Started with Light-O-Rama 11

A standalone controller whose sequence contains lighting commands for other controllers will
transmit those commands to the other controllers. In this case, the controller is known as a director

unit.

Unit

A unit is another term for a Light-O-Rama controller. Each unit has a number of circuits, each of
which can be used to control lights independently of each other. Each unit is identified by a unit ID.

Unit ID

Each unit has an identifier assigned to it, known as a unit ID. When a lighting command is sent to
a unit, all of the units that are daisy chained together can see that command. Howeer, the
command contains a unit ID; only the units having that unit ID will act upon that command.

For Light-O-Rama controllers, the unit ID is a two characters, each of which can have any of the
values 0, 1, 2, 3,4,5,6,7,8,9, A, B, C, D, E, and F. For example, "01", "25", "37", "5C", "BD", or
"E2". However, not all possible combinations are allowed: "00" and "F1" through "FF" are
disallowed.

Controllers other than Light-O-Rama controllers use different formats for their unit IDs.

Connecting the Lights Using Light-O-Rama Controllers

To connect lights using Light-O-Rama controllers, take the following three steps:

1. Determine the serial port and hook up a controller.
2. Select a unit ID.

3. Test the lights.
Step 1. Determine the Serial Port and Hook Up a Controller

Insert an SC485 conwerter into your PC's DB9 serial connector which you plan on using for the Light-
O-Rama network. If you are using a USB/RS-232 converter, then make sure that it is properly
installed, and that the SC485 conwerter is connected. If you're not sure what all this is about, simply
try to find a connector on the back of your PC that has nine pins and which will accept the SC485
adaptor.

Using a cable, connect a Light-O-Rama controller to the SC485 adaptor. Make sure that the LOR
controller is powered on. The LED in the controller should be blinking.

Using the Light-O-Rama Control Panel, start the Hardware Utility program. In the Hardware Utility's
Setup Comm Port section, use the Auto Configure button. This will cause the Hardware Utility to
look for the attached controller and determine which comm port is being used.

Step 2. Select a Unit ID

If your controller has unit ID selection switches, you can select its ID by adjusting the selectors to
the desired ID. If your controller does not have these unit ID selection switches, then you will need

to set its unit ID by using the Hardware Utility:

© 2022 Light-O-Rama, Inc.



12

Light-O-Rama v6.1.0

To set the unit ID using the Hardware Utility, connect one and only one unit to the PC using the
SC485 adaptor and a cable. In the Set Unit IDs section, go to Set New Unit ID, select the ID that
you wish to use for the controller, and click the Set Unit ID button. This button will only work on
new units that have never been assigned a unit ID (to change the unit ID of a unit that already has
one assigned, use the Change Existing ID section instead).

TIP: Assign unit IDs sequentially, starting at 01. This will make maintenance of the units faster.
Step 3. Test the Lights

With the unit connected to the PC, attach lights and power the unit on. In the Hardware Utility, click
the Refresh button in the top center of the screen. After a short time, your unit should appear in the
dropdown list to the right of the Refresh button. Select the unit, and you can then test the lights
using the various controls in the Test Unit's Operation section of the Hardware Utility.

TIP: Before clicking Refresh, set the Hardware Utility's Max Unit ID to as low a value as possible.
This is the maximum unit ID of controllers that you plan on using (you can always change it to a
higher value if you add more controllers later). Setting it to a low value makes the Hardware Utility
run faster (though it will not find any connected units with higher unit IDs).

Creating a Scheduled Lights Display
To create a lights display and hawe it run at certain times, take the following steps:

Make your sequences.
Make a show.

Make a schedule.
In on the Control Panel's "Play Shows" section, set the mode to "Show Player".

Eal e

Step 1. Make Your Sequences
Using the Sequencer, create the sequences that will be used in your show.

You can test how the lights will look for a sequence while in the Sequencer: Make sure Control
Lights is enabled, and that you have assigned the channels in the sequence to a controller that is
hooked up to your PC. Then, click the play button (which is the green arrow in the toolbar).

Step 2. Make a Show

A show is a collection of sequences. A show can be created in the "Create Shows" section of the
Control Panel.

Shows hawe seweral sections, each of which can have sequences:

e Background: Sequences listed in the "background" section will be played for the entire
duration of the show.

e Startup: Sequences listed in the "startup” section will be played when the show first begins.

e Animation and Main: After the "startup” sequences have completed, sequences in both of
these sections will run, until it is time for the show to stop.
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e Shutdown: When it is time for the show to stop, the "animation" and "musical" sequences
will stop running, and the sequences in the "shutdown" section will start. Only after the
"shutdown" sequences are finished will the show truly end.

When editing a show, you can add sequences to any of these sections by selecting the appropriate
section, and clicking the "Add" button at the top of the playlist.

After you have created your show, you should sawe it using the "Sawe" or "Sawe As" button. Assign
the show a meaningful name - this is the file name that you will be using in the next step.

Step 3. Make a Schedule
Reopen the show you created in step 2 by double-clicking on it while viewing the list of shows.
Go to the "Dates & Times" section.
If there isn't already a schedule entry, click the "Add" button to create one.

Select a start and end time that will allow the show to start at a convenient time for you to view it.
Adjust the days of the week and date range if desired. Then click Save to save your schedule.

Step 4. Turn On the Control Panel's "Show Player"
In the "Play Shows" section of the Control Panel:
¢ If the mode is currently Disabled, click the Show Player button.
¢ |f the mode is something other than Show Player, click the Disabled button, then click the

Show Player button.

Doing this will cause the Control Panel to monitor your schedule, and start and stop your show at
the appropriate times.

2 What's New?

What's New in the Latest Version

e What's New in Version 6.1.0

What's New in Version 6.1.0

Initial production release of the S6 Light-O-Rama Software Suite.
Big Changes
e Many functions that used to be separate programs are now part of the Control Panel. This includes:
o Defining your lighting networks (previously done in Network Preferences)

0 Monitoring the status of those networks (previously done in the Comm Listener)
o Creating shows (previously done in the Show Editor)
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o Checking if there are any issues with the show (previously done in the Verifier)
o0 Scheduling shows (previously done in the Schedule Editor)

o Playing shows (previously done in the Show Player)

o Creating SD cards for Light-O-Rama Director units (previously done in the Hub)

e There is a new phone app, available for Android, iPhone, and iPad, that allows your phone to
communicate with the Control Panel

Licensing

Registering your software is done from the new Control Panel.

The Startup and Shutdown sections of shows are now available at all license levels.

Show On Demand is now available at all license lewels.

Using calendar dates when creating a show schedule is now available at all license lewels.
Your license is also used when logging into the phone app.

Control Panel

Access the Hardware and SenoDog Utilities.

Access the PixConl6 configuration tool.

Find PixieLink controllers on the network.

Network Preferences and network status are combined onto a single page. The network log can be

displayed in a separate window if desired (similar to the Comm Listener window, but nicer)

o Test lights - test a preview, a group of channels, or a group of pixels

e Access the Sequencer - with a view similar to the Sequencer's Start Page.

o Edit, verify and schedule shows. Length of each sequence and total duration of the show are
displayed.

e When playback is disabled, you can pick 1 of 2 playback modes: Show Player (traditional
playback), Live Player (jukebox playback).

e The new Show Player allows the queue of upcoming sequences to be manipulated by the user.

e The new Show Player allows a set of "Override Sequences" to be defined and inserted into the
qgueue at any time (for example "Clear out please" announcements).

e The new "Live Player" mode puts you in control of playing your show. It works like a jukebox and
makes using Light-O-Rama sequences in live performances much easier.

e Create SD cards for your mini- or MP3 Director.

e Click the cloud icon in the title bar to enable or disable your cloud connection, which is used by the
phone app. A cloud icon with a "!" in it means the computer is connected to the cloud, but the
phone app is not connected to the cloud. When the phone app connects, the icon will show a check
mark inside.

o Album art is displayed beside a musical sequence if the media file contains such an image.

e The new Control Panel behawes like a regular Windows program. It does NOT minimize to the
system tray.

e Sequence playback uses a new file format. This should allow sequences to start playing more

quickly and use less memory. S4/5 compressed sequences (LCS) and intensity data (LID) files are

no longer used.

Hardware Utility

¢ The tabs for "Digital IO Boards" and "X10 CM11A" have been removed.
e The SD card creator remains, but can only use LMS and LAS files. The ability to use LOREDIT files
here has been remowed.
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e The Light Console and Pixel Console remain, even though these functions have been recreated in
the new Control Panel.

Sequencer

¢ The right-click menu for the waveform has been remowved, although this menu is still available by
right-clicking on the yellow timeline. Also, the ability to drag across the waveform to zoom in has
been remowved. Double-clicking on the waveform now opens the Audio Settings panel.

e Empty grid view groups are now automatically deleted.

e Added new item to the timeline's right-click menu: Zoom To Play Range.

o Added new shortcuts: Ctrl-A to set max intensity and Ctrl-l to set min intensity. These are the
counterparts to Ctrl-U and Ctrl-D. Ctrl-A will no longer select all, but you can use R followed by C to
accomplish that.

e The "T" shortcut key will now add a timing mark wherever the pointer is located if there is no
selection in the sequence grid and playback is stopped. You can clear the selection by clicking in
the waveform area.

e On the right-click menu, "Add/Modify Motion Effect Rows" is now "Manage Motion Effect Rows"

e Motion rows are now only displayed in the order in which they are rendered. You can no longer drag
a motion row anywhere in the sequence grid. Row order is modified using the "Manage Motion Effect
Rows" menu item.

e The first column in the Manage Motion Effect Rows dialog now identifies the foreground and
background rows.

e On the Sequencer Preferences "Startup” tab there is a new option: Use default window arrangement
at startup. A few users with multiple monitors had problems with the way the Sequencer
remembered the position of its windows - sometimes causing a crash the next time the Sequencer
started. This gives those users a reliable way to start the Sequencer every time.

¢ The playback marker style can now be set by right-clicking on the timeline, as well as in Sequencer
Preferences. For users that change the playback marker style fairly often, and this allows them to
do that more quickly.

e Converted the "Carryover" column to "End Unit / End Circuit" in Prop Definition.

e Previously, setting a dimming curve in Prop Definition only applied to ELOR and DMX networks.
They now also work on regular LOR networks (not enhanced).

e Added option to Preview Design's Layout View to save it as a PNG image file. You can then open
the PNG image in MS Paint or similar programs and print to multiple pages. This is helpful for
layouts that are wider than 1 page.

e Typing the right-arrow key after a paste will now keep you on the first row of the selection. So you
can do multiple pastes with Ctrl-V, Arrow-right, Ctrl-V, Arrow-right, Ctrl-V, Arrow-right, etc.

e Updated the Statistics tab in Preview Design to include the number of channels in each LOR
network. This can help you diagnose when a network is overloaded.

e On Preview Design's Design tab, added "Create Group" to the item list's right-click menu.

¢ Added a Snowflake shape in Prop Definition. This shape can be used to efficiently model pixel
snowflakes and other props with radial symmetry. Motion effects that mowe left or right will spin
around the snowflake.

e Added Teal and Pink to the list of traditional colors in the Prop Definition screen.

¢ When editing a prop with a custom shape, you can now shrink the size. This works well for coro
props -- and the smaller size greatly improves performance.

e Added FSEQ export to the File menu - only available with a PRO license.

e There is now full support for dumb RGBW fixtures (4 channels). RGBW is sequenced as a regular
RGB channel; but when output to lights, the white channel is set to the minimum of the red, green,
and blue values, and then the red, green, and blue channels are reduced by the calculated white
value. In Prop Definition, the RGB order setting affects the order of the first 3 channels; white is
assumed to be the last channel.
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SuperStar

Added enhanced singing face features. Eyes will now blink every 2-4 seconds. Bow/Star will
illuminate when mouth is moving. Motion row defaults for Boscoyo type faces will automatically be
added into the image list.

Added twinkle and shimmer to the smooth effects

Added Windows Font support in Text Setup dialog box. This allows text using any of the Windows
system fonts. Bold, Italic, underline, and smoothing can be done for any of the fonts at any size.
Added "Don't Use Music" feature in the Auto Sequence dialog box.

Added feature for image mode, double click in the green grid, or the preview and in addition to
setting the current color for the pixel you clicked on, it sets all non-black to the current color. This
is to make it easy to change the color of all the pixels for a face element for the Boscoyo type
faces.

Added the feature "Silhouette Mask Adjacent Effects Only." This enables you to have multiple image
masks at the same place in the time ruler and have background and foreground effects that apply to
the mask they are adjacent to.

Added support for image masks with smooth effects

Added ability to multi select images and delete them with the Image list "Delete" button

Added feature so Ctrl + double click will select all 4 colors in the color controls

Added support for the new 14 element LOR singing faces

Increased the maximum dimensions from 360x360 to 400x400

Fixed a bug in the Singing Faces Dialog box that pops up informing them about what image options
the user should pick. The text for one of the cases was being truncated.

Fixed a bug where SSEdit.exe can crash if in the Image Setup dialog box you go to Large grid and
then back to Standard grid.

Fixed a bug where if you import an image in a path that has an '&' character then when you go back
to the sequencer and attempt to save the .loredit file the sequencer gets an error.

Fixed a bug in "Change Orientation" in the "Mowe or Scale Selected Effects" dialog box. The source
width and height were interchanged when the preview was Horizontal. They now work as expected.
Fixed a bug where Instant Sequence would not create any effects if you double click to edit a
sequence.

Fixed a bug where if launched from the Sequencer and you do "export to sequence editor” the .Ims
file can have missing channels if there are props in the Preview that have duplicate channel
assignments.

Fixed a bug where if you are in horizontal orientation and you copy a portion of an image in Image
mode, when you try to move the orange rectangle it doesn't move around properly.

Fixed a bug where if you copy a portion of an image in Image mode and do not press Esc key, then
select an effect that is not and image action and do paste, the paste appears to do nothing because
what it did was paste the portion of the image that was copied while in image mode. Fixed it by
exiting "copy a portion of an image" mode if the graphic mode changes, or if the "copy" button is
pressed.

Fixed a bug where if you have a group selected and load a .sup file then the code thinks there is still
a group selected.

Fixed a bug where you can select a smooth effect and then select a smooth effect before the
currently selected effect and the selection region in the time ruler becomes .05 seconds long

Fix some bugs in the "stop at edge" feature in the Text Setup dialog box. Large superstar fonts were
going 3 pixels off the left edge.

If a Preview is horizontal and has more than 50 pixels per row then the Sequencing Grid was being
displayed too large and you could not see the Preview.

New PixieLink Firmware Version 1.04
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e Firmware 1.04 has been released for the PixieLink to support a support module upgrade. It also
fixes the 141 fatal error (TCPIP stack initialization failure) and fixes the 17 Mbps speed option.

3 Feature Comparison

The Light-O-Rama software package must be registered, with a valid license, in order to be used to its
full potential. Each license contains two separate types of license levels: the main license level and the
SuperStar license level.

The main license lewvel cowers all of the Light-O-Rama software package except for the Light-O-Rama
SuperStar Sequencer. Several different main license levels exist, each having different features: Basic,
Basic Plus, Standard, Advanced, and Pro. Additionally, there is an unlicensed Demo version (which is
the same as the Basic version, except that it cannot be used to actually control lights, and has
encrypted sawe files).

The SuperStar license level covers the Light-O-Rama SuperStar Sequencer. Its possible lewvels have
names such as 2_CCR, 24 _CCR, 60_CCR, and the like, indicating the number of Cosmic Color Ribbons
you can use with SuperStar. Additionally, there is an unlicensed Demo version which does not allow
export to an actual sequence.

Any reference in this help file to a "license level" or "feature level" refers to the main license level, not to
the SuperStar license lewel, unless specifically noted otherwise.

You will be given a chance to register your Light-O-Rama software at the time that you install it. To
register after that time, or to upgrade to a higher level license, please see the "Register Light-O-

Rama" (or "Upgrade Light-O-Rama") menu item on the Sequencer's Help menu, or in the Control Panel's
License section.

The following chart summarizes what features are available with each license level, with details on each
feature listed below the chart.

If a feature is listed as "(demo mode)", it means that the feature can be used with this license to see
what it's like, but it won't be fully supported. For example, if you try one of the Sequencer's demo mode
features while building a sequence, you won't be able to save your changes to that sequence. Please
see the details for each feature for exactly what "demo mode" means for that feature.

If a feature is listed as "(S4, not S5)", it means that the feature is supported in version 4 of the Light-O-
Rama Software Suite, but support has been dropped in version 5.

Any features not listed here are available with all license levels.

FEATURE DEMO BASIC BASIC STANDARD | ADVANCED PRO
PLUS

Number of
LOR Units 0 2 4 8 UNLIMITED UNLIMITED

Supported

Number of
Grid Views 2 2 2 4 UNLIMITED UNLIMITED

Supported
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FEATURE

DEMO

BASIC

BASIC
PLUS

STANDARD

ADVANCED

PRO

Full Access
XML Data

Storage

No

YES

YES

YES

YES

YES

Beat Wizard

(demo
mode)

(demo
mode)

YES

YES

YES

YES

VU Wizard

(demo
mode)

(demo
mode)

YES

YES

YES

YES

Video
Playback

Audio Only

Audio Only

Windowed
Video

Windowed
Video

Full Screen
Video

Full Screen
Video

Show On
Demand

No

YES

YES

YES

YES

YES

Startup

Sequences
in Shows

YES

YES

YES

YES

YES

YES

Shutdown

Sequences
in Shows

YES

YES

YES

YES

YES

YES

Background

Sequences
in Shows

(demo
mode)

(demo
mode)

(demo
mode)

YES

YES

YES

Sequence
in
Sequence

No

No

No

No

YES

YES

MIDI File
Wizard

(demo
mode)

(demo
mode)

(demo
mode)

(demo mode)

YES

YES

Triggered
Interactive

Sequences

(demo
mode)

(demo
mode)

(demo
mode)

(demo mode)

YES

YES

Show

Startup
Options

No

No

No

No

YES

YES

Execute
Windows
Shell
Commands

No

No

No

No

YES

YES

Multiple
Networks

No

No

No

No

YES

YES

Create
Protected

Sequences

No

No

No

No

YES

YES

DMX
Intensity

No

No

No

No

YES

YES

Native DMX
Devices

Supported

No

No

No

No

YES

YES
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FEATURE DEMO BASIC BASIC STANDARD | ADVANCED PRO
PLUS
Create favorites
Motion Create Create Create Create Favorites Create and
Effects Faworites Fawvorites Fawvorites Fawvorites use in
sequences
— No No No No No YES
Networks
M Waveform Wawveform Wawveform Waveform Wawveform Waweform or
Display Spectrogram
No Longer Supported
Dasher . .
Controllers No No No No Not in S5 or Not in S5 or
later later
Supported
X10 . .
Controllers No No No No Not in S5 or Not in S5 or
later later
Supported
Digital 10 . .
Cards NoO NoO NoO NoO Not in S5 or Not in S5 or
— later later
Supported
BSOFT
Digital 10 NoO NoO NoO NoO Not in S5 or Not in S5 or
Cards later later
Supported

Number of LOR Units Supported

Except for the Advanced and higher license lewvels (which support an unlimited number of Light-O-
Rama controllers), each license level will send lighting commands to a limited number of Light-O-
Rama controllers: Basic supports a single controller, Basic Plus supports four, and Standard

supports eight.

Whether a particular controller is supported or not depends on its unit ID. For example, the Basic
license lewvel will send lighting commands only to unit ID numbers 1 and 2, while the Standard
license lewvel will send lighting commands to any unit that has a unit ID between 1 and 8.

Regardless of whether a particular unit will be sent lighting commands, you can always use the
Sequencer to build sequences using that unit; Light-O-Rama simply will not control the lights for that
unit unless you upgrade to a higher license lewel.

The unlicensed Demo version will not send lighting commands to any controllers, so you cannot use
it to actually control your lights.

Number of Grid Views Supported

A sequence may have multiple grid views; however, certain license levels will only support a limited
number of grid views in any given sequence. The Demo, Basic, and Basic Plus levels support 2 grid
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views per sequence, Standard supports 4, and Advanced and higher support an unlimited number of
grid views per sequence. The system grid view "View All ltems" is not counted toward the limit.

You will not be able to add new grid views to a sequence if it already has the maximum supported
number. However, you can still open sequences that have more grid views (for example, a sequence
that was created by someone who has a higher license level than you do). In this case, the extra
grid views can be displayed in the Sequencer, but you will not be able to modify them.

Full Access XML Data Storage

When a sequence is saved using a licensed version of Light-O-Rama, its sawe file uses a standard
XML format, which is designed to be understandable by people. In the S5 version of the software,
these files have an LOREDIT extension. Technically advanced users may feel comfortable editing
these XML-based sequence files directly with a text editor, or even building their own tools that can
be used with these files (although please be careful when doing so, as it is not terribly difficult to
make a small mistake which may render the sequence file incomprehensible to the Light-O-Rama
software package).

On the other hand, when a sequence is saved using the unlicensed Demo \ersion, it is saved
encrypted, and so the file itself cannot be easily understood or modified by anyone or anything
except the Light-O-Rama software package. Additionally, data from an encrypted sequence cannot
be copied and pasted, except on the computer that the sequence was originally encrypted on.

No matter whether a sequence is saved using the open XML format or using encryption, the Light-O-
Rama software itself will still be able to use it.

If you create an encrypted sequence using the unlicensed Demo version, and later purchase a
license, you can unencrypt the sequence by resaving it on the same computer it was originally
encrypted on, using your licensed version of the software.

Beat Wizard

The Beat Wizard can be used to analyze a song to try to determine its tempo, and to automatically
place timings and lighting effects into a sequence based upon that tempo. It is fully supported in
license lewvels Basic Plus and higher.

It is not supported in license level Basic (nor in the unlicensed Demo version). However, you can still
try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be able to
save your changes. You will be given a warning about this when you try it, along with a chance to
back out before committing to using it. Additionally, if you do decide to use it, and your sequence
already has unsaved changes, you will be given a chance to save them before you actually use this
feature.

VU Wizard

The VU Wizard can be used to analyze a song to find peaks in the audio - much like a VU meter -
and to automatically place timings and lighting effects into a sequence based upon those peaks. It
is fully supported in license lewvels Basic Plus and higher.
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It is not supported in license level Basic (nor in the unlicensed Demo version). However, you can still
try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be able to
sawe your changes. You will be given a warning about this when you try it, along with a chance to
back out before committing to using it. Additionally, if you do decide to use it, and your sequence

already has unsaved changes, you will be given a chance to save them before you actually use this
feature.

Video Playback

You can build musical sequences based on audio files (such as MP3) or on video files (such as
WMV). When a musical sequence is played, the sound will always play, but the actual video will
only be displayed for license lewvels Basic Plus and higher. License level Basic will not display video.

At the Advanced license level or higher, you can show the video in full screen mode. Basic Plus and
Standard will show video inside a window.
Show On Demand

This feature allows you to play show without having to scheduled it. This is done via the "Show On
Demand" menu item of the Light-O-Rama Control Panel's popup menu.

Startup Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Startup Section. Seguences in the Startup Section are played immediately upon the
show starting up, one at a time, in order. After all of them have been played, the main portion of the
show (i.e. the Animation Section and the Musical Section) begins.

Howewer, this section is fully supported only with the Standard or higher license lewvels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode”, to see what it is like. Howewer, the Light-O-Rama Show Player will
not actually play the sequences in a show's Startup section; instead, the show will simply begin play
directly with the Animation Section and the Musical Section.

Shutdown Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Shutdown Section. When the scheduled end time for the show is reached, the main
portion of the show (the Animation Section and the Musical Section) stops, and the sequences in
the Shutdown Section are then played, one at a time, in order. After they hawve all finished, the show
is truly finished.

Howe\er, this section is fully supported only with the Standard or higher license lewels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like. However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Shutdown section; instead, when the scheduled end
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time for the show is reached, the Animation Section and the Musical section will stop, and the show
will be ower.

Background Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Background Section. All sequences in the Background Section will play
simultaneously, looping back to their starts when they reach their ends, throughout the entire course
of the show.

Howe\er, this section is fully supported only with the Standard or higher license lewels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like. However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Background Section.

Sequence in Sequence

Sequences can themselves contain subsequences - a parent sequence containing a child sequence.
The parent sequence can be set to start or stop the child sequence at any given point during play.

Howewer, subsequences are only fully supported with the Advanced license level or higher.

Using other license lewels, you will still be able to use subsequences in a sort of "demo mode", to
see what they are like, but you will not be able to save changes to your sequence after having done
Sso.

MIDI File Wizard

The MIDI File Wizard can be used to automatically insert timings and lighting effects into a musical
seguence that is based upon a MIDI song. For example, it can make your lights chase each other
in time to the music, or turn certain channels on or off based upon what notes are being played.

Howewer, the MIDI File Wizard is fully supported only with the Advanced license level or higher.

Using other license levels, you will still be able to use the MIDI File Wizard in a sort of "demo mode”,
to see what it is like, but you will not be able to save changes to your sequence after having done
Sso.

Execute Windows Shell Commands

Using the Advanced license lewel or higher, Light-O-Rama can optionally tell Windows to execute
any arbitrary command that you specify when a particular sequence is started. An example of how
this might be used: If you broadcast the songs playing during your show ower the radio, you might
set your sequences up so that they tell Windows to tell your RDS ("Radio Data System") program to
also broadcast the name of the song, allowing people with RDS-enabled radios to see the name of
the song currently playing in your show.

© 2022 Light-O-Rama, Inc.



Feature Comparison 23

Triggered Interactive Sequences

In addition to being able to control lights, some Light-O-Rama controllers can also accept input,
acting as triggers to start particular sequences on demand during a show. For example, as part of
your display, you could have several buttons for people to push, each of which will play a particular
song.

Howe\er, this feature is fully supported only with the Advanced license level.

Using other license lewels, you will still be able to use this section in the Show Editor in a sort of
"demo mode", to see what it is like. Howewer, the Light-O-Rama Show Player will hot actually play
any sequences which are triggered during your show.

Show Startup Options

Normally, the sequences in a show will start playing immediately at the show's scheduled start time.
The Advanced license level or higher allows more control over this; for example, you could hook a
big red button labeled "Start the Show" up to one of your Light-O-Rama controllers, and the show will
not start until that button is pushed.

For details, please see "Show Startup Options".

Multiple Networks

The Light-O-Rama Software Package can send lighting commands to Light-O-Rama controllers over
seweral different Comm ports simultaneously. This has seweral potential uses, especially for people

with large numbers of controllers, or lights spread out physically far from each other.

Howe\er, this is supported only in the Advanced license lewel or higher. Other license lewvels will
send lighting commands to Light-O-Rama controllers only over a single Comm port.

Create Protected Sequences

The Light-O-Rama Sequencer can be used to create protected sequences, which are sequences
which cannot be modified (generally speaking) or viewed in the Sequencer, but which can still be
played, control lights, scheduled in shows, and so forth.

Howe\er, this is supported only in the Advanced license lewvel or higher. Other license levels can use
protected sequences, but cannot create them.

DMX Intensity

Light-O-Rama allows the possible intensity of most lighting effects ranges from 0 to 100, i.e. a
percentage of full intensity. DMX devices, however, are capable of taking 256 different intensities
(from O to 255), rather than 101. Light-O-Rama supports this possibility via the DMX Intensity tool.
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Howe\er, this is only supported in the Advanced license lewvel or higher. Other license levels will not
have access to the DMX Intensity tool.

Native DMX Devices Supported

The Advanced license lewvel or higher can send lighting commands to DMX devices, in addition to
Light-O-Rama controllers. Lower license lewvels can only send lighting commands to Light-O-Rama
controllers.

Motion Effects

Motion Effects can be fully used only with the Pro license level. Lower license lewvels can use the
Motion Effect Generator to test effects and save those effects as favorites, but they cannot be used

in sequences.

Enhanced Networks

The Pro license level can use enhanced LOR networks. These can help with displays involving large
numbers of independent lighting elements and are required when using Light-O-Rama Pixie
controllers. Lower license lewvels cannot use this feature.

Audio Display

At any license level, music can be displayed as an audio waveform. At the Pro license lewvel, you can
also view the audio as a spectrogram. See the Audio Settings topic for examples.

Dasher Controllers Supported

These controllers are not supported in S5 and later versions.

X10 Controllers Supported

These controllers are not supported in S5 and later versions.

Digital 10 Cards Supported

These controllers are not supported in S5 and later versions.

BSOFT Digital 10 Cards Supported

These controllers are not supported in S5 and later versions.
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4 Light-O-Rama Concepts

Light-O-Rama allows your computer to control your lights and other equipment in synchronized displays.
Such a display is organized into seweral levels:

At the lowest lewel, a sequence contains commands to be sent to your Light-O-Rama hardware, which
will actually control your lights. For example, a sequence might contain a command to turn on one
string of lights while making another string twinkle, and two seconds later, fading the first string down
while fading the second string up. A sequence can contain commands for many circuits.

Sequence

A sequence contains commands to control lights

Typically, people build a sequence per song that they want in their display (known as musical
sequences), each one containing all of the lighting commands for its particular song. People also build
animation sequences, not associated with any particular song, and often build one for each independent
part of their display - for example, one animation sequence to control a group of snowmen having a
snowball fight, and another to control a tin soldier firing a cannon.

Sequences can be grouped together into shows. A show allows several sequences to be played at the
same time, or sequentially, or in random order. A show can contain different sections - for example,
some sequences might be played only at the beginning of a show, others only at the end, others in
between, and still others for the entire duration of the show. You can assign a schedule to a show so
that the Show Player can play it at the scheduled times. Keep in mind that the Show Player can only
play one show at a time, but any number of shows can be scheduled for different times, and the same
show can be scheduled to play at many different times.
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4.1

Sequence Sequence Sequence

A show contains sequences to be played together, or in order, or randomly

Sequences

A sequence is a set of commands to be sent to lights - for example, a sequence may command the
lights to turn on when the sequence starts, turn off a second later, stay off for a tenth of a second, start
twinkling for the next two seconds, and then fade up, from completely off to completely on, during the
next three seconds. The Light-O-Rama Sequencer is used to create and modify sequences.

e Key Sequencing Steps

e The Sequence Grid
e More Information

Key Sequencing Steps
There are several key steps in the sequence process as shown in the flowchart below:
e Create a preview

e Create a sequence
e Save a sequence
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S5 Process Flowchart
If upgrading (optional)

Create a PREVIEW which
defines all of the
channels in your display

M
N
Create a new 55 A single preview can be used
sequence to create many sequences
[ ]
~
[ ]
N

Import Visualizer file

Import from online

prop libraries

Import SE animation

Upgrade a sequence | >
from a prior version

Save 55 Sequence ]
Create show

pempy using LOR Hub or

Show Editor
.LOREDIT file [ H

Create SD Card
N .
) using LOR Hub

A sequence can control multiple sets of lights independently of each other. Each set of lights should be
hooked up to a particular circuit on a particular controller; each such circuit is referred to as a "channel”.
Channels are assigned to props, and props are part of a preview. Every sequence is associated with a
single preview, and that preview determines the set of channels the sequence can control. A preview can
be associated with multiple sequences.

Create a Preview

In the example abowe, the 3 sequences are all assigned to the "Christmas 2018" preview. Each
sequence will have 4 props that can be controlled: Window, Door, Eaves, and Gutter.
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Not only do you assign channels to a prop, but you also assign a shape to each prop. This lets you draw
and arrange your lights in a way that resembles your actual display. When you play a sequence in the
Sequencer and display its preview, the drawing will behave just like your lights will - the props in your
drawing will turn on and off, fade up and down, and so forth.

A preview with Window, Door, Eaves, and Gutter props

Create a Sequence

There are two types of sequences: animation sequences and musical sequences. Musical sequences
are associated with songs (or sound effects, videos, etc.); the lights can be made to turn off and on (and
do other effects) in sync with the music. Animation sequences are not associated with songs. Many
sequences can be played simultaneously, but at most one musical sequence can be playing at a time -
all others must be animation sequences. This means that you can control some of your lights in sync to
a song via a musical sequence, while simultaneously controlling other lights independently, via animation
sequences.

You can create a new sequence:

¢ from the Eile Menu,
¢ by clicking links on the Start Page, or
¢ by right-clicking on a preview name in the Previews Window.

You can also create an S5 sequence by upgrading a sequence created in a prior version.

Save Your Sequence

It is important to save your sequence often so you don't lose any work if your computer crashes or you
lose power. It is also a good idea to make backup copies of your sequences to a flash drive or to the
cloud. The Sequencer's Save Copy options can be configured to make time-stamped backup copies
every time you sawe.

S5 sequence files use a different file extension than prior versions:
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S5 Sequences

Prior Versions

Musical Sequences

LOREDIT

LMS

Animation Sequences

LOREDIT

LAS

Sequence File Extensions

Once your sequence is complete, you can use the sequence file (LOREDIT extension) to:
e create a show for playback on the computer
¢ create an SD card for an LOR MP3 Director using the Control Panel

The Sequence Grid

Here is an example of a simple sequence containing 4 props, as represented in the Sequencer. The
props are listed down the left side and a timeline is displayed across the top. As time passes (from left
to right), you can see that the Window prop is turned on, then it is turned off and the Door prop is turned
on, then that is turned off and the Eaves prop is turned on, and so forth, through the 4 channels:

0:01.00 0:01.50

1.00 0:00.50
W E -

Show All ltems

oWindow 0§ )
Tt Door

{F Eaves

T Qutter

A simple sequence with afixed timing grid
Timings
The vertical lines in the sequence grid, representing distinct points in time, are known as timings. These

timings do not have any direct effect on how your lights will look; instead, they allow you to select time
ranges for lighting effects to happen, using various tools in the Sequencer.

Timings are grouped together into timing grids. There are 2 types of timing grids: fixed and freeform. In a
fixed timing grid, all of the timings are a fixed distance apart and the timings cannot be mowed, deleted,
or added to. In a freeform timing grid, timings can be at any location, and can be mowved, added, and
deleted. A sequence can have more than one timing grid. For example, here is the same sequence, but
now with a freeform timing grid displayed:

Show All ltems  ~ T3 - ]!",3[,] . ,__,_,_',:_]'_F]_?_'?[.] L Dm,[m L 00150 L
Tt Window L '
£} Door
{t Eaves
{F GQutter

A simple sequence with afreeform timing grid

Note that the timings in this freeform grid are not the same distance from each other. Also note that the
timings and the effects do not line up with each other - there is no reason that they would have to. This
is so as to allow flexibility in where effects can be applied, without cluttering the display with many
timings.

For example, perhaps you might want a sequence to have some effects that follow the drum beats in a
song, and other effects that follow the lead guitar. You could simply add timings representing both the
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drum beats and the guitar to a single timing grid, but if you do, it could be difficult to remember which
timing is for which instrument; also, the display might become cluttered with so many timings. So,
instead, you could put the timings for the drums into one timing grid, and the timings for the guitar in
another timing grid, and use the drop-down box to easily switch between the two timing grids as
appropriate. The effects that you add using the timing grid for the drums will not necessarily line up with
the timing grid for the guitar, nor the effects added using the timing grid for the guitar with the timing grid
for the drums, but neither should they.

Grid Views

A grid view is the group of props displayed in the sequence grid. A sequence can contain multiple grid
views. Each grid view can have its own props, or can share props with other grid views, or both. There is
one system-generated grid view call "Show All ltems" - it automatically shows all props in the preview.
You can change the order of the props displayed in the "Show All ltems" grid view, but you cannot
remove items from it.

Grid Rows
The sequence grid can display sewveral types of grid rows:

¢ Reqular channel rows have a gray background and control a single output channel

¢ RGB channel rows have a black background and are used for props composed of RGB lights that
can display any color

¢ Motion effect rows are only available with a Pro license. They allow you to apply color patterns to a
prop made of RGB pixels. Motion effects can also be applied to groups of pixel props. Motion
effects can be created using the Motion Effect Generator or the SuperStar Sequencer (SuperStar
is licensed separately).

e Loop rows can be used in animation sequences (but not musical sequences). When playing a
sequence that contains a loop, when the end of the loop is reached, the sequence will jump back
to the beginning of the loop. It will do this a certain number of times (that you specify), and then
will continue past the end of the loop. Each time that it jumps back, you can make it go through
the loop faster, slower, or the same speed as before. There can be many loops in a sequence
(set up for different time ranges), and loops can even contain other loops.

e Beat channels can be used in musical sequences, and are intended to hold effects related to the
beat of the music. They are merely a sequencing convenience and do not control lights.

e Subsequence rows point to a separate sequence file. The subsequence can be turned on or off at
different points in the main sequence, and its effects will play only when it is turned on.

o Archived prop rows contain effects for props that were once part of the preview, but have since
been deleted.

e RGB aggregate rows aid in the conversion of effects from props made of traditional lights to RGB
channels or motion effect rows.

A prefix symbol is added to certain types of grid rows to help identify them. Here is a master list of
symbols used:
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J Beat Channel

A Motion Row

1* Regular Channel

= RGE Channel

@ Archived Prop

& Subsequence

More Information
For more detailed information on sequences, please refer to the following sections:

e The Sequencer

e Previews

e Animation Sequences
e Musical Sequences

e Channels

e Timings

o Effects

e Archived Props

e RGB Aggregates

e Freeform Play Range

411 Previews

A 'Preview' is a representation of your light display. It defines the lighting elements, how they are
arranged, and what channels they use. Creating a preview is required before you can create a sequence.

A preview can be a quick rough sketch, or a detailed, highly realistic depiction of your display. It is up to
you to decide how much effort you want to put in to it. In any case, the preview must define every
channel that will be controlled by your sequences.

When you play a sequence using the Sequencer, you can also watch the sequence's preview in the
Playback window. The drawing will change as if it were the lights that the sequence controls - that is,
parts of the drawing will turn on and off, fade up and down, twinkle, and shimmer, just as the sequence
commands.

Props

The display elements in a preview are referred to as ‘props’. You must add a prop to the preview for every
display element that you want to control. A prop can be as simple as a single channel string of
traditional lights, or as complex as a big pixel tree or matrix. When you create a prop, you define the
type and color of lights that it uses, its shape, and the channels assigned to it. If one of the built-in
shapes doesn't meet your needs, then you can define a custom shape.
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A sample of some of the shapes that come built-in to S5

Groups

Props can be grouped together.
¢ You might do this so that the props appear together in the sequence grid.
¢ You might also create a group so that you can apply an effect to the group instead of individual
props. This enables things like sweeping a color across your entire display.

Background Image
A preview can be assigned a background image (for example, a photo of your house), which you can

draw the lights on top of. The brightness of the background image can be adjusted from within the
Sequencer.

IO, Sees
A AN AN

One Preview > Many Sequences

One preview can be associated with multiple sequences. Update the preview once, and the next time
you open any sequence associated with that preview, the update will automatically be applied.
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Preview: Christmas 2018

Prop: Window Prop: Door Prop: Eaves Prop: Gutter
Channels Channels Channels Channels
Unit 01 Circuit 1 Unit 01 Circuit 2 Unit 01 Circuit 3 Unit 01 Circuit 4
Sequence: Sequence: Sequence:

Jingle Bells Let It Snow Joy to the World

Importing a Preview

You don't necessarily need to create a preview from scratch. The Sequencer can import an existing
display definition from a variety of sources.

|m port an 84 V|S ua| iZ er ® LOR Visualizer v2.9.111 Advanced-Sample Visualizer File.lea

Fle Edt Help Debug

file Dlol] =] ele/s/s[ alal x[aa] Slc] 5= 3]
ﬁl} <@ @] @lal@l= 5= é@ | T Hame | Handi ﬂ\f&vlex‘ T ‘ W [Poted ~|

Fistures || Frops ¥ Simple Display
arage

You can perform the
import from the Preview
Management window,

when upgrading a
sequence, or from within

Preview Design

Changed | Select Prop 3831 2457 1:55 PM
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Import a block-style
animation defined in a
legacy sequence

You can perform the
import from the Previews
Window, or when

upgrading a sequence

ﬁ Animation for 2008\do you hear-2008.Ims

4| pm|

Siee
Bows 70
Columnzs a0

Update

Dirawing

Track 1 =

House Star Left =
o g

" Erase
7 View

L Cea |

Background Image

Select
e

r

Import an S4 Pixel Editor
preview

Pixel Editor previews are
automatically upgraded to
S5 previews the first time
you run the S5 Sequencer

‘0 Preview Design - tutorial

Save

Freview

Neme tutarial

Prop - Format - List -

Garage
Garage Aood

Roof Qutline

r Bulb

séze 0
T;Tsparency U
~Background
Brightness
U

Lo o]

Import a preview from an
S5 sequence sent to you
from someone else

Each S5 sequence
contains a backup copy of
the preview it uses. When
you open an S5 sequence
that has been sent to you,
the copy of the preview
inside the sequence will
automatically be imported
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Conwert any legacy
sequence to an
automatically generated
preview. The preview won't
look like your house, but
channel information will be
set correctly and it will
allow you to get started
with your sequencing right
away.

You can auto-generate a

preview when upgrading a

legacy sequence, or by
using the Quick Preview

feature when creating a
new S5 sequence.

ﬁﬁule Edit View Tools Play Wind
[)[c|cs|m| &% B8 «:

[A |4 | 0| | ol 02| 22

A Time Scale |2:|5}'||m\ 1
_ HouseStarkeft || | |
. HoweStw2 |

House Star 3 |
House Star Ton |
House Star §
House Stat B
Houge Star 7

__ HowseStarRioht || |
_ Howse Star Doar Lt |

Linit 01.13

Unit 01,14
Fi Doot Tiee

Unit 01,16
Elaw Star k | |
— BewStart ||
— GCarsgeStarlt 1| |
_ GarageStw2 || |
Garage StarTop || |

Garsne Star Bt
Archian
House Roof
Garage Foof

Preview Design - da you hesr

Save Cancel Neme |d you hear

Design Channel Conflicts (and bulk change tosl)

Add ltem a ¥ e

Item = Format - 4

Garage Star Top
House Roof v

Bulb  Scale  Background
Shape Square -
Size [ ]
1
Tnsparency

Other Wamnings  String Summary  Statistics

The Preview Design Window

Previews are modified using the Preview Design window. It can be accessed several ways:

e To create a preview, go to the Previews window and click the "+" icon.
e To modify a preview, go to the Previews window and double-click on a preview name.
¢ To modify the preview for an open sequence, click the preview name on the sequence's toolbar and

select Preview Design from the drop-down menu; or you can select Preview Design from the

Sequence menu.

For details on how to create and modify previews, please see the Preview Design topic.
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Preview Design - LOR Store Sequences-House-CB8P32 (2020-07) O x
Cancel 2) Name |LOR Store Sequences-House-C68P32 (2020-07) | Revision
Design |74 Channel Conflicts & Bulk Changes |4 Other Warnings  String Summary  Statistics
01.01-Roof A ~ | 5P &dd | = | Edit ~ Format = . ] o (6 ¥ @, =
01.02-Roof B
01.03-Roof C
01.04-Roof D
01.05-Window A
01.06-Window B
01.07-Window C
01.08-Window D
01.09-Colurmn A
01.10-Column B
01.11-Celumn C
01.12-Column D n
o oA
01.15-Bush C v
Bulb  Scale  Background
Shape Square ~
Size '
1
Transparency '
0%
< >
The Preview Design window with lights drawn on top of abackground photo of ahouse
4.1.2 Animation Sequences

An animation sequence is a sequence that is not associated with a song (or video, or other audio file).
This is as opposed to a musical sequence.

There are some other differences between animation sequences and musical sequences:

e Animation sequences can contain loops, which musical sequences cannot;

e Various song-related tools such as the Beat Wizard, MIDI File Wizard, VU Wizard and Tapper
Wizard are only available for musical sequences.

e Animation sequences cannot contain beat channels.

e Generally speaking, only one musical sequence can be played at a time (although there is an
exception to this, described in the help page on musical sequences), whereas many animation
sequences can be played simultaneously.

You can convert an animation sequence to a musical sequence by simply setting the media file via
Sequence > Media File.

In S5, animation sequences and musical sequences have the same file extension (LOREDIT). This is
different from prior versions, where animation sequences had an LAS extension and musical sequences
had an LMS extension.

To create an animation sequence in the Sequencer, use the New Animation dialog.
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Mew Animation Sequence >

Sequence Author (cannot be changed later):

lane Doe

- Select Preview

A preview defines all of the display elements and channels in your sequence

Cluick Preview

2017 class sample

Length of animaticn (not including loops):

|1:DD.DD 1 minute

[] UseLoops

r Initial Timing
[] Tenth second intervals
Half second intervals
[] One cecond intervals

[] Custom interval

A NE e

-

[] Create an empty freeform timing grid

Default number of motion effect rows for pixel props: 4 x
(requires PRO license)

Save these choices as defaults Create Cancel

The New Animation dialog

4.1.3 Musical Sequences
A musical sequence is a sequence that is associated with a song (or video, or other audio file), allowing
you to synchronize the song with lighting effects. This is as opposed to an animation sequence.

There are some other differences between animation sequences and musical sequences:

e Animation sequences can contain loops, which musical sequences cannot;
e Various song-related tools such as the Beat Wizard, MIDI File Wizard, VU Wizard and Tapper
Wizard are only available for musical sequences.
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¢ Musical sequences can contain beat channels.

¢ Generally speaking, only one musical sequence can be played at a time (although there is an
exception to this, noted below), whereas many animation sequences can be played
simultaneously.

The exception to the rule that "only one musical sequence can be played at a time" is that musical
sequences put into any section of a show other than the musical section are, effectively, treated as
animation sequences. That is, their associated songs will not be played, and more than one of them can
be played simultaneously.

You can conwert a musical sequence to an animation sequence with the Sequence > Convert to

Animation menu item.

In S5, animation sequences and musical sequences hawe the same file extension (LOREDIT). This is
different from prior versions, where animation sequences had an LAS extension and musical sequences
had an LMS extension.

To create a new musical sequence in the Sequencer, use the New Musical Sequence dialog.
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Mew Musical Sequence X

Sequence Author (cannot be changed later):

Jane Doe

rSelect Preview
A preview defines all of the display elements and channels in your sequence

Existing Preview  Quick Preview

LOR Store Sequences-House-C68P32 (2020-07) w

r Music

File name |Wizards In Winter-T50.mp3

Title |Wizard5 In Winter (Instrumental] (Album Version)

|
Artist |Tran5-Sil:Jerian Orchestra |
|
|

Album |The Lost Christmas Eve

rInitial Timing
Use a Wizard to create timings Create equally spaced timings
® Mot now, maybe later [ Tenth second intervals
Half second intervals
() Use the Tapper Wizard [] One second intervals
(O Use the Beat Wizard [] Custom interval
(O Use the VU Wizard 0.0 c
Mumber of motion effect rows for pixel props without [, Py

-

defaults set in the preview (requires PRO license)

Audic Infermation Waveform Only ~

Save these choices as defaults Cancel

The New Musical Sequence dialog

414 Channels

A channel is a particular circuit on a particular controller which can control lights (or senos in the case of
the Servo Dog controller). The Sequencer can be used to assign effects to channels, to make the lights
turn on and off, fade, shimmer, twinkle, and so forth.

Regular Channels

Single channels can control a string of traditional incandescent or LED lights, or a single-color flood light,
or perhaps some strobe lights. We will refer to these as "Regular Channels” to distinguish them from
"RGB Channels".
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A single channel from an AC controller

RGB Channels

An RGB channel is a group of three channels - a red channel, a green channel, and a blue channel. By
varying the amount of red, green, and blue light, any color can be produced. A device may hawe a single
RGB channel, like an RGB flood light (sometimes referred to as "dumb RGB"); or it can have many RGB
channels, like a Cosmic Color Ribbon (sometimes referred to as "Smart Pixels").

Yellow

Mixing red, green, and blue light

Pixels

Pixels are just a collection of RGB channels, 1 RGB channel controls one pixel. So a string with with 50
pixels would have 50 RGB channels. Light-O-Rama Pixie Controllers, as well as the PixCon16 controller,
are used to control pixels.

Device Type

When defining a channel, you first start with the Device Type. Device type specifies the type of
commands the controller understands (i.e. command protocol). The S5 software can send commands
using the Light-O-Rama protocol and also the DMX protocol.
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Light-O-Rama Protocol
When using the Light-O-Rama protocol, a channel has a uniqgue combination of:

¢ Network, which is the COM port that this channel's controller is hooked up to;
¢ Unit, which is the unit ID of the controller, allowing different controllers to be distinguished from

each other;

¢ Circuit, which represents an electrical circuit that can controlled. It could be a single output from
an AC controller, DC controller, or servo controller. Or a group of circuits could be used to control
a string of RGB pixels - one RGB channel per pixel.

DMX Protocol
When using the DMX protocol, a channel has a unique combination of:

e DMX Universe, and

e DMX Channel. There are 512 available channels in each DMX universe.
Assigning Channels

Channels are assigned to props in the Prop Definition screen within Preview Design. A preview is
assigned to a sequence, and the sequence can only control the channels defined in its assigned

preview.
Preview: Christmas 2018
Prop: Window Prop: Door Prop: Eaves Prop: Gutter
Channels Channels Channels Channels
Unit 01 Circuit 1 Unit 01 Circuit 2 Unit 01 Circuit 3 Unit 01 Circuit 4
Sequence: Sequence: Sequence:
Jingle Bells Let It Snow Joy to the World

Network Preferences

There are 2 variants of the Light-O-Rama protocol: there is the non-enhanced protocol for "Gen 1" devices
and the enhanced protocol (ELOR) for "Gen 3" and later devices.

There are also 2 variants of the DMX protocol: there is DMX sent over a USB adapter and DMX sent over
Ethernet (also known E1.31 and sACN).
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Which variant to use as well as other connection properties are set using the Network Preferences

program.
| Specified in: LOR < Device Type » DMX |
i Prop Definition ‘ i
i *  MNetwork (Regular, Aux A, etc.) *  Universe (1-999) i
i * Unit ID (01, 02, etc.) * Channel (1-512) |
| *  Circuit (1-512) !
i FTOTOH |"l| i
i USB adapter i
?: f Ethernet (E1.31) |

415 Effects

Lighting effects (or just "effects™) turn your lights on at a particular intensity level (brightness), or to a
particular color in the case of RGB, or a particular pattern in the case of motion effects for pixels. The
lighting effects available depend on the type of channel:

e Reqular channels
e RGB channels

e Pixels

Effects for Regular Channels

on Y

The "On" effect is just what it says - the light turns on. This could be the light turning on at full
(100%) intensity, or at some other intensity, or fading on, or fading off.

Twinkle %

The "Twinkle" effect causes your lights to quickly vary between on and off. The effect could be
twinkling at full (100%) intensity, or at some other intensity, or fading on, or fading off.

The difference between "Twinkle" and "Shimmer" is that twinkle is more random: Two different strings
of lights that are both told to shimmer at the same time will quickly turn off and on in sync with each
other; if they are instead told to twinkle, they will still quickly turn off and on, but not in sync with
each other.

Shimmer [H
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The "Shimmer" effect causes your lights to quickly vary between on and off. The effect could be
shimmering at full (100%) intensity, or at some other intensity, or fading on, or fading off.

The difference between "Shimmer" and "Twinkle" is that twinkle is more random: Two different strings
of lights that are both told to shimmer at the same time will quickly turn off and on in sync with each
other; if they are instead told to twinkle, they will still quickly turn off and on, but not in sync with
each other.

DMX Intensity el

DMX devices receive values between 0 and 255. Most of the time it is sufficient to specify that a light
be turned on at 50% or 75% brightness - in which case the DMX Intensity effect is not necessary
(the Light-O-Rama software will handle the conversion between percentage and DMX value for you).
Howeer, there are some DMX devices (moving head lights for example) where a precise DMX value
is required. In these cases, the DMX Intensity effect can be used to specify that value.

Effects for RGB Channels (also called dumb RGB)

For RGB channels, the 4 effects for regular channels (on, twinkle, shimmer, and DMX intensity) can be
applied in combination with a color or a color transition.

Effects for Pixels (also called smatrt pixels)

For pixels you have 3 options for creating effects. The S5 Sequencer allows you to mix and match all 3
approaches.

¢ Assign colors to each pixel individually. This can be tedious work for display elements with more
than a few pixels. However, sequences for sale are sometimes delivered this way.

¢ You can use the SuperStar sequencer (separate license required)

¢ You can use the Motion Effect Generator that is built in to the Sequencer. Pro license required.

4.1.6 Timings

Timings are the times in a sequence at which you can command the lights to do various effects - to turn
on, turn off, fade up, fade down, and so forth.

Timings are represented in the Sequencer by \ertical grey lines. For example, the following sequence
has timings ewery half a second, at 0.5 seconds, 1 second, 1.5, 2, 2.5, 3, and so forth:

Show All ltems VE'?9.......?:?1........F]:DE........F]:DS.......

£ Window o

£} Door ! |

GFaves 0 | |
¥ Gutter

A sequence with timings every half asecond

Timings do not have any direct effect themselves on the behavior of your lights; rather, they simply give
you a way to specify a start time and an end time for effects on a grid row. You can fill the space
between two timings with an effect by selecting the appropriate tool (such as the "Fade Up" tool) and
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clicking on a grid cell (see Adding Effects for details). For example, selecting the "Max Intensity" tool
and clicking the cell between 1 second and 1.5 seconds for the "Door" prop results in:

Show All kems  ~ | ~ ° 0:01 0:02 0:03

& Window |
{t Door S ;
{} Eaves

{F Gutter

The Door prop has been turned on, between 1second and 1.5 seconds

Timings do not have to be equally spaced (as they are in the above example). For example, the following
sequence has timings at 0.37 seconds, 1 second, and 3.2 seconds:

Show Alltems % - F° 0:01 0:02 0:03

O Window 4 |

{1 Door ! :
{F Eaves
{F GQutter

A sequence with timings at 0.37 seconds, 1 second, and 3.2 seconds

Timing Grids

A set of timings is known as a "timing grid". A sequence can have more than one timing grid, with one
being shown at a time. The timing grid that is currently shown can be changed by selecting from the
"Timings" drop-down box on the Toolbar. There are two types of timing grids: fixed grids and freeform

grids.
Fixed Timing Grids

In a fixed timing grid, each timing is the same length of time from the next timing. For example, a fixed
timing grid might have a timing every second, or every tenth of a second.

The timings in a fixed timing grid cannot be mowed, deleted, or added to.

Freeform Timing Grids

In a freeform timing grid, timings do not hawe to be equidistant. For example, a freeform timing grid might
have one timing at time 1.00 (i.e. one second), another half a second later at time 1.50, and another 2.2
seconds past that at time 3.70.

The timings in a freeform grid can be mowed or deleted, and new timings can be added.

Creating, Deleting, and Modifying Timings

Timings can be automatically inserted into a sequence when it is created, in a variety of ways. For
example, you can tell the Sequencer to insert timings every so often - for example every half second, or,
for a musical sequence, insert timings based on the song itself using various tools like the Beat Wizard,
VU Wizard, Tapper Wizard, and MIDI File Wizard. If you tell it to insert timings every so often (such as
every half second), it will create them in a fixed timing grid. If you tell it to use one of the audio wizards,
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or not to insert timings, it will use a freeform timing grid. Please see the New Animation dialog and New
Musical Sequence dialog for details. The audio wizards can also be run at any time after sequence
creation.

Mew Musical Sequence

*

Sequence Author (cannot be changed later):

Jane Doe

rSelect Preview

A preview defines all of the display elements and channels in your sequence

Existing Preview  Quick Preview

LOR Store Sequences-House-C68P32 (2020-07) w

r Music

File name |Wizards In Winter-T50.mp3

Title |Wizard5 In Winter (Instrumental] (Album Version)

|
Artist |Tran5-Sil:Jerian Orchestra |
|
|

Album |The Lost Christmas Eve

rInitial Timing

Use a Wizard to create timings

® Mot now, maybe later

() Use the Tapper Wizard
(") Use the Beat Wizard
() Use the VU Wizard

Create equally spaced timings
[] Tenth second intervals
Half second intervals
[] One second intervals
[] Custom interval

C &
(LR )

-

Audio Information

Save these choices as defaults

Mumber of motion effect rows for pixel props without |, Py
defaults set in the preview (requires PRO license)

\
~ b

Waveform Only

The New Musical Sequence dialog

In a freeform timing grid:

e Timings can be added during sequence playback by using the "T" shortcut key

e When there is no grid selection and no playback, the "T" shortcut key will insert a timing where
the mouse pointer is located. You can clear the grid selection by clicking anywhere on the audio
waveform -- which will get you into this mode.

¢ Timings can be mowved by clicking and dragging them. This behavior can be turned on or off by

"locking" the timings.
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Timings can also be added, deleted, and resized in a variety of other ways. See these topics for more
information:

¢ The toolbar's timings section
e The Timing Mark sub-menu on the grid's right-click menu

4.1.7 Protected Sequences

A protected sequence is a sequence which, generally speaking, cannot be modified, and whose
sequence grid cannot be viewed in the Sequencer. Protected sequences can, however, be played just
like any other sequence; they can be scheduled in your shows, they can be played in the Sequencer,
they can be downloaded as standalone sequences, and they will control your lights.

There are some things about a protected sequence which can be modified:

¢ The location of the media file (via Sequence > Media File)

e The preview (via Sequence > Assign Different Preview)
e The Windows shell command (via Sequencer > Windows Command)

To create a protected sequence, open the sequence which you wish to protect, and then select "Export
as Protected" from the Eile menu. It will prompt you to select a file name for the protected sequence. In
S5, protected sequences hawe a different file extension than regular sequences: .LORPROT versus
.LOREDIT

The ability to create a protected sequence is available only with the Advanced license level or higher.

F3 Light-0-Rama 55 Sequencer v5.3.7 Pro — O *
File  5Sequence Jools Window  Help
LTI TR Lite aint Nick-Beach Boys-... | -~ 3
& Timing ' Freeform 1 ~ LOR Store Sequences-House-C68P32-2019-08¢ g
[ p _— = = = !¢Normal . %@%@ E [ o
Save Undo Redo All  Here-to Start-to Visible Selection Pzuse Stop Loop Shorter Taller Time Time | Playback Waveform E3
End Here Cut  In Window ,D:
Play Zoom Wisibility | =
J0 0:02 0:04 0:06 0:08 0:10 012 0:14 -
7
Track 1 - =
[ %]
Unit ID 01 al S
Unit ID 02 Protected Sequence E
Unit ID 03 . . - -
U Tkt (click for more information)
Unit ID 05
Unit ID 06
Unit ID 07
Unit ID 08
Unit ID 20-27
v
£ Ll R4 >

A protected sequence, as displayed in the Sequencer

4.1.8 Archived Props
What Are Archived Props?
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Archived props are an inactive part of the sequence. They contain effects and can be displayed on the
sequence grid (they are shown with an "@" symbol as a prefix). Each archived prop has its own prop
definition that is not part of the preview. Archived props are not shown in the playback window when the
sequence is played and they cannot control real lights.

Archived props are a benefit because the sequencing on old props is preserved, allowing you to decide
what action to take and when.

J0

archived items 'E: -
@ DX 1.1

i

ived props

How Are They Created?

If an existing sequence is opened and contains information for props that are no longer part of the
preview, those props and their associated sequence are automatically converted to archive props. You
cannot create an archive prop manually. Scenarios where this might occur:

¢ You are upgrading sequences for S4 and you created your preview by importing a Visualizer file.
Howeer, there are some old channels in your sequence that you don't use any and were not in
the Visualizer file - and thus won't be in your S5 preview either. Those old channels in the
sequence will get archived because they are not in the preview.

e You created an S5 sequence with a last year's preview (e.g. 2017 Christmas) and now you have
created a new preview for this year (e.g. 2018 Christmas). Your display has changed from last
year and you have retired a few props. If you assign the new 2018 Christmas preview to your 2017
sequences, then the sequencing for the retired props will be archived because they are no longer
in the preview.

¢ You were working on this year's sequence (e.g. Sequence-A), which is currently closed. You edit
the preview and remowve a prop because you decide you are not going to use it this year. When
you next open Sequence-A, the sequencing for the prop you removed from the preview will be
archived.

If you delete a group from the preview and your sequence had motion effects on that group, then the
group will be archived.

What Can You Do With Them?

You can do sewveral things with archive props:

¢ You can copy sequencing from the archive prop to other areas of your sequence using copy/paste.
¢ If the sequence for the archived prop is no longer needed, you can delete it by right-clicking on the
prop’s name and selecting "Delete Archived Prop™.
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@ Unit 01.8 ' ' '

Prop Definition

Insert Preview Props and Groups 3
Convert to Grid View Group

Hide ltem

Copy to Other Grid View

Sort Channels 3
Add/Modify Motion Effect Rows
Delete Archived Prop

Delete an archived prop directly from the sequence grid

¢ From the Manage Archived Props dialog you can perform bulk deletions, convert archived props to
beat channels, or add them to your preview (making them a full-fledged members of your
sequence, capable of controlling lights).

419 RGB Aggregates
What Are RGB Aggregates?

RGB aggregates allow you to combine any 3 existing channels (the channel colors don't need to be red,
green, and blue necessarily), and the combination of the 3 is treated as an RGB channel for sequencing
purposes. This can be useful for people who are converting sequences with traditional strings to RGB.

In rare circumstances the S5 sequence upgrade process may create an RGB aggregate, but generally
they are manually created as needed by the user.

RGB aggregates do not need to have channels assigned to all 3 slots (red, green, and blue). You could
create an RGB aggregate with just the green and blue slots assigned, for example.

In the following example, "Hoop 2" is an RGB aggregate consisting of red, white, and blue traditional
channels. The white channel "Hoop Wh 2" is placed in the aggregate's green slot. "Hoop 2" can be
sequenced as either an RGB channel or as 3 individual channels. Changes made to the RGB Channel
row are immediately reflected on the individual channels, and vice versa.

J0 0: D06 0:08

RGE Aggregates -
-] =Hoop2
{} Hoop Red 2
{F Hoop Wh 2
£t Hoop Blue 2!

"Hoop 2" is an RGB Aggregate

How Are They Created?
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RGB aggregate channels can be created:

¢ By selecting "RGB aggregate" from the "Add New" item on the Sequence menu or on the Grid
View menu.

¢ By clicking the "+" icon on the Manage RGB Aggregates dialog.

Right-click on a RGB aggregate's hame and select "Modify RGB aggregate" to change its name and/or
its assigned channels.

Right-click on a RGB aggregate's nhame and select "Delete RGB aggregate" to remowve it completely from
the sequence.

What Can You Do With Them?

Suppose that in last year's display you used several colors of traditional lights (bundles) on your roof
outline, and that this year you are replacing them with RGB pixels. You need to somehow change the
sequences you used last year to control the new pixels in this year's display.

ZINZIN 21N 21N

Here are the steps:

Copy the preview for last year's display to a new preview.

Add the pixels for the roof outline to the new preview, without deleting the strings used the prior year.
Open last year's sequence.

Assign the new preview to the sequence.

Use Sawve As to give the sequence a new name

Create an RGB aggregate for the a bundle in the roof outline

Copy the RGB aggregate's RGB channel to the clipboard

If you have a Pro license, paste onto the motion effect row for the new pixels. If you have a lower lewel
license, select all of the RGB pixel rows and paste into the selected area.

4.1.10 Time Format

NG AL

Whenewer the Light-O-Rama Sequencer asks you for a length of time, you can generally specify hours,
minutes, seconds, and hundredths of a second. You don't have to specify all of them if you don't want
to.

The general format is:
HH:MM:SS.hh
Where HH is hours, MM is minutes, SS is seconds, and hh is hundredths of a second. You usually do

not have to type all of that in, though; for example, if you are concerned only with seconds, you don't
hawve to type in anything about hours, minutes, or hundredths of seconds.
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4.2

The Sequencer also uses this same format whenever it displays a length of time to you.

The following examples show how to specify various lengths of time:

Length of Time Format
Ten seconds 10

Ten and 37/100 seconds 10.37
Three minutes and ten seconds 3:10
Three minutes, ten and 37/100 seconds 3:10.37
Sewven hours, three minutes, and ten seconds 7:03:10
Sewven hours, three minutes, ten and 37/100 seconds 7:03:10.37

Shows

What is a Show?

A show is a collection of sequences, to be played as a set. After creating sequences with the
Sequencer, you can build a show that incorporates them by going to the Create Shows section of
the Control Panel. While building the show, you can add a schedule so that it will play at certain
times. Once the show is built and has a schedule, it can played by the Show Player.

A show doesn't necessarily need a schedule, as it can be played on demand, via the Light-O-Rama

Control Panel.

There are six different parts to a show, each of which consists of sequences:

The Background Section

The Startup Section
The Animation Section

The Musical Section
The Interactive Section
The Shutdown Section

Each of these parts is optional. For example, a show can be built having only a musical section and

a shutdown section.

Additionally, if your Light-O-Rama software license is for the Advanced feature level or above, you
can modify exactly how your show will start up - for example, immediately at its scheduled start
time, or after a certain circuit on a certain Light-O-Rama controller has been triggered (for example,

by someone hitting a "start" button). See "Show Startup Options" for details.

Note that the duration of a show is not part of the show itself; rather, it is determined by the

schedule.
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4.3 Schedules
What Is a Schedule?

A schedule is associated with a show and tells the Show Player the dates and times when the show
should be started and shut down.

Shows are created and edited in the Light-O-Rama Control Panel's Create Shows section. When
editing a show, a schedule is created by adding one or more schedule entries to it's Dates & Times
section.

A schedule entry specifies 3 things:

e When the show will play. This consists of a start time and an end time of your choosing. The
time range could be 5pm to 10pm; or it can cross midnight, starting at 8pm and ending at
2am for example.

e What days of the week the show will play.

e The date range for the show. In a new schedule entry, the start date will default to the current
day and the end date will not be populated, meaning it will run on the specified days of the
week from now to eternity.

When the Light-O-Rama Show Player looks at the list of active shows to decide whether a show
should be played, there could be several schedule entries that apply to the current date and time.
The Show Player resolves this by taking the schedule entry with the narrowest date range. A
schedule entry for December 21st through 27th (7 days) would take precedence over one for
December 1st through 31st (31 days). And a schedule entry for December 25th (1 day) would take
precedence ower both the 7-day and 31-day examples.

Example

Suppose you hawe a single show which you want to play every Friday and Saturday night in
December, from 7:00 PM to 10:00 PM, except for Christmas Eve (when you want it to run from 5:00
PM to 11:00 PM) and Christmas Day (when you want it to run from 8:00 AM to 2:00 PM). This
would require 4 schedule entries for the show:

Time Range Days of the Week Date Range

7:00 PM to 10:00 |Friday, Saturday December 1st through
PM 23rd

7:00 PM to 10:00 [Friday, Saturday December 26th

PM through 31st

5:00 PM to 11:00 |All days (to account for whatever day of the week December 24th

PM Dec 24th falls on)

8:00 AM to 2:00 |All days (to account for whatever day of the week December 25th

PM Dec 25th falls on)

Considerations

¢ In the Light-O-Rama Control Panel, the Play Shows section must be set to Show Player in order
for scheduled shows to run.
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4.4

File Locations

The first time you start the Light-O-Rama software, you will be prompted for the name of the folder where
you want to store sequences and other related files. The default choice is to create a "Light-O-Rama"
sub-folder below your "Documents" folder, as shown below.

Set Light-O-Rama Data Directory >

Light-\-Rama
—

Light-©-Rama needs to know where you would like to store your data, such as sequences and
audio files. If you would like to specify the folder where Light-O-Rama should store these files,
select it now. Otherwise, Light-O-Rama will create its own folder.

Choose the folder ABOVE where you want your sequences - for example, if you want your
sequences in CALOR\Sequences, choose CALOR,

|C:\U sersiMatt\DocumentsiLight-O-Rama, Reset

Back Cancel Mext

Light-O-Rama Sub-folders

Regardless of where you choose to put the Light-O-Rama data folder, it will contain the following sub-
folders:
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l C:hUsers'MattDocuments Light-0-Rama o [m] 1
‘G( ;;v| . = Documents = Light-C-Rama - - lmjl Search Light-O-Rama Eﬂ‘
Orgarize *  Sharewith *  Burm  Mew Folder = ~ 0 @
't Favarites Documents libra
y Arrange by:  Folder
PR Desktop Light--Rama
4 Downloads
. Mame = | Drake modified Type Size | |
= Recent Places
| Budio 1412019 12:16 AM File Folder
7 Libraries | Clipboards 142019 12:16 AM File Folder
| Documents | CommonData 1/4/201912:17 &M File Folder
rJ”- Music .
| Hardware 1/4/2019 12:16 &M File Falder
=/ Pictures
E Videos | ImportExport 1/4/2019 12:16 AM File Folder
| KeyMaps 1/4/2019 12:16 AM File Folder
e@ Homegroup | Logs 1/4/2019 12:16 AM File Folder
| LORInkernal 1/4/2019 12:17 &AM File Folder
R
I Computer | Metwark 1/4/201912:16 &M File Folder
" | Plugins 1/4/2019 12:16 AM File Folder
‘El_i Metwork,
| Sequences 142019 12:16 AM File Folder
| SuperStar 1/4/2019 12:16 AM File Folder

12 items

Audio

The "\Light-O-Rama\Audio" folder is where you should store the media files (audio and/or video) that you
will use as the music track for your sequences. The advantage of storing them here, is that Light-O-
Rama programs will look for the media files here by default. If you move your sequences to a different
computer, or share your sequences with another user, as long as you store the media file here, Light-O-
Rama programs will always be able to find the media file without prompting.

Clipboards

The "\Light-O-Rama\Clipboards" folder is where clipboards for the Sequencer are stored when cutting,
copying, or pasting effects. Clipboard files have a ".LCB" file extension. Clipboard files created by third-
party programs should be placed in this folder.

CommonData

The "\Light-O-Rama\CommonData" folder contains a number of important files:

Previews (LORPreviews.xml)

Motion Effect Favorites (LORFavorites.xml)

Color Fade tool favorites (LORGradients.xml)
Motion Effect Generator palettes (LORPalettes.xml)
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e Custom Keyboard maps (CustomKeyMaps.xml)
Hardware
The "\Light-O-Rama\Hardware" folder stores dimming curves that can be loaded into a controller.
ImportExport

The "\Light-O-Rama\lmportExport" folder is the default location for files exported from the Sequencer,
including previews, props, and motion effect favorites.

KeyMaps

The "\Light-O-Rama\KeyMaps" folder holds custom keymap files created in S4 or earlier. S5 custom
keymaps are stored in CommonData.

Logs
The "\Light-O-Rama\Logs" folder is not currently used in S5.

LORInternal

The "\Light-O-Rama\LORInternal” folder is used as temporary storage by some Light-O-Rama programs.
You should not make any changes to the items stored in this folder or any of its sub-folders.

Network

Below "\Light-O-Rama\Network" folder is a sub-folder called "SavedConfigurations"”, where exports from
Network Preferences are saved. These files have a ".LIV" extension.

Plugins

The "\Light-O-Rama\Plugins" folder contains sub-folders where files can be added to extend the
functionality of the Sequencer:

e prop shapes (not yet supported)

e motion effects (not yet supported)
¢ software dimming curves

Sequences

The "\Light-O-Rama\Sequences" folder is where your sequence files should be stored. S5 Sequence files
have a ".LOREDIT" extension.

SuperStar

The "\Light-O-Rama\SuperStar" folder contains files used by the SuperStar Sequencer.

Moving Files To A New Computer
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4.5

45.1

If you mowve your Light-O-Rama software to a new computer, you should copy files in all of the sub-folders
noted abowe, with the exception of Logs and LORInternal.

Hardware

Light-O-Rama can control your lights via Light-O-Rama controllers and Native DMX devices. The S5
version has dropped support for: Dasher controllers, Digital IO cards, BSOFT digital 10 cards, and X10
controllers.

When a prop is created in a preview using the Sequencer, the kind of controller (known as "device type")
is assigned in the Prop Definition window. It can also be changed on the Channel Conflicts & Bulk

Changes tab of Preview Design.

Light-O-Rama Controllers

Light-O-Rama allows your computer to control your lights via a variety of hardware controllers. Primary
among these are Light-O-Rama controllers.

Some Light-O-Rama controllers can also act as input triggers, allowing you to start particular sequences
on demand (such as when a person pushes a button).

Unit IDs

Each Light-O-Rama controller is assigned a unit ID. A unit ID is an identifier for the controller, and is
two characters long, with each character being a digit (0-9) or a letter from A to F. For example, 37,
25, 4B, C8, and DA are all valid unit IDs. Some such combinations are reserved, though, and should
not be used for as a unit ID. Specifically, 00, F1 through F9, and FA through FF are not valid unit
IDs. See the Unit Id Values topic for a complete list.

Controllers will only react to lighting commands that are intended for their own unit ID; if two
controllers on the same network have the same unit ID, both will react simultaneously to the same
commands. Howewer, a unit set up to use input triggers must have its own unique unit ID, not
shared with any other unit, and must not be on an LOR Enhanced network. Also, the Hardware
Utility may react strangely with respect to a unit ID which has more than one unit - for example,
detecting them as a single unit, or misdetecting them as some unknown controller type.

The unit ID of a controller is set in one of two ways, depending upon the type of controller:

¢ Most controllers have physical switches on them that allow you to set the unit ID by moving the
switches.

¢ Otherwise, the Hardware Utility can be used to select a unit ID for controllers without such
switches.

It is generally a good habit to assign your unit IDs sequentially starting at 01. This is not necessary,
but it will speed up some maintenance such as configuring and testing your controllers in the

Hardware Utility.

Circuit IDs
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Within a controller, each string of lights is assigned a specific circuit ID. This allows Light-O-Rama
to make different lights do different effects at the same time, using the same controller.

Standalone Mode and Computer Controlled Mode

Light-O-Rama controllers can be set up in standalone mode, in which a sequence is downloaded to
them in advance via the Hardware Utility, or hooked up to your computer via a COM port, in which
case the Light-O-Rama Show Player will send them lighting commands (during scheduled shows), or
the Light-O-Rama Sequencer will (on demand for a single sequence).

A controller in standalone mode can also send lighting commands to other controllers that are
hooked up to it via phone lines or data lines, similarly to the way that the Show Player or Sequencer
would. Therefore, in standalone mode, a sequence only needs to be downloaded (via the Hardware
Utility) to a single controller; the other controllers hooked up to it will receive their commands from it.

Only one source of lighting commands should be present in any group of controllers that are hooked
up to each other - either the Show Player, the Sequencer, or a single controller with a downloaded
sequence. Having more than one source of commands will cause unexpected and undesired
results, as lighting commands will be missed or garbled.

Light-O-Rama Networks

The Show Player and Sequencer can control up to sixteen different networks of Light-O-Rama
controllers, each hooked up over a different COM port. These networks are referred to as
"Regular" (which is the default), "Aux A", "Aux B", "Aux C", and so on, up to "Aux O".

One main use of multiple networks is for displays with very large numbers of controllers; they enable
more lighting commands to be sent out at a single time. They also allow you to set up a sort of star
network centered on your PC, rather than a single long daisy chain of controllers; both of these may
make such sequences perform more smoothly.

Another use is for displays whose controllers are hooked up using wireless communications, via a
Light-O-Rama Easy Light Linker. Wireless communications has a lower top speed than wired, but
using multiple wireless networks allows commands to be sent over all of them simultaneously. So,
depending upon how many controllers you have and how many lighting effects you send them during
your show, using multiple wireless networks could make your show perform more smoothly than
using a single wireless network.

It is simplest, though, to just use a single Light-O-Rama network, and in many situations, this is
perfectly sufficient.

Light-O-Rama networks can be either normal or "enhanced".

The COM ports represented by each of the networks can be set via the Networks section of the
Control Panel.

Enhanced Light-O-Rama Networks
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A Light-O-Rama network can be an "enhanced" network (set via the Networks section of the Control
Panel). An enhanced network allows for larger numbers of channels to be controlled as compared to
a network that is not enhanced, and is especially good for transmitting data to RGB pixels. The
recommended speed for a enhanced network is 500K. although Light-O-Rama Pixie and PixCon16
controllers can go to 1000K. Sequencer motion effects can only be sent to Enhanced LOR networks
and DMX networks.

A Pro lewel license is required to use this feature, and the Control Panel must be running in order for
the lights to be controlled. Not all controllers can be used on such a network, and some controllers
may require firmware updates before they are able to be used on an enhanced network. Also, input
triggers are not supported on LOR Enhanced networks.

Assigning Circuits in a Sequence

When you add a controller to your display, you add the strings of lights attached to that controller as
props in your preview using the Preview Design window.

45.2 Light-O-Rama Pixel Controllers

Light-O-Rama sells seweral different Pixel Controllers which support multiple different Pixel ICs. The
Pixie 16, Pixie 8, and Pixie 4 controllers can support up to 100 pixels per port and fully integrate into the
existing Light-O-Rama network.

When you add a pixel controller to your display, you add the strings of pixels attached to that controller
as props in your preview using the Preview Design window.

453 Light-O-Rama PixCon16 Devices

With the introduction of the PixCon 16 controller, Light-O-Rama is now selling and supporting native
E1.31 devices. These devices are configured from the Network Preferences program on the advanced
tab. To start the configuration of LOR E1.31 devices, press the 'Find/Configure E1.31 devices' button.

When you add a PixCon 16 controller to your display, you add the strings of pixels attached to that
controller as props in your preview using the Preview Design window.

454 Native DMX Devices

In addition to Light-O-Rama controllers and various other types of controllers, Light-O-Rama can control
native DMX devices, either directly over a serial port and adapter or over ethernet via E1.31.

When you add a DMX device to your display, you add the controller's channels as props in your preview
using the Preview Design window.

Several DMX universes can be used, each having a unique universe number from 1 to 999. Each should
be assigned a separate DMX adapter (such as an ENTTEC Open DMX USB adapter) or else E1.31
settings (such as IP address and port). You can assign adapters or E1.31 settings to universes via the
Networks section of the Control Panel.

Note that you do not hawve to use the "DMX Intensity" effect on DMX channels. You can, but you can
also use any other effect (such as Fade Up or Twinkle). If you use a DMX Intensity effect, it will have a
natural DMX intensity range of 0 to 255. If you use any other effect, it will have a range of 0 to 100, but
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455

Light-O-Rama will automatically scale it to DMXs 0 to 255 range immediately before sending it out to the
actual DMX device.

LED Pixel and Node Terminology

When discussing individually addressable bulbs, there are many terms that can be used. In an effort to
standardize these terms when dealing with RGB devices, Light-O-Rama defines the following:

e 'LED' (or 'Light"): A single locus (point) of light. One or more LEDs are part of a NODE. LEDs (or
LIGHTSs) are elemental - they can NOT be broken down further.

e 'Node': A single processor for one or more LEDs. Nodes are PHYSICAL. Think of them as the
processor chip on ewery individual LED/LIGHT.

e 'Pixel": A pixel is a collection of one or more NODEs. Pixels are VIRTUAL, and controlled by a single
TRIPLET. All nodes that are part of a pixel will react in the same way. Pixels are the 'bridge' between
the physical world and the virtual (sequencing) world.

e 'Triplet": A group of 3 CHANNELSs that set the color of a PIXEL. When we speak about a triplet we
do not specify the order of the CHANNELs. For example, some pixels are in RGB order, while some
others could be in GRB order. Either of those orders refer to the same triplet.

e 'Channel': A channel controls a single color of a TRIPLET. A TRIPLET consists of 3 channels: Red,
Green, Blue in the order specified by the manufacturer of the string.

The number of TRIPLETs required will always be the same as the number of PIXELs. When we talk
about something that you can physically touch we use 'Pixel'. When we are talking about it otherwise,
say in reference to a sequence, we use Triplet'.

Here are some examples to help:

A Light-O-Rama Cosmic Color Ribbon has 150 LEDs. Every 3 LEDs are attached to a single NODE.
When you set the resolution of the CCR, you control how many consecutive NODES are assigned to a
single PIXEL. At a resolution of 50, each NODE is controlled by 1 PIXEL for a total of 50 PIXELs. At a
resolution of 25, every two NODESs are controlled by 1 PIXEL for a total of 25. In all cases a single
TRIPLET will control a single PIXEL.

You may have a string of 170 RGB LEDs. Each one of these LEDs is attached to a single NODE. If you
do not group any of the NODESs together, you will have 170 PIXELs that are controlled by 170 TRIPLETs
which consist of 3 CHANNELs each for a total of 510 CHANNELS.

Separating the notion of Nodes from Pixels also allows virtual addressing to make more sense. For
example, say you have 30 pixels that are arranged as a 10 x 3 matrix. When you physically construct
this matrix, you will most likely use a snake pattern as that minimizes the amount of wire/etc. Your
NODES will look like this:

1 2 3 45 6 7 8 9 10
20 19 18 17 16 15 14 13 12 11
21 22 23 24 25 26 27 28 29 30

Notice how when we get to the right side, we don't start over at the left, but instead go one line lower and
in reverse order. While that makes a lot of sense while building the matrix, logically the pixels are not in
the correct order. Since we read left-to-right, we'd like to see all the pixels ordered from left to right. If
we were to set the 'Zig-Zag' parameter on a PixCon16 to 3, the physical nodes will still be in the same
order, however the pixels will be numbered:
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1 2 3 45 6 7 8 9 10
11 12 13 14 15 16 17 18 19 20
21 22 23 24 25 26 27 28 29 30

Since NODE refers to the physical and PIXEL refers to the virtual, we now can state 'Node 18 is Pixel
13, and it makes sense.

4.6 Unit Id Values

The numbers we use in everyday life are decimals, where each digit has a value between 0 and 9. Light-
O-Rama unit ids are usually represented has hexadecimal numbers (aka "hex"), meaning each digit can
take on 16 values: 0 through 9, followed by A through F. The following table can be used to convert
between the systems.

The last 8 columns show how to set the switches on a Pixie controller to achieve the desired unit id. A
value of 1 in these columns means the switch is in the "on" position, O is "off".

ID/HDDQ

Pixie Switches (1=on)
Decimal Hex 1|12|3|4|(5|6|7)|8
1 01 ofofOoO|lO|JO0O]J0]O0]|1
2 02 olofofo|oOof0O|1]|0O
3 03 ofofo|lO|JO0O]J]0] 1|1
4 04 olofofo|oOf1]0]|0O
5 05 ofofOoO|lO|JO0]1]0{|1
6 06 ofofofo|oOf1]1]|0O
7 07 ofofo|lO|lO0]1]1f1
8 08 ojojo|lO0O]1|l0]|O0]f0O
9 09 ofofo|lO|l1]J]0]0{|1
10 0A ofofofof|21f0]|1]|0O
11 0B ofofo|lO|l1]0]1{f1
12 oc ofofofo|1f1]0/|0O
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0D
OE

OF

10
11
12
13

14
15

16
17
18
19
1A

1B
1C
1D
1E

1F

20
21

22
23
24
25
26
27
28
29
2A

2B
2C
2D
2E

2F

30
31

32

33

34
35

36

60

13
14
15
16
17
18
19
20
21

22
23

24
25

26
27

28
29

30
31

32
33

34
35

36
37

38
39
40
41

42

43

44
45

46

47

48

49

50
51

52
53

54

© 2022 Light-O-Rama, Inc.



61

Light-O-Rama Concepts

37
38
39
3A

3B

3C
3D
3E

3F

40

41

42

43

45

46

47

48

49

4A

4B

4C
4D
4k

4F

50
51

52

53

54
55

56
57
58
59
5A

5B

5C
5D
5E

5F

60

55

56
57

58
59

60
61

62

63

64
65

66
67

68
69

70
71

72
73

74
75

76
77

78
79

80
81

82

83

84
85

86
87

88
89

90
91

92
93

94
95

96
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61

62

63
64
65
66
67
68
69
6A

6B
6C
6D
6E

6F

70
71

72

73

74
75

76
77
78
79

7A
7B

7C
7D
7E

7F

80
81

82

83

84
85

86
87
88
89

8A

62

97

98
99
100
101
102
103

104
105

106
107
108
109

110
111
112
113

114
115

116
117
118
119

120
121
122
123

124
125

126
127
128
129

130
131
132
133

134
135

136
137
138
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8B

8C
8D
8E

8F

90
91

92

93

94
95

96
97
98
99
9A

9B

9C
9D
9E

9F

A0

Al

A2

A3

A4

A5

A6

A7

A8

A9

AA

AB

AC

AD

AE

AF

BO
B1

B2

B3

B4

139
140
141
142
143

144

145

146
147
148
149

150
151
152
153

154
155

156
157
158
159

160
161
162
163

164
165

166
167
168
169

170
171
172
173

174
175

176
177
178
179

180
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B5

B6

B7
B8

B9

BA
BB
BC

BD
BE

BF

Co

C1

Cc2

C3

c4

C5

C6

c7

C8

9

CA
CB

cC

CD
CE

CF

DO

D1

D2

D3

D4

D5

D6

D7

D8

D9

DA
DB

DC

DD
DE

64

181
182
183

184
185

186
187
188
189

190
191
192
193

194
195

196
197
198
199
200
201
202
203

204
205
206
207
208
209
210
211
212
213

214
215
216
217
218
219
220
221
222
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223 DF i1j1f0j1|1]1|1f(1
224 EO 111 0|0|0|O0]fO
225 El 1)]1(1]0(0]0|0f1
226 E2 1{1j1(0|0|0|1]|O
227 E3 1)]1(1j0(0]0|1(1
228 E4 1110|011 0]|O
229 E5 1)]1(1j]0(0]1]|0f(1
230 E6 1110|011 |1]|O0
231 E7 1)]1(1j0(0]21]|1(1
232 E8 11101 |0|0|O
233 E9 1)]1(1j]0(1]0|0f(1
234 EA 11101 |0|1]|O
235 EB 1)]1(1j0(1]0|1(1
236 EC 111011 0|O
237 ED 1)]1(1j0(1]1|0f(1
238 EE 111011 |1|6O
239 EF 111011 |1f(1
240 FO 11|11 0|0|0|O

5 The Light-O-Rama Software Package

The Light-O-Rama software package is a suite of programs, each helping with a different portion of
computerized control of your lights to help build a dynamic display:

The Control Panel gives you convenient access to create and control all aspects of your show.
The Sequencer is used to create, modify, and test sequences.

The SuperStar Sequencer can be invoked from the Sequencer and can be used to create unique
effects. It also has auto-sequencing capabilities and the ability to sequence singing faces.

The Hardware Utility can be used to test your controllers, and to download sequences to them to
be used in standalone mode.

The Diagnostic is a troubleshooting tool that displays various information about your Light-O-Rama
configuration.

The Offline Regqistration Utility can be used to register Light-O-Rama on a computer that does not
have access to the internet.

The Light-O-Rama software package must be registered with a valid license in order to use it to its full
potential. There are several different possible license levels, each having different features available.
Light-O-Rama can also be used unlicensed, in Demo mode, but you will not be able to actually control
lights while in Demo mode.

Please note that the Light-O-Rama software package must be installed on a local drive; it is not
supported when installed on a network drive.

51 Control Panel

What is the Light-O-Rama Control Panel?
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The Light-O-Rama Control Panel is an application that allows convenient access all functions in the

Light-O-Rama software package.

The Light-O-Rama control panel must be running in order to play scheduled shows from your
computer. It also must be running in order to control lights from the Sequencer.

Running the Light-O-Rama Control Panel

To run the Light-O-Rama Control Panel, double-click the "CP" icon that was placed on your desktop
during installation.

Alternatively, you can select it from your computer's Start menu, under All Programs (or "All apps") /

Light-O-Rama / Light-O-Rama Control Panel:

—

Light-O-Rama

Light-O-Rama Control Panel

Light-O-Rama Diagnostic

Light-O-Rama Hardware

Light-O-Rama Help

Light-O-Rama Offline Registration Utility

Light-O-Rama Sequencer

sijjer e JeouReZle Heo

Light-O-Rama SuperStar Sequencer

Run the Light-O-Rama Control Panel from your computer's Start
menu

Main Window
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Light-O-Rama Control Panel v6.0.4 (BETA) Pro ? - D

Menu Light-O-Rama Controller Setup |— Mobile
; Status -

|'¥J Controller Setup U Configure LOR controllers, update firmware
2 Network I-¥ % (except for the controllers listed below)
e or controllers oW,

EIEE Networks | gratus -

.h!, Test Lights (
3 Configure a ServoDog controller

Sequences

tllé Create Shows B

Configure a PixCon16 controller

» Player
| P | Play Shows |\ grare B (not to be confused with the Pixie-16, which is configured with the Hardware Utility)

Configure a controller with a web-based setup page

This includes the Light-0-Rama Pixielink as well as some third-party E1.31 controllers.

The main functions of the Control Panel are grouped into sections and listed on the left side of the
screen. Clicking on a section icon or name will display the contents of that section on the right side.

mNormaHy, the icon and its description for each section are displayed on the left side.

However, clicking the icon with the 3 horizontal lines next to the word "Menu" will turn the
text off and only display the section icons. Click the Menu icon again to turn the section text
back on.

Some sections will display a "badge" on top of their icon. The badge indicates the overall status of that
section, so you can know what is going on without having to actually open that section. In the picture
abowe, the Networks and Play Shows sections are displaying a badge.

For details on each of the sections, please refer to the following:

Controller Setup - everything related to setting up your light controllers.
Networks - set up your lighting networks and see their status in real time.
Test Lights - test your lights to make sure they are working

Sequences - access to the Sequencer

Create Shows - create and edit shows and their schedules

Play Shows - play scheduled shows or conduct a live show

SD Cards - create and edit SD cards for Light-O-Rama Directors

License - register your Light-O-Rama software

Settings - change settings that govern Control Panel operation.

Closing The Control Panel
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You close the Control Panel as you would any other Windows program -- by
— D clicking the "X" icon in the upper right corner of the window. When you do
this, the Control Panel will no longer be running and your scheduled

shows will not run! If you want to keep your shows running, but no longer
wish to view the Control Panel, then click the minimize "_" icon instead.

Cloud Connection

The Light-O-Rama Control Panel has a companion mobile app so that you can control your lights
without being in front of your computer. This connection is made through the "cloud” so that you can
connect to your Control Panel from anywhere on planet! However, in order for it to work, your computer
running the Control Panel must have an active Internet connection, and your phone running the Light-
O-Rama mobile app must also have an active Internet/data connection.

Using this feature is optional, but is provided by Light-O-Rama at no extra cost - it is included with
your license.

Display Number

Most people use their license to control a single display at a time. Howewer, you might use your
license to control multiple displays - for example, you have a display at your house, and a separate
display at your parent's house.

Under Settings > Mobile App you can set a Display Number. Normally, you can leave this set to 1.
However, in the case where you have multiple displays, you would assign a unique display number in
the Control Panel for each display.

There is also a Display Number setting in the phone app. The display number set in the phone app
must match the display number set in the Control Panel in order for the connection to work. While you
can only control one display at a time from the phone app, you can connect to display 1, close the
app, then connect to display 2, etc.

The cloud senvice only allows one Light-O-Rama license/display # combination to connect at a time.
So if you have 2 computers with the same license and display number, the last Control Panel to
connect to the cloud wins (the other will display an "X"). Same goes for the phone app.

Cloud Status Icon and Button

At the top right of the window is a cloud status icon. The icon reflects the real-time status of your
cloud connection.
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Icon Name Meaning

DISABLED Connection is disabled by the user. In other words, you don't want to
allow a remote connection to your Control Panel.

DISCONNEC | The Control Panel was unable to connect to the cloud. Either your
TED computer is not connected to the Internet or there is a problem with the
cloud senice.

UNPAIRED The Control Panel is connected to the cloud, but the phone app is not
connected.

PAIRED The Control Panel is connected and the phone app is connected.

The cloud icon is also a button. If your cloud status is disabled, then clicking the button will attempt a
connection. Conwersely, if you are disconnected, unpaired, or paired, clicking the button will disable
the connection.

Launch At Start-up

If you wish, you can set it up so that the Control Panel will automatically be run whenever your
computer starts up (and therefore you won't have to start it via the Start menu anymore). To do this,
select "Launch at Startup” in the Settings section header.

[]

v’ Launch at startup

Help

Selecting the "?" icon at the top right of the Control Panel window will open up the Light-O-Rama
help files.

5.1.1 Controller Setup

The Control Panel's Controller Setup section is where you can find all of the utilities for configuring your
Light-O-Rama controller. It has 4 big buttons on the right side that will take you to the following tools:

o Hardware Utility -- used for all controllers except PixCon16 and PixieLink
e SenwDog Utility -- useful for setting parameters specific to the SernvoDog controller
e PixCon16 Utility -- used for configuring PixCon16 controllers
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e Find Web-based Controllers Tool -- useful for finding controllers that use web-based setup, like the
PixieLink.

Light-O-Rama Controller Setup

Configure LOR controllers, update firmware

(except for the controllers listed below)

Configure a ServoDog controller

Configure a PixCon16 controller

(not to be confused with the Pixie-16, which is configured
with the Hardware UHility)

Configure a controller with a web-based
setup page

This indudes the Light-0-Rama Pixielink as well as some
third-party E1.31 controllers.

5.1.1.1 ServoDog Utility

The Light-O-Rama SenoDog Utility can be used to configure the Light-O-Rama ServoDog, which
is a fourteen channel digital controller that can perform digital input, digital output, sernvo control
and PWM ("Pulse Width Modulation") dimming.

For details on how to use the ServoDog Utility, please refer to your ServoDog manual. This can be

downloaded from the Light-O-Rama Support page.
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Q Light-0-Rama ServoDog Utility v2.5.3
|

= || B2
ServoDog Configuration _

WARNING: Possible Servo Damage: Limits Motion Parameters Power Up Parameters Simulatar
present in the controller are bypassed. Cantral

Servo YWirtual Pulse Range " Move to Default Position
Test |«[1oo0 =| | 2000 | ™ Move to Meutral Position SR
Virtual Stops + Start Pulse on First Command |

_Test [«[ioo0 =] [«fz000 ~]

Default Position Lost Communications
Test [<is00 = Parameters

" Hold at Current Position Carmm Fort
Actual Pulse Range " Move to Detault Position
Test [afs00 =] [af2200 =] | © Moveta Neutal Posiion Select &2
Neutral Trim * Stop Pulze / Start ok First Command Select Unit ID
_Test =500 = Standard Preset Values IE' IG‘
ﬂ J ﬂ - Use slider to test |Medlum Range [default) ﬂ -
intensity values

Ll TaEEDDGO Sl B
Pulse Width  LORValus  DMRvale | L 2 245678 Al

10002000 | 0% 100% 0255 [ [w [v v [w v W [ r Get from ServoDog Send to ServoDog

CHAN 1
QUTPUT
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~
Click to Select Channel

The Light-O-Rama ServoDog Utility
5.1.1.2 PixCon16 Configuration

Open the PixConl6 Configuration page by clicking the "Configure a PixCon16 controller" button on the
Control Panel's Controller Setup section. Make sure your PixConl16 controller is powered on and that it
and your computer are connected to the same Ethernet network (the Ethernet connector on the
PixConl6 is the silver connector).

The PixCon16 is a little different than other Light-O-Rama controllers when it comes to configuration and
use. All configuration of the board is done while it is connected to a standard LAN. The PixConl6 can
not be configured via the LOR RS485 mode. The PixConl6 howewer can run (i.e. control lights) in either
E1.31 mode (Ma an Ethernet network), or as an LOR device on an LOR ENHANCED network at 500K
(1000k if there are only Pixie and/or PixCon16 controllers on the network). If you would like to use the
PixConl6 as an LOR device, be sure to select 'LOR Mode', explained below. When in LOR mode, the
PixConl6 can be connected to an MP3 Director (G3 or later) if desired.

Main Window

Click the "Search" button in the PixCon16 Utility. After a few seconds, a list of the PixCon16 / E1.31
devices that were found will be shown.
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Light-O-Rama PixCon 16 Utility - V2.3.24 - x

MNetwork Devices

Select Adapter: | 192.168.1.36 v || Refresh Adapters About

Model Nickname 1P Firmware Temperature

PxCon 16 Mkl ECO Dev Test Mkl 192.168.1.63 v2.0.13 26.9°C / 80.4°F

Found 1 Device(s)

After pressing the Search button

To configure a particular board, double-click on it. The PixCon Configuration window should open.

Under some circumstances, the program may not be able to detect all of the controllers connected to
your LAN. This can be due to multiple issues since the routing and configuration of TCP/IP can be
tricky:

= Most Importantly: Please select the correct network adapter at the top of the window. You must
select the network adapter that is directly connected to the same network the PixCon16 is
connected to.

= The board may simply have missed the command for it to report in. Pressing "Search" again will
usually find the missing controller. It could also be that the network is currently saturated with
lighting commands. You should stop any running show before attempting to configure an E1.31
device.

= [f this is the first time you are configuring a board, or if you changed the configuration of your
network, the device may no longer be at an IP that you are expecting. In that case, you may want
to reset the board to factory specifications. This will then place the board into 'DHCP' mode where
it will request an IP from your network. This requested IP should then be able to be found with the
program. Please note that resetting the board will clear all of your configuration information, and
you will need to re-configure the board.
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After configuring you controller using the PixCon Configuration window, then clicking OK to save your
configuration and close the window, the list of controllers in the main window will NOT automatically
update. You will need to press the Search button again. Be patient -- it may take a few seconds for the
controller to update its configuration and reboot before it is able to respond to a search request.

PixCon Configuration Window

Use this window to configure a specific PixConl6 controller. After changing the settings, click the "OK"
button at the bottom of the screen to sawve the changes; otherwise, click "Cancel" to leave the device
configuration unchanged.

The "PixCon Configuration" window has 5 tabs:

o Network
e Control
e LEDs

o Test

e Misc

Network Tab

PixCon Configuration — X

=

Network Control LEDs Test Misc

IP Address
(Static) IP Address: 192 | /168 | [1 | e8
(Static) Subnet Mask: 255 |,[255 |,[255 |[0
Type of IP: ® DHCP (O Static
Cancel oK

The Network Tab
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If you wish to let the controller be assigned an IP automatically by a router, select the ‘DHCP’
button. DHCP is the default mode of operation and will allow the controller to connect instantly to
most home or corporate networks that have a router.

If you are connecting your controller directly to your PC or via a basic network switch on a network
without a router, you will need to use a Static IP address.

To set a static address, select "Static" and then type in the IPV4 address you would like for the
board, as well as the Subnet Mask. The address should be in the same range as the computer you
are currently using to configure the board. The subnet mask should match the computer's as well. If
you change the address to one that is not within the range of your local LAN, the board may
'disappear'. In that case you should reset the board to factory settings, search again for the board,
and attempt to reconfigure it again.

Control Tab

' PixCon Configuration — X
MNetwork  Control LEDs Test Misc

Ethernet Control

Start Universe: : Start Channel: 5:
Pixels Per Qutput: |50 : [] Advanced = Advanced
Ethernet Protocol: ® sACN (E1.31) O Art-Net O LOR

[] Hold Last Frame (Timeout Action)

DMX512 Qutputs
Off/On  Universe Off/On  Universe

Out1:©|1 : Out 3: @‘1 :
Out 2: @‘1 v Out4: @‘1 =
Cancel OK

The Control Tab
Mode of Operation (Ethernet Protocol)

The PixConl6 can be run in 3 different modes:
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e As an E1.31 controller on an Ethernet network. The Ethernet cable should be connected
to the silver connector on the PixCon16.

¢ As an Art-Net controller on an Ethernet network. This mode is not currently supported by
the Light-O-Rama Software Suite.

e As an LOR device on an LOR RS485 network. A Cat5 cable is attached to the "J3/J4
(DMX #1)" jack on the board and run (directly or indirectly) to a Light-O-Rama USB
adapter. Be sure to also mowe the jumpers on the board from the ESTA side to the LOR
side near J4.

Start Universe / Channel

In E1.31 and Art-Net mode, these 2 fields specify the universe and start channel for the first port.
Normally, the channel should be set to 1.

In LOR mode, this specifies the Unit Id and Circuit of the first port. Normally, the channel (circuit)
should be set to 1. Note that the Unit Id here is in decimal (base 10), whereas the unit id is
hexadecimal (base 16) in all other parts of the software. See the Unit Id Values topic for a
conversion table.

Pixels Per Output
Enter the number of pixels on the longest string attached to this PixCon16.
DMX512 Outputs

This section allows you to enable/disable the 4 DMX ports available on the board, as well as
assign the universe each will control. These ports act as a bridge between E1.31 and a DMX
universe. By using one or more of these ports, you can eliminate the use of one or more USB
DMX adapters. These ports are not active when using the board in LOR mode.

Advanced - OFF

If the "Advanced" box is not checked, then the start universe (or unit id) and channel for ports 2-
15 will be automatically assigned.

When using E1.31 mode and Advanced is off, then you should set up your Prop Definition

similar to the following picture:

¢ Prop Definition's "Nodes per String" should match the PixCon16 Configuration "Pixels Per
Output”.

¢ Prop Definition's device type should be set to "DMX'.

¢ Prop Definition's "Max Channel" should be set to 510.

¢ Prop Definition's Universe and Start Channel should match the corresponding PixCon16
Configuration.

¢ Prop Definition's "Enter channel on first row, auto-number the rest" should be selected.

¢ Prop Definition's "Separate Universe for each RGB string" should be unchecked.
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rShape
Tree 180

Actual # of 16 =

Ctrinnc

Exact# of RGE |30 =

Modes per String

# of Folds in 0 =
each 5tring

Starting Bottom Left
Location

)
£

r Channels
Uses the zame channels as | <none> e
DMK v Max Channel 510 =

(®); Enter channel on first row, auto-number the rest |

i) Enter a channel on every row

[] Separate Universe for each RGB string

Universe End Cary "
Channel Channel Owver

L 1 1 150 0
2 1 151 300 0
3 1 301 450 0
4 1 451 510 90
5 2 a1 240 0
& 2 241 390 0
7 2 391 510 30
g 3 3 180 0

a 3 181 330 0 =

When using LOR mode and Advanced is off, then you should set up your Prop Definition similar

to the following picture:

e Prop Definition's "Nodes per String" should match the PixCon16 Configuration "Pixels Per

Output”.

¢ Prop Definition's device type should be set to "LOR".
¢ Prop Definition's Unit Id and Start Circuit should match the corresponding PixCon16

Configuration.

e Prop Definition's "Max Circuit" should be set to 510.
e Prop Definition's "Enter channel on first row, auto-number the rest" should be selected.
e Prop Definition's "Separate Unit Id for each RGB string" should be unchecked.
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r Shape r Channels
Tree 180 e Uses the same channels as | <none> “
ual¥el 16 =~ a6k v Max Circuit 510 |2
Exact# of RGE |30 =
Modes per 5tring (®) Enter channel on first row, auto-number the rest
# of Folds in 0 =
each String = w () Enter a channel on every row
) [] Separate Unit ID for each RGE string
Startlrjg Bottom Left ~
eser Newwork | unieid Z | B o |
b 1 |Reg.. |+ 01 1 150 0
2 |Reg.. v~ 01 151 300 0
3 |Reg.. |v 01 301 450 0
4 |Reg.. |+ 01 451 510 90
5 |Reg.. 02 91 240 0
& |Reg.. |~ 02 241 390 0
7 |Reg.. |+ 02 391 510 30
g |Reg.. |~ 03 31 180 0
PILISTES AT RELES o |Req.. vl 03 181 330 0 i

Advanced - ON

There are 2 modes available for setting up the pixel ports of a PixCon16, simple and advanced.
For most users, simple mode is all that will be needed. For more complex configuration
options, please use the advanced mode.

Here you can set:
¢ an individual start universe and channel for each string
¢ the number of pixels attached to each port

¢ the number of "null pixels". Null pixels allow the controller to ignore or skip a specified number
of pixels at the beginning of an output. This is useful when you want to extend the distance
between controller and your actual lights, as the data signals used by pixel chips are not
designed to travel over long distances. Sometimes the signal between controller and first pixel
gets degraded and causes problems such as flickering lights. In these cases inserting a “fake”
(null) pixel between controller and first real pixel can help as they reproduce the signal on their
output; remember that they will not actually light up as they are ignored by the controller. The
PixCon16 treats null pixels as an entirely different parameter to normal pixels. So for example
if you had 50 pixels in your pixel fixture and needed to insert 2 null pixels before the start, the
‘Null Pixels’ field for that output would need to be set to 2 and the ‘Num Pixels’ field would
remain at 50 (even though there are 52 physical pixels in total on that output).

e Use of the Zig-Zig feature is not recommended. Instead, use one of the matrix shapes in Prop
Definition and set the number of folds.

¢ Grouping allows the user to specify how many physical pixels are grouped together and
treated as one single pixel to the outside world. For example, if you had a pixel strip with 150

© 2022 Light-O-Rama, Inc.



Light-O-Rama v6.1.0

physical pixels on an output and entered 10 in the grouping field for that output, it would
effectively turn that strip of 150 individual pixels into a strip of 15 individual ‘pixels’. Each ‘pixel’
would now actually consist of a group of 10 physical pixels all grouped together as one single
‘pixel’ as far as your lighting control software or console is concerned.

¢ Intensity Limit allows the user to specify a value between 0 and 100% for the brightness lewel
of the pixels on a given output. Note that the brightness output is scaled based on the input
level provided to the controller. This is used in circumstances where the lights are too bright for
your application. If you set the Intensity limit to 50% for example, the PixCon16 would halve all
incoming data values. Reducing brightness also reduces the amount of power consumed by
the pixel strings.

e Turning on the reversed option tells the controller to light up the pixels in reverse order to the
way that they are physically connected. This means the first pixel to light will actually be the
last physical pixel on that output instead of the first physical pixel. Usually, it is best to leave
this setting disabled, as it is easier to take care of such situations in your Preview.

; Advanced Output Configuration - *

Outputs 1 - 16
U:i?er:se cr?:a:a Unl?::rse Chgar::m ::;; prﬂs ZigZag Group lL?:.:TW\ Reversed
Output1 |1 | |1 1 5o | [o o | [1 | [00 @)
Output2 |1 | [151 1 5o | o 0 1 0 @)
Output3 |1 | [301 : 250 0 | o 0 1 1w | @)
Output4 |1 | [as1 2 o0 o | [o 0 1| || @)
Outputs |2 | ot 2 5o | [o 0 1| 0] @)
Output6 |2 | [2a1 2 200 ;5o | o 0 1 00| @)
Output? |2 | [301 : 50 | [o 0 1| o] @)
Output8 |3 | [31 3 o | [o 0 1 00| @)
Outputd |3 | [181 3 330 0 | o 0 1| |0 | @)
Output 10 3 | [331 3 480 0 | o 0 1 00| @)
Output 11 [3 | [as1 4 o | [o 0 1 00| @)
Output 12 |4 | [121 4 270 o | [o 0 1 0 @)
Output 13[4 | [an ' 420 0 | o | o 1| | | @D
Output 14 4 | 421 5 60 so | fo o ][] 0] @D
Output15 |5 | |61 5 50 | [o 0 1 00| @)
Output 16 |5 | [an1 5 50 | [o 0 1 100 @)
[ Automatic Sequential Channels (@ TabDown (O Tab Right Cancel oK

The Control Tab - Advanced
LEDs Tab
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© PixCon Configuration — x

MNetwork Control LEDs Test Misc

LED Pixels
Pixel IC: Ws2811 v  Speed (O Slow @) Fast
Clock Speed: | |
Controller Outputs: @® Normal (O Expanded
LED Type: ® RGB ) RGBW
RGB Order: |G-B-R v [ Advanced  Advanced

Gamma Correction
Only applied to chips that are higher than 8 bit.

Red: I 2.0
Green: I 2.0
Blue: I 2.0

Lock Sliders: m

Cancel oK

The LEDs Tab
Pixel IC
Select your pixel string's chip-set here. The PixCon16 can support a variety of pixel driver chips
-- which chips are supported depends on the firmware loaded to the board. Current Light-O-Rama

pixel strings use the WS2811 chip (IC). This setting applies to all 16 outputs.

If in doubt, check the packaging:
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SC-LOR:W52811-DC12V-10IC-30LED- B

Length: Smeters
Working voltags:DC12V

Ma>Imum power:36W

Packing: Casing-IP68

Packing:1 roll per bag

Speed

Some pixel chip-sets have a low and high speed. If your chip-set supports high speed (current
LOR pixel strings do), check the "Fast" box.

Controller Outputs
In most cases, select "Normal" here.

If using a controller that supports expanded mode and you select a pixel type that is a single
wire protocol with no clock line (like WS2811), then you will have the option to select expanded
mode. This mode allows the clock output on each of the pixel outputs on the control board to
function as a data output instead of a clock line. This doubles the number of physical data
outputs available and also increases the refresh rate. On a PixConl16 Mk2 for example, your
data outputs will go from 16 to 32 in expanded mode and the max RGB pixels per data output
will drop from 1020 to 510. In this mode, special care will be required in wiring your pixels to the
connectors on the board.

LED Type

Some pixel drivers can operate RGB or RGBW LEDs. In this case, an option will be shown to
select the type you are using. RGB LEDs use 3 channels and RGBW LEDs use 4 channels per
pixel.

RGB Order

Under this tab you can also change the RGB (W) color order of all the outputs simultaneously,
or change it for individual outputs separately. This is useful if the lights you are using are not
physically wired in the standard red, green, blue order. To change the order of all outputs at once
simply select the order from the drop-down box. To change specific outputs, click the ‘Advanced’
checkbox and then click the "Advanced" button to bring up the RGB (W) configuration window
for individual outputs.

You can also set color order in Prop Definition. If your pixel strings are naturally in RGB order,
then both the controller and Prop Definition should be set to RGB order. If not, set one to RGB
and the other to the pixel string order. Things become very confusing if you try to change it both
places!
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Color Correction (Gamma)

These sliders allow you to adjust the relative amount of power supplied to each channel of a
triplet attached to the 16 pixel ports of the board. Color Correction is typically used so that
pixels attached to this board can be adjusted to more closely match pixels on other boards.
Please note that this setting is for the entire board and not per port. Use the sliders to increase
or decrease the amount of ‘color' for each component.

Test Tab

' PixCon Configuration - x
Metwork Control LEDs Test Misc
Test Mode

FPrior to running test mode. all other settings should be
saved to controller (Press OK).

Current Test: Mone (Live Data)

Set Test: None (Live Data) b
MNone (Live Data)

RGBW Cycle

Red

Green

Blue
White
Set Color

Color Fade

Cancel oK
The Test Tab

This tab allows you to remotely select a number of different hardware test modes on the controller
that can help to determine if your pixels are connected correctly and are working as they should.
Simply select the test you wish to run from the drop-down box to turn it on, and select either an
individual pixel output or all pixel outputs for the test to be applied to. Note: Before running the tests
the pixel type and outputs should be configured correctly or it will not work.

Misc Tab

© 2022 Light-O-Rama, Inc.



82

Light-O-Rama v6.1.0

./ PixCon Configuration — X
Network Control LEDs Test Misc
Misc

Nickname: |Dev Test Mkl

Fan Control - Fully On Temp: |35 °C & 95°F

MAC: EO-B6-F5-E0-4D-D3

Start Identify Stop Identify

Firmware

Vv2.0.13 Update Firmware

Voltage Banks

1: 11.8V 2: Off

Cancel oK

Nickname:

You should set the name of the board to something meaningful to you. For example, if this
particular controller is used for a tree, you may want to name it 'Pixel Mega Tree' or the like.

Fan Control

Optionally, you can connect a fan to the PixConl16. When the board reaches the temperature
specified here, the fan will be set to full on. If you don't have a fan connected, you can ignore
this field. See the PixConl6 Hardware manual for more information.

Firmware Update:

To update the firmware, press the Update Firmware button. You will then be asked for the
location of an LOR PixConl6 Firmware File. To ensure you have the latest firmware available,
please check the Light-O-Rama website and download the latest available.

Once you hawve selected the correct file, the firmware update process will start. The process is
typically safe to perform, however we recommend that you do not update firmware unless you
are addressing a known problem, or need to add some new functionality that a new firmware
offers.
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When updating the firmware of a PixConl6, the power and status lights will flash on/off in
different patterns. Do not power off the board while the update is in progress. If you are unsure if
the update was applied properly or not, wait a few minutes and then observe the power and
status lights. This will give the board enough time to reboot and stabilize. Also, pay attention
to any instructions that may be shown on your screen.

Should the update process fail, the board could be in one of several states after the failure:

¢ If the status light is blinking and the power light is solid, this typically means the update was
successful. Howewer, it could also mean the board did not receive or it did not properly start
the update process.

¢ If the power and status lights are alternating, then the board is currently in the boot-loader
mode.

¢ If the power light is ON but the status light is OFF there was a problem with the firmware
update.

In all cases after allowing the board to sit for a few minutes, power it off then back on. The board
should return to normal operation at that time. If not, please refer to the hardware manual of the
PixCon16 for additional troubleshooting information.

5.1.1.3 Find Web-based Controllers

The Light-O-Rama PixieLink controller is configured using a web page. The tricky thing about that is
knowing the IP address of the controller so you can open the web page in a browser. This tool will take
care of finding the IP address for you.

1.

When you open the tool, it will display a list of network adapters attached to your computer. If your
computer has WIFI only, you will probably only see 1 network listed. In the picture below, there are
3 networks. You need to select the network that will be scanned. In our example, we have selected
the first network listed.

Click the Scan button. Depending on the number of devices on the network, it can take anywhere
from 1 to 30 seconds to complete the scan.

After the scan is finished, the list of devices with web-based setup pages will be listed. You can
click the IP address of the device you want to configure and this will open the web page in your
default web browser.

After you are done with the scan page, click the Cancel button to return to the main Controller
Setup view.

If you plug in a USB-to-Ethernet adapter after the Control Panel has started, you might need to
click the "Refresh list of networks" button to see the new adapter in the list.
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Light-O-Rama Controller Setup

Select the network to scan for PixieLink and other controllers
®) 192.168.10.2 ASIX AX88772 USB2.0 to Fast Ethernet Adapter
O 192168027 Realtek PCle GBE Family Controller

O 17226.96.1 Hyper-V Virtual Ethemnet Adapter

E ‘ Refresh list of networks ‘ | Cancel ‘
Scan Results

192.163.10.3 Pixielink Settings

5.1.2 Networks

Light-O-Rama software running on a computer can control a wide variety of hardware devices and
communicate with them via several different methods.

Light-O-Rama Adapters

In the simplest case, the devices/controllers are connected to your computer via a USB to RS485
adapter sold by Light-O-Rama.

Light-O-Rama USB Adapter
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Typically, Light-O-Rama controllers are connected to USB adapters, and up to 16 USB adapters can be
connected to a single computer - that is, 16 different "networks". In many cases, a Light-O-Rama user
will only need a single network -- that is, a single USB to RS485 adapter -- for all of his or her controllers:
this is called the "Regular" network. Should additional networks be needed, 15 auxiliary networks ("Aux
A", "Aux B", and so on, up to "Aux Q") are also available, each of which would be controlled via a
separate USB adapter.

DMX

If you have an Advanced or Pro license, the software also supports communication to:
o DMX devices via USB to DMX adapters,
o Ethernet-connected devices via the E1.31/SACN protocol.
o Ethernet-connected devices via the Art-Net protocol.

You can configure up to 999 DMX universes (although please note that, depending on your computer's
capabilities, the software may not be able to adequately drive that many universes simultaneously).

The Network List

The Control Panel's Networks section let's you set up your lighting networks and see their connection
status in real time. These networks are used by the Show Player when it plays your sequences. It is
also used by the Sequencer when Control Lights is enabled. It is important that this information is
correct or your lights will not turn on!

In the picture below, 6 networks have been defined. Each network has a hame shown in bold font. A
second line shows some of the connection parameters. And a third line shows the connection status -- a
green check mark if things are OK, or a red Xif there is an issue. In the first picture, all 6 networks are in
a green status, and you can see the summarized status as a badge on the network icon on the left. The
badge displays the total number of networks (6), and the green color indicates no issues.
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Light-O-Rama Control Panel v6.0.5 (BETA) Pro DR - O

Menu Lighting Networks |E| | IMPORT | | EXPORT | | NETWORK ch;:

AC, Faces, Floods
Controller Setup . LOR Regular
Connected

[
&% Networks Pixel Tree & CCP
- LOR Aunx A (Enhanced)

'I'i'!' Test Lights Connected
PixCon16 #1

Sequences 3 "t . DMX1-6 (E1.31) 192.168.104
e : Connected 5568

] 1
| ® Create Shows mmmm=mn  PixCon16 #2
! DMX 7-12 (E1.31) 192.168.10.5
Connected 5568

PixCon16 #3
DMX 13-18 (E1.31) 192.168.10.6
Connected 5568

Moving Head
DMX 300 ATOADTAZ
Connected Open DMX (raw)

* Settings

The same set of networks are shown below. However, this time a network cable has been removed from
"PixConl6 #3". The status on the individual controller has turned red, and the badge on the network icon
has also turned red. The badge color alerts you to the problem, even if you are in a different section of
the program.

The number on the badge will always indicate the total number of networks defined. The badge color will
turn red if the status of any network turns red, and return to green once all networks are back to a green
status..
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Light-O-Rama Control Panel v6.0.5 (BETA) Pro DR - O

Menu Lighting Networks |E| | IMPORT | | EXPORT | | NETWORK ch;:

AC, Faces, Floods
Controller Setup . LOR Regular

Connected
]
E?E thE Pixel Tree 8 CCP

. - LOR Aunx A (Enhanced)
.h',!, Test Lights Connected
PixCon16 #1

Sequences 3 "t . DMX1-6 (E1.31) 192.168.104
e : Connected 5568

] 1
| ® Create Shows mmmm=mn  PixCon16 #2
! DMX 7-12 (E1.31) 192.168.10.5
Connected 5568

PixCon16 #3
DMX 13-18 (E1.31) 192.168.10.6
Verify |P address is camrect and controller... 5568

Moving Head
DMX 300 ATOADTAZ
Connected Open DMX (raw)

* Settings

Using the buttons in the section heading (to the right of "Lighting Networks"), you can:

e Add a new network. You will be prompted for what kind of network to add:
o LOR adapter

o DMX adapter
o E1.31 controller

0 Art-Net controller
o Edit the selected network (you can also double-click on a network in the list to edit it)
¢ Remowe the selected network
Import and export the complete network configuration (backwards compatible with files created
using earlier versions of the software)
¢ View the network log

5.1.2.1 LOR Adapter

On this screen you define a Light-O-Rama network - one that uses a USB adapter (or a serial adapter on
older computers).
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§ Edit Network

Name

AC, Faces, Floods

LOR Network

Regular

Port D Only ports for devices connected to this computer

COM 8 - USB Senal Port
Speed

S7.6K

Use Enhanced LOR (ELOR)

Off

Name

Use the name field as you see fit. Listing some of the key props on this network makes for a good
name.

LOR Network

Select the Light-O-Rama network. If you have a single network, then choose "Regular”. Networks
that are already defined will be disabled in the drop-down, so you don't define the same network
twice.

Serial Port ("Port")

In the drop-down box, chose the serial port that you wish to use for that network. Make sure that
your selection does not conflict with another network, or with DMX adapters.

If you check the box to the right of the drop-down, only adapters currently connected to the computer
will be shown in the drop-down. This will make it easier to identify the correct port.
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If you are setting up multiple LOR networks, we recommend connecting and setting up one adapter
at time, checking the "Only show ports..." box each time. After you are done setting up all of the
adapters in Network Preferences, you can then plug all of the adapters into your computer.

Connection Speed ("Speed")

Light-O-Rama software can communicate with Light-O-Rama controllers using various
communication speeds. These speeds can be set independently for each Light-O-Rama network:

¢ If you do not have extraordinary needs and the network is not enhanced, "57.6K" is suggested.

¢ If you have controllers that are hooked up to your computer using a very long or poor quality
communications cable, you may need to set the speed to "19.2K (Slowest)".

¢ If you are using Light-O-Rama Easy Light Linkers (ELL) for wireless communication in your
network, speeds will be limited to a maximum of 115.4K (57.6K for the older V4 ELL).

¢ If you have many circuits with very fast action, you may need to set the speed to "115.4K", or even
"500K". Note that 500K is currently supported only on G3 controllers, Cosmic Color Ribbons,
Cosmic Color Bulbs, Cosmic Color Pixels, Pixie Controllers, and the PixConl16. You may also
have to upgrade your firmware to use 500K. See our Network Speeds web page for the latest
information.

¢ If you are using enhanced LOR, then 500K is the recommended speed.

e [f this network ONLY contains a combination of Pixie and Pixcon16 controllers running on an
Enhanced LOR Network, you may select 1000K.

Enhanced LOR

Checking this box designates this network as an enhanced network. This optimizes the network for
high channel counts, such as when using RGB pixels. Motion effects and SuperStar effects can only
be played on enhanced LOR networks and DMX networks.

A Pro lewel license is required to use this feature. Not all controllers can be used on such a network,
and some controllers may require firmware updates before they are able to be used on an enhanced
network. Also, input triggers are not supported on LOR Enhanced networks.

5.1.2.2 DMX Adapter

On this screen you define a DMX network that uses a USB adapter.
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§ Edit Network

Name

Moving Head

Universe

Adapter
A704D7AZ

Adapter Protocol
Open DMX {raw)

Name

Use the name field as you see fit. Listing some of the key props on this network makes for a good
name.

Universe

Set the universe that will be assigned to this adapter. When you create props in your preview that
represent fixtures attached to this adapter, the universe assigned to those preview props must match
the one you assign here.

DMX Adapter ("Adapter")

Select the adapter from the drop-down list of adapters available on the system. Note that the
program cannot detect adapters that are currently in use. For example, if you have an LOR USB485
adapter that is currently assigned to an LOR network, and you wish to assign it to a DMX universe
instead, you will first need to unassign it from the LOR network before it can be reassigned to the
DMX universe. Furthermore, you may need to stop and restart the Hardware Utility before the device
will be shown in the Adapter drop-down box.

Note that there are different types of DMX protocols that can be used. Please be sure to select the
correct protocol for your adapter.
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DMX Protocol ("Protocol")

Different DMX adapters use different protocols. You must specify the correct protocol for the DMX
adapter you wish to use:

Adapter Type Protocol

DMXKing UltraDMX Micro ENTTEC DMX Pro (or compatible)
DMXKing UltraDMX RDM Pro ENTTEC DMX Pro (or compatible)
ENTTEC DMXUSB Pro ENTTEC DMX Pro (or compatible)
ENTTEC Open DMX USB* Open DMX (Raw)

* Some old ENTTEC Open devices, built in approximately
2008 or earlier, may not be supported

LOR USB485 Open DMX (Raw)
LOR USB485B Open DMX (Raw)
LOR USB485-ISO Open DMX (Raw)
Lynx (DIY) ENTTEC DMX Pro (or compatible)

Other types of adapters may or may not work with LOR software. If they do, you may need to
experiment to find the correct protocol to use.

5.1.2.3 E.31 (sACN) Controller

On this screen you define a group of DMX universes for a controller that uses the E1.31 (SACN) protocol.
Please note that E1.31 configurations can be complex, and may require a firm grasp of networking,
network topologies, and addressing. Such topics are beyond the scope of this document.
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§ Edit Network

Name

PixConla #1

Start Universe

End Universe

IP Address
192.168.10.4

RESET TO STANDARD PORT [5568)

Name

Use the name field as you see fit. Listing some of the key props on this network makes for a good

name.

Start Universe

The first DMX universe used by this controller.

End Universe

The last DMX universe used by this controller.

IP Address
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Here, you must select the type of IP address you wish to use for this controller:

e Specify: Selecting this option will cause the universe to use unicast mode, and lighting
commands for the universe will be received by a single E1.31 device, using the IP address that
you specify.

e Multicast: Selecting this option will cause the universe to use multicast mode, allowing lighting
commands for the universe to be received by multiple E1.31 devices. The actual IP address that
will be used depends upon the universe number, in the manner described by the E1.31 standard.
For example, universe 37 will use IP address 239.255.0.37, while universe 650 will use IP address
239.255.2.138.

e Local: This option will cause the universe to send lighting commands to the computer itself, using
the local loopback address (127.0.0.1).

Port

The IP port that the remote device or devices will listen on for lighting commands should be specified
here. In almost all cases, the standard value (5568) should be appropriate.

5.1.2.4 Art-Net Controller

On this screen you define a group of DMX universes for a controller that uses the Art-Net protocol.
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§ Edit Network

Name

301 (Art-Net)

Start Universe

End Universe

Adjust Art-Net universe (PixCon16 should be on)

® On

IP Address

® Specify 192.168.0.50
O Local

Port

o o ot

Name

Use the name field as you see fit. Listing some of the key props on this network makes for a good
name.

Start Universe

The first DMX universe used by this controller.

End Universe

The last DMX universe used by this controller.
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Adjust Art-Net Universe

Turn this setting on for PixCon16 controllers. It may need to be off for other Art-Net controllers.
Testing on your part may be required.

IP Address

Here, you must select the type of IP address you wish to use for this controller:

e Specify: Selecting this option will cause the universe to use unicast mode, and lighting
commands for the universe will be received by a single Art-Net device, using the IP address that

you specify.

e Local: This option will cause the universe to send lighting commands to the computer itself, using
the local loopback address (127.0.0.1).

Port

The IP port that the remote device or devices will listen on for lighting commands should be specified
here. In almost all cases, the standard value (6454) should be appropriate.

5.1.2.5 Export/Import

The Advanced and Pro \ersions of the software can export/import your entire network configuration to a
file. This is useful if you would like to have multiple different configurations available, or if you use the
software on multiple machines and want to mowe the configuration between them.

The Import/Export function works on ALL the parameters that can be changed in the Networks section of
the Control Panel.

Please be careful when importing a network configuration from another computer. While the hardware
and software give a best-effort to configure themselves the same way across physical machines, that is
not guaranteed. This is especially true of COM port settings, and IP addresses. After importing a
configuration, you should always check all values to ensure they are correct.

To export your configuration, press the Export button and give the file a name. The exported files are
normally saved in the LOR Data path under "Network\SavedConfigurations". An exported file will have
the .LIV extension.

To import a configuration, press the Import button and select the configuration to import.

5.1.3 Test Lights

The Test Lights section of the Control Panel gives you 3 options to test your lights:

e Test props in a the selected preview
e Test channels
e Test pixels
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Test Preview

Light-O-Rama Control Panel v6.0.7 (BETA) Pro
Menu Test Lights

Controller Setup

E?E Networks
RGB —
Candycane L1 I

Candycane L2

B Candycane L3
Sequences

Candycane R1

.I.'i'!, Test Lights

tlé Create Shows Candycane R2

Candycane R3

Eave 01

Eave 01 icicle (lower)
Eave 01 icicle {upper)
Eave 02

Eave 02 icicle (lower)
Eave 02 icicle {upper)
Eave 03

Eave 03 icicle

Faue A

Test Preview

Testing a preview can be really useful when you are setting up your display for the season and making
sure each prop is working. This function can also be accessed from the mobile app, so you can test
while outside during display setup.

Testing props in a preview is easy:

1. Select the desired preview from the drop-down list

2. Click on a prop. Note that props are listed in alphabetical order, but grouped by type -- so
traditional props are listed together, pixels props are together, etc.

3. The test options will be displayed to the right of the prop list (see the 2 pictures below). Test
options will vary by the type of prop (traditional, dumb RGB, pixels), but all will be similar.

4. The prop name, string description, number of channels or pixels, and the first channel will be listed
on top. Below that will be a brightness slider. And to the right of the slider will be a list of tests
(on/off, or red/green/blue).

5. Change the brightness or color as needed.

6. Once done, click on the next prop you would like to test.

When you leave the Test Lights section, the lights will turn off. When you come back to the section, the
lights will turn back on, with the settings where you left them
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Select Preview:

Tree L Arm 1
Tree L Arm 2
Tree L Arm 3
Tree L Arm 4
Tree L Trunk
Tree R Arm 1
Tree R Arm 2
Tree R Arm 3
Tree R Arm 4
Tree R Trunk
Traditional

Jesus

“ Wireframe Merry Chnstmas-1
Multicolor string 1 ch: White
Channels: 1
First Channel: DMX Universe 9, Ch 8

® On

O on

Test for atraditional prop

97
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Select Preview: | 2022 Chnstmas

Candycane L2
Candycane L3
Candycane R1
Candycane R2
Candycane R3
Eave 01

Eave 01 icicle (lower)

Eave 01 icicle (upper)

Eave 02

Eave 02 icicle (lower)

Test Channels

“  Candycane L1
‘B RGB Pixels (RGB order)
Pixels: 90
First Channel: DMX Universe 11, Ch 391

® All On (white)

Test for a pixel-based prop
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Light-O-Rama Control Panel v6.0.7 (BETA) Pro
Menu Test Lights

Controller Setup
Network Channel Count Range

& o Tt ]
Networks Regular COM 3 57.6K _ ®) 0-100
Aux A COM 5 500K Enhanced 5
Unit 1D (hex)

I I i Univ 1 - E1.31 [5568] 0- 255
1 Testighs 2
Univ 2 - E1.31 [5568] or iDMX1000

S LI-L.7  r19 IEcem controdlers only)
equences ===

011 01.2 - y . : - 01.8 01.9 01.10  01.11

t.(?) Create Shows

0 0 0 0 0
0112 0113  01.14 0115 0116

* Settings

Test channels

In Test Channels, you can test channels in any LOR network or DMX universe that you have defined in
the Networks section. No need for those channels to be defined in a preview

Select the network to test from the list

Select the number of channels

If testing an LOR network, select the unit id (these are hexadecimal numbers).

Leawe the range at 0-100 unless you are testing DMX fixtures and need to set a precise value.

Now you can move the individual sliders up and down to adjust the brightness of each channel. You
can also use the "All On" and "All Off* buttons to set all channels at once.

arDdE

When you leave the Test Lights section, the lights will turn off. When you come back to the section, the
lights will turn back on, with the settings where you left them.

Test Pixels
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Light-O-Rama Control Panel v6.0.7 (BETA) Pro

Menu Test Lights

Controller Setup
MNetwork Pixel Count Channel Order

3 -
Regular COM 3 57.6K RGE order ~ ALL ON (WHITE)
Networks I

Aux A COM 5 500K Enhanced |
Unit ID (hex) | GREEN | | ALL OFF |

L -
'I'T!I- Test Lights Univ 1- E131 [5568]
Univ 2 - E1.31 [5568]

Sequences o e

E3

1 1 1
t.é Create Shows 301 302

Test pixels

In Test Channels, you can test pixels in any LOR network or DMX universe that you have defined in the
Networks section. No need for those pixels to be defined in a preview

Select the network to test from the list

Select the number of pixels

If testing an LOR network, select the unit id (these are hexadecimal numbers).

Each pixel takes 3 channels, and often the first channel is red, the second channel green, and the
third channel blue. But that is not always the case. If the colors on the sliders don't light up the
expected colors, then try changing the color order until you get the expected results.

5. Now you can mowe the individual sliders up and down to adjust the color of each pixel. You can
also use the "Red", "Green", "Blue", "All On (White)", and "All Off' buttons to set all pixels at
once.

e N

When you leawve the Test Lights section, the lights will turn off. When you come back to the section, the
lights will turn back on, with the settings where you left them.

5.14 Sequences

The Sequences section of the Control Panel provides convenient ways to access the Sequencer. This
can be done in any of 3 ways:

o Click the "Sequencer" button at the top right. This will open the Sequencer, without opening any
sequences. This is the preferred way if you need to edit a preview.
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¢ In the "Start A New Sequencer" section, click the "New Musical Sequence" or "New Animation
Sequence" buttons to start a new sequence.
¢ In the "Recent Sequences" section, double-click on one of the sequences listed.

Light-O-Rama Control Panel v6.0.9 Pro
Menu Start A New Sequence

Controller Setup ‘ B s ST B

L] Create a sequence to synchronize lighting effects with an audio or video file.

Create a sequence to amimate one or more props without audio.

3 -
a% Celtods ‘ ' New Animation Sequence

'I'i'!' Test Lights

B Recent Sequences
Sequences

Iyt WizardsinWinter-2022
t Create Shows CAUsers\Matt\Documents\Light-O-Rama\Sequences\2022\Chri '/ 20/ 2022 12:49 PM

Izl Play Shows Amazing Grace Techno-2022
Ci\Users\Matt\DocumentshLight-O-Rama\Sequences\202 \Chri
ﬂ SD Cards
Christmas Story-2022

‘ . CilUsers\Matt\Documents\Light-O-Rama\Sequences\2022\Chri
.'_ License 7 =

7/28/2022 12:45 PM

7/28/2022 12:45 PM

LOR 5.6.0 Motion Effects

2 rl A
CihUsers\Matt\Documents\Light-O-Rama\SequencesiSamples S Ll

L Settings LOR 5.4.0 Motion Effects

TN 1-A1 PhA
The Sequences Section

5.15 Create Shows

The "Create Shows" section of the Control Panel is used to create, edit, schedule, and verify shows. A
show is a group of sequences that will be played together. They can be played using the Show Player.
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Light-O-Rama Control Panel v6.0.9 Pro
Menu Create & Schedule Shows

. 2020 Halloween
Controller Setu
: @ Inactive Starts at scheduled time

3
395 Networks Saturday, October 31, 2020 5:00 PM - 10:00 PM

hl Test Lights 2021 Christmas (5] Needs prep: 7

Sequences

1 1
- riday, December 24, 2021 - Saturday, December 25, 202 : - 114
@ Create Shows Friday, D ber 24, 2021 - Saturday, D ber 25, 2021 4:00 PM - 1100 PM

| > | Play Shows s e [ 5] Needs prep: 5
®  Active Starts at scheduled time 14:2840

C’D Inactive Starts at scheduled time 14:54.46

Wednesday, December 1, 2021 - Friday, December 31, 2021 5:00 PM - 10:00 PM

ﬂ SD Cards Thursday, December 1, 2022 - Saturday, December 31,2022 Sun, Mon, Tue, Wed, Thu  5:00 PM - 10:00 PM
4 . Thursday, December 1, 2022 - Saturday, December 31, 2022 Fri, Sat 5:00 PM - 11:00 PM
=7 License

Sunday, December 25, 2022 Every Day 4:00 PM - 11:00 PM

2022 Halloween E] Ready to play

7 ® Active Starts at scheduled time 07:12.88
* Settings

A list of 4 shows and their associated schedules

Each show in the list displays the show's name and some information about its schedule. Hovering your
mouse over the schedule information will show more details in a tool tip.

2022 Halloween | | Ready to play [

> @ Inactive Starts at scheduled time 07:12.38

Monday, October 31, 2022 5:00 PM - 10:00 PM

1 line for each Start type

schedule entry (on schedule or by trigger)

Activate or deactivate Playback status
the schedule Click button to prepare show

Each show can be active or inactive. Only active shows will be scheduled by the Show Player. Howewer,
you can still play inactive shows using Show On Demand. Setting a show active or inactive can be done
directly from the list of shows, or it can be set while editing a show (in the Dates & Times section).

The buttons at the top right allow you to:
¢ Add a new show

o Edit the selected show. You can also do this by double-clicking on a show in the list.
¢ Remowe a show from the list
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e Import a show
e Update the playback readiness status

If a show is displayed with a red icon in front of its name, it indicates that the show file (LSS file
extension) cannot be found. If the file has been renamed or moved, you can double-click on the item and
you will be prompted for the new show file location.

Test Show | | Show file missing

@® ) Inactive Starts at scheduled time 00:00.00

Mo schedule set for this show

The show file is missing for this show

Add Or Edit A Show

To add a new show, click the Add button in the heading.

To edit a show, select a show from the list so that it is highlighted, then click the Edit button in the
heading. Alternatively, you can double-click on a show to immediately open the Edit Show dialog. If you
double-click, be sure to awoid the Active toggle, or you might change its setting inadvertently.

Either action will open the Show dialog where you can assemble the playlist and set the show's
schedule.

Remove A Show

To remowve a show, select it from the list, then click the Remowve button. This will permanently remowve the
show's schedule and playlists from your computer -- so use with caution!

Import A Show

Clicking on the "Import" button at the upper right will prompt you to select an LOR Show file (LSS file
extension). Shows files were created in prior versions of the software using the Show Editor, or the LOR
Hub's "Simple PC Show" function, or the older Simple Show Builder program. The Import function allows
you to bring shows built with these older tools into S6. Once the show has been imported, it will be
displayed in the Edit Show dialog.

Show Readiness

After you have created (or purchased) your sequences and put them into a show, there is still one more
step before the show can be played: the show must be prepared for playback. Show readiness status is
listed on the right side of the entry for each show.
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|E| Ready to play

071288

5:00 PM - 10:00 PM

|E| Needs prep: 0, Emrors 1

00:00.00

|E| MNeeds prep: 5

000542

There is a button, and then to its right is the status. Here is what the status messages mean:

e Ready to play - the show has been prepared and is ready to play. There should be no delays
when the show starts to play.

e Errors: <number> - the number indicates the number of sequences that cannot be played for one
reason or another. Edit the show, then go to the Verifier section to see any problems.

e Needs prep: <number> - the number indicates the number of sequences that need preparation
before they can be played. You can either:
o start the preparation manually by clicking the button to the left of the status message, or
0 wait and let your show play, in which case the preparation will be done right before each

sequence starts for the first time.

Preparing the Show

If there are sequences in a show that need preparation, click this button to prepare them. The
process will happen in the background so you can continue to use the Control Panel for other
things. While preparation is running, the button will be replaced by a spinning icon and the status
will change to a percentage, letting you know how far along the process is.

This picture shows preparation in progress, with the percent complete displayed:

2022 Halloween 31.8%
® Active Starts at scheduled time 071288

Monday, October 31, 2022 5:00 PM - 10:00 PM

How Long Does Preparation Take?

The length of time it takes to process a sequence depends on several factors including the length of the
sequence, the number of channels it is controlling, the number of effects, and the speed of the computer.
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A 16 channel sequence can usually be processed in a few seconds. A long sequence for a display with
thousands of pixels could take several minutes, or several hours, depending on its complexity.

How Often Does Preparation Need To Be Done?
A show needs to be prepared for playback any time one of these items change:

Sequences are added to the show

A sequence in the show is changed using the Sequencer

A preview for any of the sequences in the show is changed

In the Networks panel, an LOR network is changed from non-enhanced to enhanced (or vice
versa).

The status shown in the list may not update automatically when any the above occurs. Therefore, you
can use the "Update Status" button in the heading to get the latest status.

5.1.5.1 Add or Edit a Show

The Show dialog is reached from the Create Shows section of the Control Panel. It is used to create a
show or to edit an existing one.

§ Edit Show - 2021 Christmas - O

Show Sections Main | ADD | E] Main Sequences ) _ )
— The sequences that will run during the main part

Startup (1) 1 Christmas Eve Sarajevo-2021 00:0000 03:20.80 | of the show (between Startup and Shutdown).
P These sequences will be played one at a time and
Main (5) 2 Carol Of the Bells - David Foster-2021 03:29.80 02:31.00 | are usually musical sequences.
din
3 Santa Boogie Short-2021 06:00.80 02:07.38
Turn used lights off at the end of each
Shutdown (1) 4 HotChocolate-2021 080818 014249 | M oo

Animation 5 Little Drummer Boy - Fork&(C - 2021 095067 04:37.73

Background ® ) Play sequentially

Interactive (O Ppiay shuffied
Schedule

Dates & Times

Options
Delay between each sequence

Cleanup Sequence [optional). This sequence wall
be played after the completion of every sequence
in the main section,

The Show dialog
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Down the left side of the Show dialog is a menu. The top portion of the menu is used manipulate the
content of the show -- which sequences get played and in which order. The lower portion of the menu is
used to define the schedule for the show -- when it will be played. The last item on the menu is the
Verifier, which performs some checks on the show and will display warnings if something needs
adjustment.

A show consists of seweral sections. Each section senes a different purpose - for example, the "startup
section" is a list of sequences that will be played when the show begins, while the "animation section" is
a list of animation sequences that will be played throughout most of the show's duration (after startup
and before shutdown). All sections are optional.

On the left side of the dialog, there is a menu item for each section. For details on each of the sections,
please refer to the following:

The Startup Section
The Main Section

The Shutdown Section
The Animation Section

The Background Section
The Interactive Section

After specifying the sequences in your show, you can continue down the menu and:

e Schedule your show
e Select startup options

o Verify your show

Editing A Playlist

Each section of the show has a playlist, except the Interactive section which consists of multiple
playlists. A playlist is a list of sequences shown in the order that they may play. You can edit the
playlist using the 5 buttons at the top right. Using them you can:

Add one or more sequences
Replace a sequence
Remove a sequence
Change sequence order

In addition to the information shown on the playlist, you can hover your mouse over a sequence name
and a tool-tip will be displayed showing the sequence's full path.
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Section Move Down
Move Up

= ]
1 Christmas Eve Sarajevo-2021 00:00,00 03:29.30
2 Carol Of the Bells - Dawid Foster-2021 03:29.20 02:31.00

Name

3 Santa Boogie Short-2021 06:00.80 02:0738
4 HotChocolate-2021 08:08.18 01:42.49
5 Little Drummer Boy - ForK&(C - 2021 09:50.67 04:37.73

LA / 1

Sequence  Sequence Start Time  Seguence
Number Name within the  Duration
playlist

Total Number Total Playlist
of Sequences Duration
Duration: 14:28.40
Add A Sequence
To add a sequence to a section, click on that section's menu item, and then on the Add button at

the top. This will prompt you for the name of the sequence that you want to add (you can selected
multiple sequences here if desired).

Replace A Sequence
To replace one sequence with a different (keeping the same place in the playlist), select the

sequence to be replaced by clicking on its name, then click the "Replace” button. This will prompt
you for the name of the replacement sequence.

Remove A Sequence

Similarly, to remove an existing sequence in the playlist, select the sequence by clicking on its
name, and then click the large "Remowe" button. You can only remove 1 sequence at a time.

Change Sequence Order
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A sequence can be mowved up or down by simply dragging it with your mouse and dropping it in the
desired position. You can also reorder sequences by clicking on a sequence name and then clicking
the up arrow or down arrow button. This also works when multiple sequences are selected (use Ctrl-
click or Shift-Click to select multiple items). This generally affects the order that the sequences will
be played in, but not always: For example, in the musical section, you can select that the
sequences will be played in the order listed, or in a random shuffle; if you choose the latter, it
doesn't matter what order they are listed in. Similarly, in the animation section, you can select that
the sequences be played simultaneously (as opposed to sequentially); if you do, their listed order
does not matter.

Open the Sequence

To open a sequence in the Sequencer, simply double-click on it. Alternatively, you can right-click on
the item and select Sequence File > Open from the pop-up menu.

Right-Click Context Menu

You can right-click on any sequence in the playlist to view a pop-up menu of additional actions. The
pop-up menu consists of 3 items:

e The Sequence File sub-menu:
0 Open - opens the file in the Sequencer.
0 Open containing folder - opens the folder where the sequence is located in Windows File
Explorer.
o Copy path to clipboard - copies the location of the sequence file to the clipboard

Christmas Eve Sarajevo-2021

Carol
Sequence File Open
Santa

ia Fi o taining fold
4 HotCH Media File pen containing folder

5 Little Copy playlist to clipboard

Copy path to clipboard

e The Media File sub-menu (not displayed for animation sequences):
0 Open - opens the media file is the user's default media player
0 Open containing folder - opens the folder where the media file is located in Windows File
Explorer.
o0 Copy path to clipboard - copies the location of the media file to the clipboard
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Christmas Eve Sarajevo-2021 00:00.00 03:20.20
Carol Of the Bolle Moeid Eoctor 2001 03:2980 02:31.00

Santa Boc Sequence File 06:00.80  02:07.38

4 HotChocc Media File Open

5 Little Drui Copy playlist to clipboard Open containing folder

Copy path to clipboard

e The Copy playlist to clipboard command copies all items in the playlist to the clipboard.
The clipboard content has 3 columns of data and is suitable for pasting into a spreadsheet.
The 3 columns are:

0 Seqguence name
0 Sequence path
0 Sequence length in seconds

A B C
1 IChristmas Eve Sarajevo-2021 |'1ce5\2021\Christmas\christmas Eve Sarajevo-2021.loredit 209.8
2 |cCarol Of the Bells - David Foster-2021 nces\2021\Christmas\Carol Of the Bells - David Foster-2021.loredit 151
3 |Santa Boogie Short-2021 nces\2021\Christmas\Santa Boogie Short-2021.loredit 127.38
4 |HotChocolate-2021 nces\2021\Christmas\HotChocolate-2021.loredit 102.49
5 |Little Drummer Boy - Fork&C - 2021 nces\2021\Christmas\Little Drummer Boy - ForK&C - 2021.loredit 277.73

Missing Sequence File

Sometimes a sequence file referenced by a show can get renamed, moved, or deleted. When this
happens, a red document icon will be displayed to the left of the file name.

If the sequence is no longer needed in the show, you can remowve the sequence. To point the entry
to the new location for the sequence, use the Replace function.

The sequence "Cannot Find Me" is missing

Missing Media File

Sometimes the media file associate with a sequence can get renamed, moved, or deleted. When
this happens, a red music note icon will be displayed to the left of the file name.

If the sequence is no longer needed in the show, you can remove the sequence. To fix the sequence

So it points to the correct media file, open it in the Sequencer, then select Sequence > Media File
from the menu.
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Bad Audic Path 00:00.00 00:12.40

Media file is missing for the sequence "Bad Audio Path"

The Startup Section

When a show is started (at a time determined by the schedule), the sequences in its startup section
will be played, one at a time, in order. After they all have finished, the main portion of the show will
begin, consisting of the animation section and the main section.

You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.

If your Light-O-Rama software license is for the Advanced or Pro level, you additionally have control
over whether this section (and the rest of your show) starts immediately at its scheduled time, or
upon an input trigger (for example, when someone hits a "start" button). See "Show Startup
Options" for details.

§ Edit Show - 2021 Christmas - O

- . ( | Startup Sequences
Showsecions s B | 11
. |—| When a show is started (at a ime determined by

Startup (1) 1 Countdown-2020 00:00.00 00:11.06 | the schedule), the sequences in its Startup section
P will be played, one at a time, in order. After they

all have finished, the main portion of the show

Main (5) will begin.

Shutdown (1
M Turmn used lights off at the end of each
Animation sequence
Background
Interactive

Schedule

Dates & Times
Options

Verifier

Duration: 00:11.06 SHIELE

The Startup section, with 1 sequence
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The Main Section

After a show's startup section has completed, its main section will begin (as will its animation
section).

Only one sequence from the main section will play at a time. They can be played in the order listed
in the playlist, or shuffled randomly. If shuffled randomly, you can also control two different aspects
of how shuffling is done: Whether or not a sequence is allowed to be played a second time before all
sequences have played once, and whether or not a sequence is allowed to play twice in a row (this
latter does not apply if you have only one sequence in the musical section - it will definitely be
played back-to-back).

Play will continue until the show is shut down (at a time determined by the schedule). If the
sequences are to be played in the order listed, and the end of the list is reached before the show is
to shut down, play will loop back to the first sequence in the list.

Optionally, a "cleanup sequence" can also be specified in the main section. If so, that sequence will
be played immediately after the completion of any sequence in the main section, before the next one
begins. Also optionally, a delay can be specified between songs.

You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.

§ Edit Show - 2021 Christmas - O
Main Sequences

[rerace] (o] ] SV
/ The sequences that will run during the main part

00:0000 022980 | of the show (between Startup and Shutdown).
These sequences will be played one at a time and
03:29.80 02:31.00 | are usually musical sequences.

06:00.20 02:0738

Show Sections Main

1 Christmas Eve Sarajevo-2021

Startup (1)
. 2 Carol Of the Bells - Dawvid Foster-2021
Main (5)
3 Santa Boogie Short-2021
Turmn used lights off at the end of each

Shutdown (1)

Animation

Background

Interactive
Schedule

Dates & Times

Options

Verifier

4 HotChocolate-2021

5 Little Drummer Boy - Forl(&C - 2021

Total: 5

08:08.18
09:50.67

Duration: 14:28.40

01:42.49
04:37.73

sequence

O Play sequentially
® ' Play shuffled

D Sengs can be repeated before all
songs are played

D The same song can be played back-to-
back

Delay between each sequence

secunds

Cleanup Sequence {optional). This sequence will
be played after the completion of every sequence
in the main section.

The Main section, shuffled playback, with a5 second delay between sequences
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The Shutdown Section

When the end of a show is reached (at a time determined by the schedule), its animation section
and musical section will end, and its shutdown section will begin. Sequences in the shutdown
section will play, one at a time, in the order listed. After they all have completed, the show is truly
finished.

You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.

§ Edit Show - 2021 Christmas - O

- , ( | Shutdown Sequences
shutd 200 | [sernce] (o] (] [+]
Show Sections Licown |—| When the end of a show is reached (at a time

1 Closing-2020 00:00.00 00:15.00 | determined by the schedule), its Main and
Startup (1) 3 Animation sections will end, and its Shutdown

3 section will begin. Sequences in the Shutdown
Main (5) section will play, one at a time, in the order listed.
After they all h leted, the show is trul
Shutdown (1) ﬁnifLEdeya ave completed, the show is truly
Animation
Turn used lights off at the end of each
Background sequence

Interactive
Schedule

Dates & Times

Options

Verifier

Duration: 00:15.00

The Shutdown section

The Animation Section

After a show's startup section has completed, its animation section will begin (as will its main
section).

Sequences in the animation section can be played concurrently or sequentially. If you choose to
play them sequentially, the first in the list will be played, and when it finishes, the next will be
played, and so forth. After all of them have been played, the first in the list will be played again. This
pattern will continue until the show is shut down (at a time determined by the schedule).

If they are played concurrently, all of them will be played at once, and whenever one reaches its end,
it will simply loop back to its beginning and keep playing. Again, this will continue until the show is
shut down.
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You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.

Only animation sequences can be used in the animation section of a show.

% New Show - O

Show Sections Animation E] Ar!lmallon Sequences ) _
Animation sequences that will run during the

00:00.00 00:10.00 | show (between Startup and Shutdown). These
sequences run concurrently with the Main
00:10.00 00:10.00 | saction.

00:20.00 00:10.00
Shutdown Turn used lights off at the end of each
sequence

Startup

Main

Animation (3)

® | Play concurrently

Background

Interactive O Play sequentially

Schedule
Dates & Times
Options

Verifier

The Animation section, with 3 sequences that will play concurrently

The Background Section

When a show is started, all of the sequences in the show's background section will start playing,
simultaneously. When such a sequence reaches its end, it will simply loop back to its beginning
and keep playing. All of these sequences will continue playing in this way until the show ends (also
at a time determined by the schedule).

If your Light-O-Rama software license is for the Advanced feature level, you additionally have control
over whether this section (and/or the rest of your show) starts immediately at its scheduled time, or
upon an input trigger (for example, when someone hits a "start" button). See "Show Startup
Options" for details.

Only animation sequences can be used in the background section of a show.

Channels controlled by a background sequence should be separate from the channels used

by other sequences. This means that sequences in the background section should use a
different preview than sequences in the other sections.
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% New Show - O

- Background Sequences
S m When a show is started (at a ime determined by

1 TuneTo Sign 00:00.00 00:10.00 | the schedule), all of the sequences in this section
Startup - will start playing, simultanecusly. When such a
3 sequence reaches its end, it will simply loop back
Main to its beginning and keep playing.

Shutdown
Animation (3)
Background (1)
Interactive

Schedule

Dates & Times
Options

Verifier

Total: 1 Duration: 00:10.00 Sasls

The Background section, with asingle sequence

The Interactive Section

Some Light-O-Rama controllers can be used not only to control lights, but also to accept input from
people, causing Light-O-Rama to play sequences on demand. For example, you could have a big
red button as part of your display, which when pressed, will cause Light-O-Rama to start playing a
particular song or songs.

This is controlled through the interactive section of the show. You can use this section to specify
what sequences are to be played when particular inputs are triggered. Please see the separate

topic on interactive groups for details.

Note that, unlike for the other sections of the show, the "Interactive" section actually lists groups of
sequences, rather than directly listing sequences. Again, please see the page on interactive groups
for details on how to create and modify these groups of sequences.

You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox, but
unlike in other sections of the show, this setting is controlled individually for each interactive group,
rather than for the section as a whole.
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¥ Edit Show - Interactive singing faces-2022 - O

Interactive Groups
List the interactive groups that will wait on

4= — —— | tnggers during the show [between Startup and
Startup Singing Faces Group (][] s o). 4 2
Type: Soundboard, Triggers: 8 —

Show Sections |E|

Main
Shutdown
Animation
Background
Interactive (1)
Schedule
Dates & Times
Options

Verifier

The Interactive section, with 1 group

Schedule Dates & Times
A show's schedule is composed of schedule entries specifying when the show will run.

A newly created show does not have any schedule entries, and a show without schedule

entries will NOT RUN. So it isimportant that you visit this section when creating a show!

A schedule entry specifies 3 things:

e When the show will play. This consists of a start time and an end time of your choosing. The time
range could be 5pm to 10pm; or it can cross midnight, starting at 8pm and ending at 2am for
example.

e What days of the week the show will play. The Add button will default to running 7 days per week.
The Add Weekdays button will default to running Sunday through Thursday. And the Add
Weekend button will default to running on Friday and Saturday.

¢ The date range for the show. After pressing the Add, Add Weekdays, or Add Weekend buttons,
the start date will default to the current day and the end date will not be populated, meaning it will
run on the specified days of the week from now to eternity.
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§ Edit Show - 2022 Halloween O

Schedule ® Active | ADD | | ADD WEEKDAYS | | ADD WEEKEND | | REMOVE ALL |

Show Sections

Startup PLAY TIME DATE RANGE

Main (5) Start | 5:00 PM Start | 10/31/2022
Shutdown End | 1000 PM End | 10/31/2022
Animation

Play on:
Background

' Sunday =~ Monday « Tuesday '~ Wednesday =~ Thursday [ Friday ~ Saturday
Interactive

Schedule
Dates & Times
Options

Verifier

A single schedule entry that will run from 5pm to 10pm on 31 Oct 2022

The schedule above will run from 5pm to 10pm on a single day: 31 Oct 2022. Even though all days of
the week are specified, the date range will constrain the schedule to a single day. Since 31 Oct 2022
is a Monday, this schedule would run the same if only Monday were checked. If Monday were not
checked, the show would not run at all

To remove a schedule entry, click the trash can icon on the right edge of the entry. You can remowe all
entries at once by clicking the "Remowve All" button at the top right.

% New Show - O
show Sections Schedule @ Inactive |E| | ADD WEEKDAYS | | ADD WEEKEND | | REMOVE ALL |

Startup PLAY TIME DATE RANGE

Main Start | 5:00 PM Start | 10/31/20;

Shutdown End End | 10/31/2022

Animation

Play on:
D Sunday
Interactive

A single schedule entry that will run from 5pm on 31 Oct 2022 until 2am on 1 Nov 2022

Background

Here is a similar schedule, except the end time is not until 2am the following day (Tuesday 1 Nov
2022). Note that this will run as expected until 2am on Tuesday 1 Nov 2022 even though Tuesday is
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not checked and the end date is 10/31/2022. That is because the date range and the days of the week
constrain the start time, not the stop time.

§ New Show O

Show Sections Schedule @ ) Inactive |E| | ADD WEEKDAYS | | REMOVE ALL |

Startup PLAY TIME DATE RANGE _|

Main Start | 5:00 PM Start | 8/11/2022
Shutdown End 10:00 PM Optionally select a date

Animation

Play on:
Background
' Sunday »/ Monday =~ Tuesday v Wednesday =/ Thursday D Friday D Saturday

Interactive

Schedule PLAY TIME DATE RANGE

Dates & Times Start | 5:00 PM Start | 8/11/2022

Dptions End 11:00 PM

Verifier

Play on:
D Sunday D Monday D Tuesday D Wednesday D Thursday ~* Friday |~ Saturday

The schedule after pressing the "Add Weekdays" and "Add Weekend" buttons

You can create a quick schedule by clicking the "Add Weekdays" button and then the "Add
Weekend" button. The resulting schedule is shown abowe. It will run from 5pm to 10pm Sunday
through Thursday, and from 5pm to 11pm on Friday and Saturday. Because there are no end dates
specified, this schedule will play at the schedule times whenever the Show Player is active.

Show Startup Options

If your Light-O-Rama software license is for the Advanced or Pro lewvel, you have more control over
exactly how your show will start up. Select the Options section, where you can choose from:

e Start at scheduled time
e Triggered startu
¢ Immediate backaground startu
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% Edit Show - 2021 Christmas
Show Sections Startup Type

® | Start at scheduled time
Startup (1)

O Start on trigger

Main (5)

Start on trigger, but start show background immediately
Shutdown (1) O

LOR Network Unit ID Input Number

Animation
e i+

Background

Interactive
Schedule

Dates & Times

Options

Verifier

Show Options section

Start At Scheduled Time

In this mode, your show will begin immediately at its scheduled start time.

Start On Trigger

In triggered startup mode, your show will start when a specified circuit on a specified Light-O-Rama
controller is triggered (as long as it is triggered during the show's scheduled run time). For example,
you could hook up a big red button labeled "Start the Show" to a controller. Please note that
triggers are not supported on LOR Enhanced networks.

Immediate Background Startup

In immediate background startup mode, your show's Background section will start immediately at
the show's scheduled start time, but the rest of the show will not start until a specified circuit on a
specified Light-O-Rama controller is triggered (as long as it is triggered during the show's scheduled
run time). Please note that triggers are not supported on LOR Enhanced networks.

Verifier

In the Verifier section, you can check your show (and the sequences used in the show) for issues that
might cause problems when it is played. Just click the "Check Show" button to get started.
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When all checks hawe finished, you can refer to the List of Verifier Messages to find out more about a
particular message.

§ New Show

. Verifier
Show Sections

Chedks Performed: 0

Startup
Check Show Errors Detected: ]
Main

Wamings Detected: 0
Shutdown

Animation
Background
Interactive

Schedule

Dates & Times
Options

Verifier

5.1.5.2 Interactive Groups

Some Light-O-Rama controllers can be used not only to control lights, but also to accept input that can
be used to trigger a seguence or sequences. For example, your display might have several buttons for
people to press, each of which will cause Light-O-Rama to play some particular song on demand.

This is controlled through the Interactive Section of a show. Unlike the other sections of a show, the
"Interactive” section displays not sequences, but groups of sequences, known as "interactive groups".
Each group matches individual circuits on individual controllers with individual sequences to be played
when those circuits are triggered.

Only one musical sequence can be playing at any given time. Therefore, if a musical sequence from an
interactive group is triggered, any musical sequence that happens to already be playing will be stopped
(for one exception to this, see the "Jukebox" type of interactive group, below).
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¥ Edit Show - Interactive singing faces-2022 - O

| Interactive Groups

Show Sections | ADD | - . I
——' List the interactive groups that will wait on

Startup Singing Faces Group |?| |57| ;ﬁg;f:w ‘:l;lﬂ'"g the show (between Startup and
Type: Soundboard, Triggers: 8 —
[V ET
Shutdown
Animation
Background
Interactive (1)
Schedule

Dates & Times
Options

Verifier

The Interactive Section

In the Interactive section you see the list of interactive groups for the show. The group's hame, type
(Soundboard in the above example), and number of triggers are displayed for each item.

e To add a new group, click the Add button at the top of the list. This will open a new window
where you can enter data for the group. See Choosing Sequences for a Group.

e To remowve a group, click the trash can icon to the right of the group's name.

¢ To edit a group, double-click on the group's name, or click the Edit icon to the right of the
trash can. This will open a new window where you can modify data for the group. See

Choosing Sequences for a Group.

Types of Interactive Groups
There are 3 types of interactive groups:

e Jukebox

e Soundboard

e Magqic To

Jukebox

"Jukebox" interactive groups allow you to define a group of sequences, each hooked up to be
triggered by an individual circuit on some LOR controller, such that only one sequence in the group
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can be playing at any given time, and if one already is playing when another is triggered, the first will
continue playing uninterrupted, and the trigger will be ignored.

If you assign more than one sequence to a single circuit in a single jukebox, then whenewer that
circuit is triggered, the "next" sequence in the list, round-robin, will be played.

Both musical sequences and animation sequences can be placed into a jukebox interactive group.

Soundboard

"Soundboard" interactive groups are similar to jukebox interactive groups in that only one sequence
in the group can be playing at any given time. Howewer, unlike jukebox interactive groups, triggering
a sequence while another sequence from the group is currently playing will cause the playing
sequence to stop, and the triggered sequence to start.

If you assign more than one sequence to a single circuit in a single soundboard, then whenever that
circuit is triggered, the "next" sequence in the list, round-robin, will be played.

Both musical sequences and animation sequences can be placed into a soundboard interactive
group.

Magic Toy

"Magic toy" interactive groups allow you to set up a group of sequences such that many of them can
be started simultaneously by a single trigger. Any sequences already playing from the group will be
stopped when the new set is started.

Only animation sequences (as opposed to musical sequences) can be placed into a magic toy
interactive group.

Choosing Sequences for a Group
In the "Edit Interactive Group" screen:

o The list of trigger groups will be shown in the top half of the window, and
e Clicking on a particular trigger will show the sequence(s) for that trigger in the bottom half.

So define the trigger first, then add 1 or more sequences associated with that trigger.
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W Edit Interactive Group

Interactive Group Properties

Name Type

Singing Faces Group Soundboard -

] Only one sequence from this group can be playing at =

| any given time. If a unit/circuit from this group is
triggered, but a sequence from this group is already
playing, the playing sequence will imnmediately stop,
and the sequence associated with the triggered unit/
circuit will be played.

Trigger Groups
Regular, 10, Input 1
Regular, 10, Input 2

Regular, 10, Input 3 v

Regular, 10, Input 4 »~/" Tumn used lights off at the end of each sequence

Selected Trigger Group Properties

LOR Network Unit ID (hex) Input Number Name

=

1 A Holly Jolly Christmas Michael Buble 00:00.00 01:59.90

Duration: 01:59.90

An Interactive Group with aset of triggers. The first trigger is selected and is associated with the
sequence "A Holly Jolly Christmas Michael Buble".

Top Half
This section is titled "Interactive Group Properties".
¢ Enter a name for the interactive group in the text box in the top left.

¢ Select the interactive group type using the drop-down box at the upper right. A description of the
selected type will be displayed below it.

o A list of trigger groups is listed on the left.
o To add a new trigger, click the "Add" button abowve the list.
o0 To remowe a trigger, click the trash can on the right side of the list item.
o To edit an item, simple select it, so that it is highlighted. The details for that trigger group will be
displayed in the bottom half of the window.

e To turn the lights off when this interactive group finished playing, check the box below the
interactive group type description.

Bottom Half

This section is titled "Selected Trigger Group Properties".
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5.1.5.3

On the first line you define the trigger's network, unit, and circuit. You can also assign a name to the
trigger: Some important notes:

e The network assigned to the trigger must be an LOR network that is NOT enhanced.

¢ You can test the trigger in the Hardware Utility using the Test Inputs function.

Below the trigger information is a playlist, where you can select the sequences that get played when
that trigger is activated.

List of Verifier Messages

The following messages can be generated by the Show Verifier. For details on any given one, please
refer to its individual help page.

Message 1 (Info): No errors or warnings found

Message 2 (Warning): Verification cancelled

Message 3 (Error): Light-O-Rama is not fully installed

Message 4 (Error): No registry entry for application path

Message 5 (Error): Application directory does not exist

Message 6 (Warning): Verifier not running from LOR application path
Message 7 (Error): Application file does not exist

Message 8 (Error): Unlicensed LOR demo version used

Message 9 (Warning): Unsupported version of Windows Media Player
Message 10 (Error): No registry entry for user data path

Message 11 (Error): User data directory does not exist

Message 12 (Warning): No registry entry for non-media data path
Message 13 (Warning): Non-media data directory does not exist
Message 14 (Warning): No registry entry for media data path
Message 15 (Warning): Media data directory does not exist

Message 16 (Error): Application file has unexpected version number
Message 17 (Warning): Weekly schedule file does not exist

Message 20 (Warning): No shows are scheduled

Message 21 (Error): Show file does not exist

Message 22 (Error): Error reading show file

Message 23 (Error): Sequence file does not exist

Message 24 (Error): Sequence file cannot be loaded

Message 25 (Warning): Show has no sequences

Message 26 (Error): Media file does not exist

Message 27 (Warning):
Message 28 (Warning):
Message 29 (Warning):
Message 30 (Warning):
Message 31 (Warning):
Message 32 (Warning):
Message 33 (Warning):
Message 34 (Warning):
Message 35 (Warning):
Message 36 (Warning):
Message 37 (Warning):
Message 38 (Warning):
Message 39 (Warning):
Message 40 (Warning):
Message 41 (Warning):
Message 42 (Warning):

Conflicting channel settingsin sequence
Channel is completely off

Sequence is completely off

Channel is missing settings

Channel uses undefined comm network
Channel in tracks of conflicting length
Musical file used in non-audio section of show
Subsequences not supported
Background sequences unsupported
Startup sequences unsupported
Shutdown sequences unsupported
Interactive triggers unsupported
Unsupported number of tracks

Shell commands unsupported

Shell command map file does not exist
Shell command not set
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Message 43 (Warning): Channel conflict

Message 44 (Warning): Old MC-P compatibility enabled

Message 45 (Warning): Channel settings conflict in sequence/intensity file
Message 46 (Warning): Channel settings conflict in intensity file

Message 47 (Warning): Intensity file conflict

Message 48 (Warning): Channel/intensity file conflict

Message 49 (Warning): Intensity file uses undefined comm network
Message 50 (Warning): Intensity files not supported by license level
Message 53 (Warning): Trigger uses undefined network

Message 54 (Warning): Trigger uses LOR Enhanced network

5.1.5.3.1 1: No errors or warnings found

Message Number: 1
Severity: Info
Summary: No errors or warnings found

If the Show Verifier does not find any errors or warnings (other than those you have told it to ignore), it
will output this message.

Show Verifier
List of Verifier Messages

5.1.5.3.2 2: Verification cancelled

Message Number: 2
Severity: Warning
Summary: Verification cancelled

If you hit the cancel button while the Show Verifier is checking for problems, it will stop checking, display
any issues that it has found to that point, and additionally display this message to warn you that there
may be other issues that it would have found had it not been cancelled.

Note that it may not stop immediately when you hit the cancel button; it may finish its current check
first.

Show Verifier
List of Verifier Messages

5.1.5.3.3 3: Light-O-Rama is not installed

Message Number: 3
Severity: Error
Summary: Light-O-Rama is not fully installed

The installation of Light-O-Rama is not complete. This could occur, for example, if the installation was
interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from your computer's
Windows registry.

If the problem is that the registry entries have been deleted, you can solwe it by running the LORPost
utility, which is typically automatically run after installation. This utility can be found in the directory
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where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one lewvel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.4 4: No registry entry for application path

Message Number: 4
Severity: Error
Summary: No registry entry for application path

A required Light-O-Rama entry in the Windows registry cannot be found. This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry. You will not be able to use Light-O-Rama until this problem is
resolved.

If the problem is that the registry entries have been deleted, you can solwe it by running the LORPost
utility, which is typically automatically run after installation. This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one lewel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.5 5: Application directory does not exist

Message Number: 5

Severity: Error

Summary: Application directory does not exist
Details: The name of the directory that is missing

The Windows registry says that the Light-O-Rama program files, such as the Sequencer and the
Hardware Utility, can be found in a certain directory, but that directory does not actually exist. You will
not be able to use Light-O-Rama until this problem is resolved.

It is suggested to uninstall and reinstall Light-O-Rama.
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Show Verifier
List of Verifier Messages

5.1.5.3.6 6: Verifier not running from LOR application path

Message Number: 6

Severity: Warning

Summary: Control Panel not running from LOR application path

Details #1: The name of the directory that LOR program files should be contained in
Details #2: The name of the directory that the Control Panel is running from

The various Light-O-Rama program files, such as the Sequencer and the Hardware Utility, are expected
to be found in a certain Windows directory. The Control Panel itself is one such program. Howewer, the
copy of the Control Panel that you are running is actually contained in a different directory.

This may not be a problem, for example if you intentionally copied the Control Panel to a different
directory and ran it from there.

However, it might indicate that you are using an old version of the Control Panel from a previous
installation, and that old Control Panel may not be completely compatible with the current installation.
Or, it might be indicative of a deeper problem with the installation of Light-O-Rama.

It is suggested that you run the Control Panel from the same directory where the Light-O-Rama program
files are installed. If you are doing so, and still get this error, consider uninstalling and reinstalling Light-
O-Rama.

Show Verifier
List of Verifier Messages

5.1.5.3.7 7: Application file does not exist
Message Number: 7
Severity: Error

Summary: Application file does not exist
Details: The expected directory and filename of the missing application file

One of the Light-O-Rama program files, such as the Sequencer or the Hardware Utility, cannot be found.

Depending upon exactly what is missing, your shows may still be able to play. Howewer, they may not,
and in any case, something is definitely wrong.

It is suggested that you uninstall and reinstall Light-O-Rama.

Show Verifier
List of Verifier Messages

5.1.5.3.8 8: Unlicensed LOR demo version used
Message Number: 8

Severity: Error
Summary: Unlicensed LOR demo version used

Your Light-O-Rama software has not been registered. Until you register it, it will not actually control your
lights (and will have other limitations as well).
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This may have occurred for various reasons - for example, it simply may be that you have not yet
purchased a Light-O-Rama license. If you do have a license, though, you may not have entered it on this
computer, or perhaps you have recently installed a new version of Light-O-Rama (in which case your
license may or may not be valid for this new version). Or, perhaps your licensing information has been
deleted from the Windows registry, perhaps by a registry cleanup tool.

If you have not yet purchased a license, you can do so from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
cowered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.

Show Verifier
List of Verifier Messages

5.1.5.3.9 9: Unsupported version of Window s Media Player

Message Number: 9
Severity: Warning
Summary: Unsupported version of Windows Media Player

The version of Windows Media Player installed on this computer is older than the minimum version
required by Light-O-Rama, or, perhaps, Windows Media Player is not correctly installed.

You may still be able to use Light-O-Rama, but it will (at the very least) be severely limited - for example,
musical sequences will not play. It is suggested that you install the latest version of Windows Media
Player.

Show Verifier
List of Verifier Messages

5.1.5.3.10 10: No registry entry for user data path
Message Number: 10

Severity: Error
Summary: No registry entry for user data path

A required Light-O-Rama entry in the Windows registry cannot be found. This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry.

Your shows will not run successfully until this problem is resolved.

If the problem is that the registry entries have been deleted, you can solwve it by running the LORPost
utility, which is typically automatically run after installation. This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
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directory one lewvel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.11 11: User data directory does not exist

Message Number: 11

Severity: Error

Summary: User data directory does not exist
Details: The name of the missing directory

The directory that Light-O-Rama expects to find Light-O-Rama data files in does not exist. This could
occur, for example, if the installation was interrupted, or if a registry cleanup utility deleted certain Light-
O-Rama entries from your computer's Windows registry, or if the directory was deleted or renamed.

Your shows will not run successfully until this problem is resolved.

You may be able to solve this problem by running the LORPost utility, which is typically automatically
run after installation. This utility can be found in the directory where you installed your Light-O-Rama
program files, which is typically (but not always) C:\Program Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one lewvel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.12 12: No registry entry for non-media data path

Message Number: 12
Severity: Warning
Summary: No registry entry for non-media data path

A required Light-O-Rama entry in the Windows registry cannot be found. This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not. Ewen if the shows themselves do run, certain sequences in them may not.

If the problem is that the registry entries have been deleted, you can solwve it by running the LORPost
utility, which is typically automatically run after installation. This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.
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Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one lewvel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.13 13: Non-media data directory does not exist

Message Number: 13

Severity: Warning

Summary: Non-media data directory does not exist
Details: The name of the missing directory

The directory that Light-O-Rama expects to find Light-O-Rama sequence files in does not exist. This
could occur, for example, if the installation was interrupted, or if a registry cleanup utility deleted certain
Light-O-Rama entries from your computer's Windows registry, or if the directory was deleted or renamed.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not. Even if the shows themselves do run, certain sequences in them may not.

You may be able to solve this problem by running the LORPost utility, which is typically automatically
run after installation. This utility can be found in the directory where you installed your Light-O-Rama
program files, which is typically (but not always) C:\Program Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one lewel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.14 14: No registry entry for media data path

Message Number: 14
Severity: Warning
Summary: No registry entry for media data path

A required Light-O-Rama entry in the Windows registry cannot be found. This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not. Ewen if the shows themselves do run, certain sequences in them may not.

If the problem is that the registry entries have been deleted, you can solwve it by running the LORPost
utility, which is typically automatically run after installation. This utility can be found in the directory
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where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one lewvel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.15 15: Media data directory does not exist

Message Number: 15

Severity: Warning

Summary: Media data directory does not exist
Details: The name of the missing directory

The directory that Light-O-Rama expects to find audio and video files in does not exist. This could occur,
for example, if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama
entries from your computer's Windows registry, or if the directory was deleted or renamed.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not. Even if the shows themselves do run, certain sequences in them may not.

You may be able to solve this problem by running the LORPost utility, which is typically automatically
run after installation. This utility can be found in the directory where you installed your Light-O-Rama
program files, which is typically (but not always) C:\Program Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored. If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one lewvel above that directory. For example, if your sequences are stored in C:
\LOR\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

Show Verifier
List of Verifier Messages

5.1.5.3.16 16: Application file has unexpected version number

Message Number: 16

Severity: Error

Summary: Application file has unexpected version number
Details #1: The name of the application file

Details #2: The expected version number of the application file
Details #3: The actual version number of the application file

A certain Light-O-Rama program file, such as the Sequencer or the Hardware Utility, has a version
number other than the one that the Verifier was expecting.
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This may be because you are using an old version of the Verifier from a previous installation, and that old
Verifier may not be completely compatible with the current installation. Or, it might be indicative of a
deeper problem with the installation of Light-O-Rama.

Make sure that you are running the copy of the Verifier that is in the same directory where your current
version of Light-O-Rama is installed. If you are doing so, it is suggested that you uninstall and reinstall
Light-O-Rama.

Show Verifier
List of Verifier Messages

5.1.5.3.17 17: Schedule file does not exist

Message Number: 17

Severity: Warning

Summary: Schedule file does not exist
Details: The name of the missing file

The file which is supposed to contain your show schedule does not exist.

If you do not intend to use the Show Player, this is not an issue. But if you do intend to hawe this
computer play scheduled shows, they will not be played until this problem is resolved.

Perhaps the file was renamed out of the way, in which case you can rename it back to the expected
name. Or, perhaps it was deleted; check your computer's Recycle Bin. If neither of these is the
problem, a new file should be created when you exit the Control Panel.

Show Verifier
List of Verifier Messages

5.1.5.3.18 20: No show s are scheduled
Message Number: 20

Severity: Warning
Summary: No shows are scheduled

You have no shows scheduled. A show will play until you add one or more schedule entries to it.

Show Verifier
List of Verifier Messages

5.1.5.3.19 21: Show file does not exist

Message Number: 21

Severity: Error

Summary: Show file does not exist
Details: The name of the missing show file

You have a show scheduled, but the file that is supposed to contain that show does not exist. The show
will not play until this problem is resolved.

If you do not want the show to play, this is not a problem, but you may want to remove it from the list of
shows so that this error message does not appear in the future.
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If you do want the show to play, perhaps its file was renamed, or deleted. If it was renamed, either
rename it back, or else to the new name of the show file instead of the old name. If it was deleted,
check your computer's Recycle Bin.

If these suggestions do not resolve the situation, you may hawe to recreate the show, using the Show
Editor.

Show Verifier
List of Verifier Messages

5.1.5.3.20 22: Error reading show file

Message Number: 22

Severity: Error

Summary: Error reading show file
Details: The name of the show file

You have a show scheduled, but the show cannot be loaded. For example, perhaps the show's file has
become corrupted. The show will not play until this problem is resolved.

If you have any backups of the show file, check to see if they work. Otherwise, you may have to
recreate the show, using the Show Editor.

Show Verifier
List of Verifier Messages

5.1.5.3.21 23: Sequence file does not exist

Message Number: 23

Severity: Error

Summary: Sequence file does not exist

Details #1: The name of the missing sequence file

Details #2: The name of the show file that this sequence is referenced in

One of your scheduled shows refers to a sequence file that does not exist. The sequence will not play in
the show until this problem is resolved.

If you do not want the sequence to play, this is not a problem, but you may want to remowe it from the
show (using the Show Editor) so that this message does not appear in the future.

If you do want the sequence to play, perhaps its file was renamed (or placed in a different directory), or
deleted.

If it was renamed (or placed in a different directory), you can either rename it back, or else use the Show
Editor to point to the new name instead of the old one.

If it was deleted, check your computers Recycle Bin, or any backups that you may have. Note that
whenever you change a sequence and sawe it (using the Sequencer), Light-O-Rama automatically saves
a backup copy of the file as it was before your changes, so you may be able to use that backup copy. It
will be saved to the same directory as the original, with the file extension ".bak" appended to its nhame.
For example, if your sequence is hamed "MySequence.las", the automatic backup will be named
"MySequence.las.bak".
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If none of these suggestions help, you may have to recreate the sequence, using the Sequencer.

Show Verifier
List of Verifier Messages

5.1.5.3.22 24: Sequence file cannot be loaded

Message Number: 24

Severity: Error

Summary: Sequence file cannot be loaded
Details: The name of the file

One of your scheduled shows refers to a sequence file that cannot be loaded. For example, perhaps the
sequence file has become corrupted. The sequence will not play in the show until this problem is
resolved.

If you have any backups of the sequence file, check to see if they work. Note that whenever you change
a sequence and sawe it (using the Sequencer), Light-O-Rama automatically saves a backup copy of the
file as it was before your changes, so you may be able to use that backup copy. It will be saved to the
same directory as the original, with the file extension ".bak" appended to its name. For example, if your
sequence is hamed "MySequence.las", the automatic backup will be named "MySequence.las.bak".

Otherwise, you may have to recreate the sequence, using the Sequencer.

Show Verifier
List of Verifier Messages

5.1.5.3.23 25: Show has no sequences

Message Number: 25

Severity: Warning

Summary: Show has no sequences
Details: The name of the show file

One of your scheduled shows has no sequences in it. This will not cause any problems - your other
scheduled shows should play fine - but there isn't much point to scheduling a show without sequences,
so this probably indicates a mistake.

If you want sequences to play in the scheduled show, go to the Control Panel's Create Shows section,
select your show, then add sequences to it.

If you do not want any sequences to play in the scheduled show, consider making the show inactive, so
that this message does not appear in the future.

Show Verifier
List of Verifier Messages

5.1.5.3.24 26: Media file does not exist
Message Number: 26

Severity: Error
Summary: Media file does not exist
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Details #1: The name of the missing media file
Details #2: The name of the sequence file that refers to the missing media file

One of your scheduled musical sequences refers to an audio file or video file that does not exist. The
sequence will not play until this problem is resolved.

It is possible that the file has been renamed, placed in a different directory, or deleted.

If it has been renamed or placed in a different directory, you can either mowve it back to its original
location, or else use the Sequencer to modify the sequence so that it points to its new location.

If it has been deleted, check your computer's Recycle Bin, or for any backups that you may have of the
file.

Show Verifier
List of Verifier Messages

5.1.5.3.25 27: Conflicting channel settings in sequence

Message Number: 27

Severity: Warning

Summary: Conflicting channel settings in sequence

Details #1: The name of the sequence having the conflict
Details #2: The track containing the first conflicting channel
Details #3: The name of the first conflicting channel

Details #4: The track containing the second conflicting channel
Details #5: The name of the second conflicting channel

One of your scheduled sequences contains two different channels that both are set up to control the
same physical string of lights - for example, they are both set up to control circuit 3 of Light-O-Rama unit
7 on the regular Light-O-Rama network.

Your sequence will play, but these two channels will fight for control over the lights hooked up to the
circuit, which may have make the lights behave in ways that you weren't expecting.

The cause of this may simply be that one of the two channels is set up with the wrong unit ID, circuit
number, network, or device type. In this case, use the Sequencer to change the channel's settings
appropriately.

If you do intend both channels to control the same string of lights, the lights may or may not behawe as
you expect. The suggested way to do what you probably want is not to have two different channels with
the same settings, but to have a single channel that is contained in two different tracks:

Let's say that you have "Channel A" in the first track, and "Channel B" in the second track. These
channels have the same physical settings as each other, but different effect events. Then to change this
situation to the suggested way, use the Sequencer as follows:

First, copy Channel A from the first track to the second track.

Next, merge the effect events from Channel B into Channel A, so that Channel A contains the effect
events from both channels.

Finally, delete Channel B.
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This will leave you with a single channel - Channel A - which is contained in both tracks, and which
contains all of the effect events that you wanted for its string of lights. Having this single channel in two
tracks, instead of two different channels in the two tracks, will make the lights behave as you probably
expect.

Show Verifier
List of Verifier Messages

5.1.5.3.26 28: Channel is completely off

Message Number: 28

Severity: Warning

Summary: Channel is completely off

Details #1: The sequence containing the channel
Details #2: The track containing the channel
Details #3: The name of the channel

One of your scheduled sequences contains a channel which is completely off for its entire duration.

Consider removing the channel from the sequence, using the Sequencer.

Show Verifier
List of Verifier Messages

5.1.5.3.27 29: Sequence is completely off

Message Number: 29

Severity: Warning

Summary: Sequence is completely off
Details: The name of the sequence file

One of your scheduled sequences has no lighting effects for any of its channels, except for having each
of them off for the sequence's entire duration.

This may be intentional - for example, you may have scheduled a musical sequence so that a song
plays while your lights are off. Otherwise, consider adding effects to the sequence, or removing the
sequence from the show.

Show Verifier
List of Verifier Messages

5.1.5.3.28 30: Channel is missing settings

Message Number: 30

Severity: Warning

Summary: Channel is missing settings

Details #1: The name of the sequence file containing the channel
Details #2: The track containing the channel

Details #3: The name of the channel

One of your scheduled sequences has a channel which is missing a required part of its physical settings
- for example, perhaps it does not have a unit ID set.
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This may be intentional - for example, perhaps you have a channel that shows the beat of a song, which
you intend to use to help build other channels rather than to actually control lights when your show
plays. If not, though, use the Sequencer to set the channel's settings appropriately.

Show Verifier
List of Verifier Messages

5.1.5.3.29 31: Channel uses undefined comm netw ork

Message Number: 31

Severity: Warning

Summary: Channel uses undefined comm network
Details #1: The sequence that the channel is in
Details #2: The track that that the channel is in
Details #3: The name of the channel

One of your scheduled sequences contains a channel which is set up to use a network which does not
have a comm port defined for it. The channel will not control lights until this issue is resolved.

The channel could be for a Light-O-Rama controller, which can be set up to use one of four different
networks.

It is possible that the channel's network (or device type) is simply set incorrectly. For example, perhaps
a channel for a Light-O-Rama controller was accidentally set to use the Aux A network, whereas you
only have a comm port assigned to the Regular network. Or perhaps a channel was accidentally set to
control a Dasher controller, whereas it was intended to control a Light-O-Rama controller. In cases like
these, use the Sequencer to change the channel's settings in Prop Definition.

Another possibility is that you do intend to use the network that the channel has assigned to it, but that
network is not set up to use any comm port on your computer. In this case, use the Network
Preferences program to specify a comm port for the network to use.

Show Verifier
List of Verifier Messages

5.1.5.3.30 32: Channel in tracks of conflicting length

Message Number: 32

Severity: Warning

Summary: Channel in tracks of conflicting length
Details #1: The sequence that the channel is in
Details #2: The name of the channel

Details #3: A track that the channel is in

Details #4: Another track that the channel is in

One of your scheduled sequences contains a channel which is in two different tracks, but those tracks
are of different lengths. For example, one track is a minute long, while the other is two minutes long.

This will likely cause the lights hooked up to that channel to behave in a way that you don't expect, as
different lighting effects from different parts of the same channel could be sent to the lights in an order
that you were not expecting.
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Unless you have done this intentionally, and understand the way that your lights will behave because of
this, consider using the Sequencer to either remowve the channel from one of the tracks or to change the
tracks to be of the same length.

Show Verifier
List of Verifier Messages

5.1.5.3.31 33: Musical file used in non-audio section of show

Message Number: 33

Severity: Warning

Summary: Musical file used in non-audio section of show
Details #1: The sequence file

Details #2: The show file that refers to the sequence

Details #3: The section of the show that refers to the sequence

One of your musical sequences is scheduled in a section of a show that does not support audio or video.
For example, perhaps a musical sequence is contained in the Background section of the show. The
sequence will play at its scheduled time, but will only control lights; it will not play audio or display video.

Make sure that the sequence is in the section of the show that you intend it to be in. If it is not, use the
Show Editor to mowe it to the appropriate section.

If it is in the section that you intended, consider using an animation sequence instead, to awid possible
confusion in the future.

Show Verifier
List of Verifier Messages

5.1.5.3.32 34: Subsequences not supported

Message Number: 34

Severity: Warning

Summary: Subsequences not supported

Details #1: The name of the subsequence

Details #2: The name of the parent sequence containing the subsequence

Details #3: The name of the channel in the parent sequence referencing the subsequence

One of your scheduled sequences contains a channel set up to be a subsequence, but your license
does not support subsequences (or you are using the unlicensed demo version of the software). The
parent sequence will play at its scheduled time, but the subsequence will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get the
subsequence to play, you would have to upgrade to a higher license level which supports subsequences.

If you are using the unlicensed demo \ersion, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you hawe already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.

© 2022 Light-O-Rama, Inc.


http://lightorama.com/

138 Light-O-Rama v6.1.0

Show Verifier
List of Verifier Messages

5.1.5.3.33 35: Background sequences unsupported

Message Number: 35

Severity: Warning

Summary: Background sequences unsupported

Details: The name of the show file containing sequences in its Background section

One of your scheduled shows contains sequences in its Background section, but your license does not
support sequences in this section. The show will play at its scheduled time, but sequences in this
section will not.

If you already have a license, and hawe registered Light-O-Rama on this computer, then to get these
sequences to play, you would have to either move them to a different section of the show, or else
upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo \ersion, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you hawve already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
cowered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.

Show Verifier
List of Verifier Messages

5.1.5.3.34 36: Startup sequences unsupported

Message Number: 36

Severity: Warning

Summary: Startup sequences unsupported

Details: The name of the show file containing sequences in its Startup section

One of your scheduled shows contains seguences in its Startup section, but your license does not
support sequences in this section. The show will play at its scheduled time, but sequences in this
section will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
sequences to play, you would have to either move them to a different section of the show, or else
upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you hawve already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.
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Show Verifier
List of Verifier Messages

5.1.5.3.35 37: Shutdow n sequences unsupported

Message Number: 37

Severity: Warning

Summary: Shutdown sequences unsupported

Details: The name of the show file containing sequences in its Shutdown section

One of your scheduled shows contains sequences in its Shutdown section, but your license does not
support sequences in this section. The show will play at its scheduled time, but sequences in this
section will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
sequences to play, you would have to either move them to a different section of the show, or else
upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
cowered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.

Show Verifier
List of Verifier Messages

5.1.5.3.36 38: Interactive triggers unsupported

Message Number: 38

Severity: Warning

Summary: Interactive triggers unsupported

Details: The name of the show file using interactive triggers

One of your scheduled shows uses interactive triggers, either in an interactive group or as part of its
startup options, but your license does not support interactive triggers. The show will play at its
scheduled time, but its interactive triggers will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
triggers to work, you would have to upgrade to a higher license level which supports subsequences. |If
your triggers are used for interactive groups, you could also mowe the sequences in them to a different
section of the show (but if so, they will play immediately, not upon being triggered).

If you are using the unlicensed demo \ersion, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
cowered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.
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Show Verifier
List of Verifier Messages

5.1.5.3.37 39: Unsupported number of tracks

Message Number: 39

Severity: Warning

Summary: Unsupported number of tracks

Details #1: The name of the sequence using too many tracks
Details #2: The number of tracks the sequence uses

Details #3: The allowed number of tracks

One of your scheduled sequences uses more tracks than your license supports. The sequence will play
at its scheduled time, but its excess tracks will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
tracks to play, you would have to upgrade to a higher license level which supports more tracks.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
cowered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.

Show Verifier
List of Verifier Messages

5.1.5.3.38 40: Shell commands unsupported

Message Number: 40

Severity: Warning

Summary: Shell commands unsupported

Details: The name of the sequence using a shell command

One of your scheduled sequences is set up to use a Windows shell command, but your license does not
support such commands. The sequence will play at its scheduled time, but the command will not be
executed.

If you already hawve a license, and have registered Light-O-Rama on this computer, then to get the
command to execute, you would have to upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo \ersion, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer. If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
cowered by your license, or perhaps your license is for an older version of Light-O-Rama than the one that
you are trying to run.

Show Verifier
List of Verifier Messages
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5.1.5.3.39 41: Shell command map file does not exist

Message Number: 41

Severity: Warning

Summary: Shell command map file does not exist
Details: The expected name of the shell command map file

One of your scheduled sequences is set up to use a Windows shell command, but the command map
file that defines the commands to execute does not exist. The sequence will play at its scheduled time,
but the command will not be executed.

This could be because you created the sequence on one computer, and mowved it to another computer to
play in your show, but did not move the command map file. Light-O-Rama keeps these commands in
the command map file, rather than in the sequences themselwes, due to security concerns. Please see

Sharing Sequences between Computers, and Security for details.

Show Verifier
List of Verifier Messages

5.1.5.3.40 42: Shell command not set

Message Number: 42

Severity: Warning

Summary: Shell command not set

Details: The name of the sequence file with the missing shell command

One of your scheduled sequences is set up to use a Windows shell command, but the command map
file does not list a command to be executed by that sequence. The sequence will play at its scheduled
time, but no command will be executed.

This could be because you created the sequence on one computer, and mowved it to another computer to
play in your show, but did not move the command map file. Light-O-Rama keeps these commands in
the command map file, rather than in the sequences themselwves, due to security concerns. Please see

Sharing Sequences between Computers, and Security for details.

Show Verifier
List of Verifier Messages

5.1.5.3.41 43: Channel conflict

Message Number: 43

Severity: Warning

Summary: Channel conflict

Details #1: The name of the show containing the channel conflict

Details #2: One of the sections of the show containing a sequence with the conflicting channel
Details #3: The sequence file in that section containing the conflicting channel

Details #4: The track in that sequence containing the conflicting channel

Details #5: The name of the conflicting channel in that track

Details #6: Another section of the show containing a sequence with the conflicting channel
Details #7: The sequence file in that section containing the conflicting channel

Details #8: The track in that sequence containing the conflicting channel

Details #9: The name of the conflicting channel in that track
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One of your scheduled shows contains sequences which could possibly play at the same time, but
which each contain a channel representing the same physical string of lights. For example, perhaps the
show contains one sequence in its Background section, and another in its Musical section, which each
contain a channel for Light-O-Rama unit 3 circuit 7 on the regular network. Since sequences in the
Background section can play at the same time as those in the Musical section, this is a conflict.

The show, and its sequences, will play at the appropriate times, but the two channels may fight for
control over the single string of lights that they are set up to use. This may lead to those lights behaving
in a manner that you are not expecting.

It is suggested that you use the Sequencer to check whether the channels are set up properly - for
example, perhaps the unit ID of one of the channels was mistakenly set to an incorrect value.
Otherwise, consider removing the conflicting channel from one of the sequences, or moving one of the
sequences to a different section of the show, where it could not be played at the same time as the other
sequence.

Show Verifier
List of Verifier Messages

5.1.5.3.42 44: Old MC-P compatibility enabled

Message Number: 44

Severity: Warning

Summary: Old MC-P compatibility enabled

Details #1: The network on which old MC-P compatibility is enabled

One of your networks has MC-P_compatibility enabled. This compatibility mode is required for certain
controllers, but they are rare (Light-O-Rama MC-P controllers purchased prior to November 15, 2003). If
you do not have any such controllers on this network, there is no reason to have this compatibility mode
enabled, and in fact it can cause significant overhead on the network, potentially leading to lag in your
lighting effects. It is suggested to turn this compatibility mode off (unless you have controllers that
require it), which can be done by going to the Control Panel's Settings section, then selecting the
"Comm" tab.

Show Verifier
List of Verifier Messages

5.1.5.3.43 45: Channel settings conflict in sequence/intensity file

Message Number: 45

Severity: Warning

Summary: Channel settings conflict in sequence/intensity file

Details #1: The sequence having the channel setting conflict

Details #2: The name of the track containing the channel having the settings conflict
Details #3: The name of the channel having the settings conflict

Details #4: The name of the intensity file having the channel settings conflict

Details #5: The range of addresses in the intensity file having the channel settings conflict

One of your sequences has a conflict between a channel defined in the sequence itself and an address
defined in an intensity file associated with the sequence. For example, perhaps the sequence contains
a channel which is set up to control Light-O-Rama unit 25 circuit 3 on the Regular LOR network, and the
associated intensity file has a range of controlled addresses that includes that circuit - for example,
perhaps the intensity file controls circuits 1 through 7 on unit 25 on the Regular Light-O-Rama network.
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In such cases, both the channel and the intensity file will simultaneously attempt to control the same
physical circuit, and the resulting behavior of the lights is unlikely to be what you want or would expect.

To resolve this issue, change the channel and/or address range so that they no longer conflict with each
other. Exactly how to do this depends upon the situation - for example, perhaps the conflict is due to a
typo made in the channel's settings (perhaps its unit number is incorrect), in which case change the
channel's settings. Or perhaps the issue should be resolved by changing the address range in the
intensity file, or by deleting either the channel or the address range.

Show Verifier
List of Verifier Messages

5.1.5.3.44 46: Channel settings conflict in intensity file

Message Number: 46

Severity: Warning

Summary: Channel settings conflict in intensity file

Details #1: The sequence having the channel setting conflict

Details #2: The name of the first intensity file having the channel settings conflict
Details #3: The first range of addresses having the channel settings conflict

Details #4: The name of the second intensity file having the channel settings conflict
Details #5: The second range of addresses having the channel settings conflict

One of your sequences has a conflict between two ranges of addresses controlled by its associated
intensity files. For example, perhaps an intensity file is set up to control DMX universe 8 addresses 20
through 40, and also to control DMX universe 8 addresses 39 through 50. In this example, addresses 39
and 40 are both set up to be controlled twice, and the resulting behavior on the lights for those two
addresses is unlikely to be what you would expect.

To resolve this issue, change the intensity file (or files) so that the address ranges do not overlap with
each other.

Show Verifier
List of Verifier Messages

5.1.5.3.45 47: Intensity File Conflict

Message Number: 47

Severity: Warning

Summary: Intensity file conflict

Details #1: The show with the conflict

Details #2: The section of the show containing the first sequence with the conflict

Details #3: The name of the first sequence with the conflict

Details #4: The name of the intensity file associated with the first sequence with the conflict
Details #5: The range of addresses for the first side of the conflict

Details #6: The section of the show containing the second sequence with the conflict
Details #7: The name of the second sequence with the conflict

Details #8: The name of the intensity file associated with the second sequence with the conflict
Details #9: The range of addresses for the second side of the conflict

One of your shows contains two separate sequences which could possibly play at the same time as
each other, and those two sequences each have associated intensity files which attempt to control some
of the same physical lights as each other. For example, perhaps one intensity file attempts to control
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LOR Regular network unit 10 circuits 8 through 12, and the other attempts to control LOR Regular
network unit 10 circuits 10 through 15. In this case, both are attempting to control circuits 10, 11, and
12 on that unit. If the two sequences actually do wind up playing at the same time as each other, the
resulting behavior on the lights attached to those circuits is unlikely to be what you would expect.

How to resolve this issue depends upon the particulars of the situation. For example, perhaps the
overlap is because of a typo in one of the intensity files' settings; perhaps "circuits 10 through 15" should
have been "circuits 13 through 15". In this case, change the intensity file. Another possibility is that one
of the sequences might not be in the correct section of the show -- for example perhaps it is in the
Background section but should have been in the Animation section -- in which case the show file should
be modified to correct it.

Show Verifier
List of Verifier Messages

5.1.5.3.46 48: Channel/intensity file conflict

Message Number: 48

Severity: Warning

Summary: Channel/intensity file conflict

Details #1: The show with the conflict

Details #2: The section of the show containing the conflicting channel
Details #3: The name of the sequence containing the conflicting channel
Details #4: The name of the track containing the conflicting channel
Details #5: The name of the conflicting channel

Details #6: The section of the show containing the conflicting intensity file
Details #7: The name of the sequence with the conflicting intensity file
Details #8: The name of the conflicting intensity file

Details #9: The range of addresses containing the conflict in the intensity file

One of your shows contains two separate sequences which could possibly play at the same time as
each other, and one of those sequences has a particular channel while the other has an intensity file
which attempts to control the same physical lights as that channel. For example, perhaps one
sequence has a channel that is set up to control LOR Regular network unit 10 circuit 8, while the
intensity file attempts to control LOR Regular network unit 10 circuits 5 through 15. In this case, both
are attempting to control circuit 8 on that unit. If the two sequences actually do wind up playing at the
same time as each other, the resulting behavior on the lights attached to that circuit is unlikely to be
what you would expect.

How to resolve this issue depends upon the particulars of the situation. For example, perhaps the
overlap is because of a typo in one of the intensity files' settings; perhaps "circuits 5 through 15" should
have been "circuits 13 through 15". In this case, change the intensity file. Or, similarly, perhaps the
channel's settings are mistaken, in which case those settings should be modified. Another possibility is
that one of the sequences might not be in the correct section of the show -- for example perhaps it is in
the Background section but should have been in the Animation section -- in which case the show file
should be modified to correct it.

Show Verifier
List of Verifier Messages
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5.1.5.3.47 49: Intensity file uses undefined comm netw ork

Message Number: 49

Severity: Warning

Summary: Intensity file uses undefined comm network

Details #1: The sequence whose intensity file uses the undefined comm network
Details #2: The intensity file using the undefined comm network

Details #3: The undefined comm network being used

One of your sequences uses an intensity file which attempts to control lights on a comm network that
has not been defined. For example, perhaps it attempts to use the LOR Aux A network, but you have
not set up the LOR Aux A network to use any particular COM port. In this case, your sequence will
play, but the lights that attempt to use the undefined network will not be controlled.

How to fix this issue depends upon the particulars of the situation. Perhaps the comm network used by
the intensity file is mistaken, in which case the intensity file should be modified to use the correct
network. Or perhaps the correct comm network is being used, but that comm network has not been set

up via the Light-O-Rama Network Preferences program.

Show Verifier
List of Verifier Messages

5.1.5.3.48 50: Intensity files not supported by license level

Message Number: 50

Severity: Warning

Summary: Intensity files not supported by license level

Details #1: The sequence which is attempting to use an intensity file

One of your sequences uses an intensity file, but your license level does not support intensity files. The
sequence will play, but any effects defined in the intensity file itself will not happen on your actual
physical lights.

This issue can be resolved by upgrading your Light-O-Rama license to a level that supports intensity
files.

Show Verifier
List of Verifier Messages

5.1.5.3.49 53: Trigger uses undefined netw ork

Message Number: 53

Severity: Warning

Summary: Trigger uses undefined network

Details #1: The name of the show containing the trigger

Details #2: The name of the undefined network that the trigger uses
Details #3: The name of the trigger

One of your triggers (either a show startup trigger or an interactive group trigger) uses a network that is
not defined in Network Configuration. The trigger will not function during your show.

There are at least two different reasons why this warning may occur, and how to resolve the issue
depends upon which one is the cause. First, there may be a mistake in the settings of the trigger itself,;

© 2022 Light-O-Rama, Inc.



146

Light-O-Rama v6.1.0

for example it may be set up to use network Aux B, whereas you intended it to use network Aux A. In
this case, change the definition of the trigger (either in the show startup options or the interactive group,
depending upon what kind of trigger it is). Second, the trigger may be set up to use the intended
network, but that network might mistakenly not have a comm port defined for it. In this case, use the
Network Configuration program to set the configuration of the network.

Show Verifier
List of Verifier Messages

5.1.5.3.50 54: Trigger uses LOR Enhanced netw ork

5.1.6

Message Number: 54

Severity: Warning

Summary: Trigger uses LOR Enhanced network

Details #1: The name of the show containing the trigger

Details #2: The name of the LOR Enhanced network that the trigger uses
Details #3: The name of the trigger

One of your triggers (either a show startup trigger or an interactive group trigger) uses an LOR Enhanced
network. Triggers are not supported on LOR Enhanced networks, and the trigger will not function during
your show.

There are at least two different reasons why this warning may occur, and how to resolve the issue
depends upon which one is the cause. First, there may be a mistake in the settings of the trigger itself;
for example it may be set up to use the Enhanced network Aux B, whereas you intended it to use non-
enhanced network Aux A. In this case, change the definition of the trigger (either in the show startup
options or the interactive group, depending upon what kind of trigger it is). Second, the trigger may be
set up to use the intended network, but that network might mistakenly be marked as Enhanced. In this
case, use the Network Configuration program to change the configuration of the network.

Show Verifier
List of Verifier Messages

Play Shows

The "Play Shows" section of the Control Panel:
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rol Panel v6.0.9 Pro

Menu Disabled @—Jwo —

Controller Setu ;
P Playback Disabled
2 Click on one of the following modes to start playback.
E?E Networks

'I'i'!' Test Lights

; Show Player
Sequences Run scheduled or on demand shows.

[ Createshows [ werar ]

Create sequence cue lists and play them back

* Settings

This section can be in one of 3 modes:
¢ Disabled - no playback, not even scheduled shows
e Show Player - plays scheduled or on-demand shows created in the Create Shows section.
o Live Player - create a cue list, and then click Play to start each cue. Can be used as a jukebox.

To go from Show Player to Live Player you must go back through disabled mode first.

Controls in the Heading

Show Player @ h.—' 100 o) 4' 50 | PLAVER 106 | | DisABLE PLAYER |

Mode Name Jaster Dimmer Mute Volur

The controls in the heading stay the same no matter which mode you are in. There are 2 slider controls
and 2 buttons in the heading:

e The first slider is the "Master Dimmer" which sets the maximum brightness level for all of the
lights in the show. This allows you to manually dim your lights while a show is playing, or to fade
them out completely. Props can be excluded from master dimming by clearing the "Master
Dimming Applies" box in Prop Definition.

e The second slider is the wolume control which allows you to increase or decrease the wlume. The
speaker icon to the left of the volume slider serves as a mute button. Click it once to mute the
sound. Click it again to unmute.

e The Player Log button opens a separate window that displays a log of all of the sequences that
have played while the Control Panel has been open.
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e The "Disable Player" button turns off the mode you were in (i.e. it will stop the show if one is
playing) and takes you back to the Playback Disabled screen shown above.

Play Shows Badge

In the menu on the left, the Play Shows icon will display a badge when a player is active. The badge will
indicate whether the player is stopped, paused, or playing a sequence. No badge is displayed in
Disabled mode. This allows you to work in another section of the Control Panel and still know what is
going on in Play Shows.

[ 1 = ol o
The "Stop" badge

5.1.6.1 Show Player

The Show Player plays scheduled or on-demand shows created in the Create Shows section.
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Light-O-Rama Control Panel v6.0.9 Pro HR - O

Menu Show Player @ ————f§100 ) —§ 50 | Puaver 106 | | orsase puave |

- E-:
Controller Setup Current Show D& @ @

2022 Halloween 9 2020-PiratesTheme

2 .
a% Networks Playing Main
Today 5:00 PM to 10:00 PM

01:30.28 00:59.37 8:26:22 PM
T 1 Test Lights Upcoming Shows
TI 19 g

|;| 2022 Halloween
Sequences ) Tomorrow 5:00 PM to 10:00 PM
t‘é Create Shows
| 2022 Halloween

| =) Sun 5:00 PM to 10:00 PM :
pcoming Sequences
|1| Play Shows |T| 2022 Halloween
'— Mon 5:00 PM to 10:00 PM 2020-spooks-on-parade

SD Cards — Main
ﬂ | > | 2022 Halloween W Ch
‘—' Tue 5:00 PM to 10:00 PM

|;| 2022 Halloween
= Sat 5:00 PM to 10:00 PM

C{‘J License Override Sequences ' 2020-StarsWars-VaderTheme
. Main
. . 03:02.97
|. » | No Parking

* Play After Cumrent Song |E| |_

2020-thunderbolt
o Settings Main

neng 72

Controls in the heading (master dimmer, volume, etc) were covered in the previous section.
The Show Player logs every sequence that it plays to the Player Log.
The Show Player screen is divided into seweral sections:

e Current Show

e Upcoming Shows

e Owerride Sequences
e Currently Playing

e Upcoming Sequences

If the media file for a musical sequence has cover art, the cover art will be displayed in the Current and
Upcoming Sequence lists. Otherwise, a default icon is used.

Current Show

Current Show + @ @

2022 Halloween

Playing
Today 5:00 PM to 10:00 PM

There are 3 rows of text in this section:
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e The name of the show being played. If the show was started on-demand, the name will have a "!"
prefix.

¢ The show status. If a sequence is being prepared for playback the first time, the status will show
as "Initializing".

¢ The time range that the show is scheduled to play

In the heading are 4 buttons:

Clicking this button will open the Show On Demand dialog prompting you for a show to run.

Clicking this button will open a dialog prompting you for how long you want to extend the show.
You can choose from 15, 30, 45, or 60 minute presets, or you can set a specific end time. This
extension is temporary -- it does not permanently change the show's schedule. However, it will
change the end time displayed in the Current Show area.

Clicking the Pause button will open a menu with 2 options: pause immediately, or after the
current song. After the show is paused, this button will display a play icon. Click it to resume
playback.

Clicking the Stop button will open a menu with 2 options: stop immediately, or after the current
song.

g @

Upcoming Shows

Upcoming Shows

|T| 2022 Halloween
— Tomormow 5:00 PM to 10:00 PM

| 2022 Halloween
— | Sat 500 PM to 10:00 PM

| 2022 Halloween
! Sun 5:00 PM to 10:00 PM

| 2022 Halloween
Mon 5:00 PM to 1000 PM

| 2022 Halloween
——' Tue 5:00 PM to 10:00 PM

This section will display any shows scheduled to play in the next 7 days. Clicking the Play button next
to a show opens the Show On Demand dialog for that show.

Override Sequences

© 2022 Light-O-Rama, Inc.



The Light-O-Rama Software Package 151

Override Sequences

(p| No Parking

—'  Play After Cumrent Song

The sequences listed in this section are not associated with a show. Typically you would use this area
for special announcements -- clear out traffic, arrival of a VIP, etc. Click the "Add" button to add one. For
each sequence you can designate that it should be played immediately or after the current song.

¥ Edit Override Sequence

Sequence File
- x| E=

Overmide Type

® | Play After Current Song

o Play Immediately

The Override Sequence dialog
Click the Play button to play the owerride sequence. If it is designated to play immediate, it will show up
in the Currently Playing area. If it is designated to play after the current song, you will see it at the top of
the list of Upcoming Sequences.

Click the Edit icon to modify the owerride (e.g. change Play Immediately to Play After Current Song).

Click the Trash Can icon to remove the override from the list.

Currently Playing

Currently Playing

2020-PiratesTheme E| 1
0 Main B ——

e (00:5937  &2622PM _ 0030.90

This section lists the currently playing sequences. While there can only be one musical sequence
playing at a time, multiple animation sequences can play simultaneously (e.g. from the Background
section of the show).
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The progress bar shows 3 times:

¢ How much of the sequence has played so far
¢ The time the sequence started
e The amount of time remaining before the sequence ends

Click the Copy button if you want the sequence to play again. A copy of the song will appear at the top
of the Upcoming Sequences list. If you want the current sequence to repeat 3 more times, click the
button 3 times.

Click the Trash Can icon to stop the currently playing sequence. The next item in Upcoming Sequences
will start playing.

Upcoming Sequences

2020-spooks-on-parade
Main
02:27.41

2020-5tarsWars-VaderTheme
Main
03:02.97

2020-thunderbolt
Main
Mg 272

This is the list of upcoming sequences. The item at the top is the next to play. The list is refreshed every
time the player has cycled through all of the sequences in the main section of the show.

To mowve an item to the top of the list, click the Up Arrow icon. This does not move the item one position,
it mowes it directly to the top.

Clicking the Trash Can icon will remowve the sequence from the current cycle. It will be put back into the
list on the next cycle.

Show On Demand
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51.6.2

§ Show On Demand

Show File

Iht-O-Rama‘\SequencesiMatt Halloween2022 Halloween.lss | BROWSE |

Start

i@ Start as soon as pos |t'.",

o Start at this hime

End
®  Play untl | stop it

o Play until this time

Start Type

® | Play After Cumrent Song

O Play Immediately

The Show On Demand dialog

Using this dialog, you can choose a show file to play immediately, or at a certain time, without needing
to add it to your schedule. You can choose to let it play until a certain time, or else indefinitely, in which
case it will not stop until you click either the "Stop" or the "Disable Player" button,

If a show is already playing at the time the on demand show is supposed to start, the playing show will
be allowed to stop gracefully before the on demand show will start. That is, if a sequence from its
Musical Section is currently playing, that sequence will be allowed to continue to play until its natural
end; also, the sequences from its Shutdown Section, if any exist, will be played (after the current
sequence from the Musical Section ends, or immediately if there is no current sequence from the
Musical Section).

Live Player

As the name implies, Live Player is geared to controlling sequences at live events. Here you can create
a cue list, and then click Play to start each cue at the appropriate time. It can also be used as a
jukebox. Cue lists can be saved to disk and loaded back at a later time. Cue files have a file extension of
LORCUE.
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5 Light-O-Rama Control Panel v6.0.9 Pro M@ - O

= Menu

";U Controller Setup

39‘52 Networks

'I'i'!' Test Lights

Sequences
t.clt') Create Shows

* Settings

Live Player @ ————f 0 « —f 50 | puaves 06 | | oisaste puaves |
+) (%) &) @ b)) [wew[orm] e swens]

s

|T| Cue 1 - A Mad Russians Christmas-TransSiberian Orchestra-SH( |E.T| | |
Duration: 00:25.31  Lights Off At End

Christmas Eve and Other Stories is the debut studio album by the Amenican rock band Trans-
Siberian Orchestra. It was released on October 15, 1996, through Lava Records and Atlantic
Records. It is the first album in the band's "Christmas trilogy”, with The Chnstmas Attic (1998) and
The Lost Christmas Eve (2004) coming afterward. All three albums, as well as their The Ghosts of
Chnistmas Eve DVD, were featured in the box set of The Christmas Trilogy. The album’s cover art
was created by Edgar Jerins.

]

|r| Cue 3 - Carol Of The Bells-Pentatonix-SHORT |E.T| |_|
Duration: 00:22.70  Auto-Follow  Lights Off At End

PTXmas is the second extended play album by the a cappella group Pentatonix. The album was
digitally released on November 12, 2012, and physical versions were available from November 13,
2012. The deluxe edition was released on Movember 19, 2013 with 2 additional tracks.

|r| Cue 4 - Linus And Lucy-Vince Guaraldi-SHORT

Controls in the heading (master dimmer, wlume, etc) were covered in a previous section.

The Live Player logs every sequence that it plays to the Player Log.

The Second Row of the Heading

The cue list name. You can type directly in this box to change the name. Click
the Sawe button after you are done.

Adds a new cue to the list. It first prompts you to select the sequence file and
then displays the Cue dialog.

Changes the selected row to the one abowe. Skips inactive cues.

Changes the selected row to the one below. Skips inactive cues.

Stops playback immediately.

BHOQB A

Play next cue. If a cue is currently playing, it is stopped. Then playback starts on
the cue after the selected one.
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Starts a new cue list. If changes have been made to the current cue list, you will
be prompted to sawe it.

Opens a previously saved cue list.

Sawes the current cue list.

Saves the current cue list with a new name.

Cue List Item

(»| Cue 3 - Carol Of The Bells-Pentatonix-SHORT W
Duration: 00:22.70  Auto-Follow  Lights Off At End

PTXmas is the second extended play album by the a cappella group Pentatonix. The album was
digitally released on Movember 12, 2012, and physical versions were available from November 13,
2012, The deluxe edition was released on Movember 19, 2013 with 2 additional tracks.

A cue that is not playing

Across the first line of the cue is:

The button to play the cue

The cue number and name

The edit button. Click to open the Cue dialog.

The Trash Can icon. Click to remowe the cue from the list. This action cannot be undone.

The second line shows the sequence duration, followed by options that were enabled in the Cue dialog.

[»] Cue 3 - Carol Of The Bells-Pentatonix-SHORT
Duration: 00:22.70  Auto-Follow  Lights Off At End

PTXmas is the second extended play album by the a cappella group Pentatonix. The album was
digitally released on Movember 12, 2012, and physical versions were available from Movember 13,
2012, The deluxe edition was released on November 19, 2012 with 2 addibonal tracks.

A cue item while playing

When the cue is playing a progress bar is shown at the bottom. You can click the cue's play button to

restart the sequence.

The Cue Dialog
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5.1.6.3

§ Edit Cue O

Mame

Carol Of The Bells-Pentatonix-SHORT

Motes

PTXmas is the second extended play album by the a cappella group Pentatonix. The album was digitally
released on November 12, 2012, and physical versions were available from November 13, 2012, The
deluxe ediion was released on Movember 19, 2013 with 2 additional tracks.

Reeat Count

'  Active

» Auto-Follow

~" Lights Off At End

The Cue dialog
This dialog has the following fields:

e Name - this defaults to the name of the sequence, but you can change it if desired.

¢ Notes - the notes for the cue, for example when it should be started.

e Repeat Count - the number of times the sequence should be repeated. 0 means the sequence
will be played once.

e Active - if checked the cue can be played. If unchecked, the cue will be skipped.

¢ Auto-Follow - if checked, once this cue finishes playing, the next cue in the list will automatically
be started.

o Lights Off At End - if checked, lights used by this sequence will be turned off after the sequence
finishes playing.

Player Log

The Player Log window is opened by clicking the "Player Log" button in Play Shows.It captures all songs
played by the Show Player and Live Player. The window can be positioned and resized independently of
the main Control Panel window. It can stay open while you perform other functions in the Control Panel.

The log of songs played is captured even if the window is not open. However, the information is only
resident in memory and is lost when the Control Panel is closed.

You can close the log window by clicking the "X" in the upper right corner.
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W Player Log

LEVEL | TiME EVENT

Information  8/25/2022 8:26:17 PM Schedule loaded

Information  8/25/2022 8:26:17 PM Enable schedule requested

Information  8/25/2022 8:26:17 PM 2022 Halloween's contents have changed

Information  8/25/2022 8:26:17 PM CiAlUsers\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\2022 Halloween.lss - Playback File Initialization
Information  8/25/2022 8:26:17 PM Started show: C\Users\Matt\DocumentshLight-O-Rama\Sequences\Matt Halloween2022 Halloween.lss

Information  8/25/2022 8:26:17 PM Starting Main: C\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\202002020-Laser_Burst_Gun.loredit
Information  8/25/2022 8:26:22 PM Stopping Main: C\Users\Matt\DocumentsiLight-O-Rama\Sequences\Matt Halloween\202002020-Laser_Burst_Gun.loredit
Information  8/25/2022 8:26:22 PM Starting Main: C\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\202002020-PiratesTheme.loredit
Information  8/25/2022 8:27:53 PM Stopping Main: C\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\202002020-PiratesTheme.loredit
Information  8/25/2022 8:27:53 PM Starting Main: C\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\2020\2020-thunderbolt.loredit
Information  8/25/2022 8:28:01 PM Stopping Main: C\Users\Matt\DocumentsiLight-O-Rama\Sequences\Matt Halloween\202002020-thunderbolt.loredit

The Player Log
The Clear button clears all entries from the log.

The Copy button copies the 3 columns of data to the clipboard. While this can be pasted into a text
editor, it is more suitable for a spreadsheet program as shown below.

A B (@ D
1 8:26:17 PM Scheduler Information  Schedule loaded
2 8:26:17 PM Scheduler  Information  Enable schedule requested
3 8:26:17 PM Player Information 2022 Halloween's contents have changed
4 8:26:17 PM Player Information  C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween'2022 Halloween.|ss - Playback File Initialization
5 8:26:17 PM Player Information  Started show: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\2022 Halloween.lss
6 8:26:17 PM Player Information  Starting Main: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\2020\2020-Laser_Burst_Gun.loredit
7 8:26:22 PM Player Information  Stopping Main: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\20204,2020-Laser_Burst_Gun.loredit
8 8:26:22 PM Player Information  Starting Main: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\2020\2020-PiratesTheme.loredit
9 8:27:53 PM Player Information  Stopping Main: C:\Users\Matt\Documents\Light-O-Rama'\Sequences\Matt Halloween\202012020-PiratesTheme.loredit
10 8:27:53 PM Player Information  Starting Main: C:\Users\Matt\Documents\Light-O-Rama\sequences\Matt Halloween\2020\2020-thunderbolt.loredit
1 8:28:01 PM Player Information  Stopping Main: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween'20201,2020-thunderbolt.loredit
12 8:28:01 PM Player Information  Starting Main: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween'\2020\2020-spooks-on-parade.loredit
13 8:28:23 PM Scheduler  Information Request to immediately stop scheduled show received
14 8:28:23 PM Scheduler Information 2022 Halloween's end time has been changed to 8/25/2022 8:28:23 PM.
15 8:28:23 PM Player Information  Stopping Main: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\2020\2020-spocks-on-parade.loredit
16 8:28:23 PM Player Information  Shutting down show: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween\2022 Halloween.|ss
17 8:28:23 PM Player Information  Finished show: C:\Users\Matt\Documents\Light-O-Rama\Sequences\Matt Halloween'\2022 Halloween.|ss

Player Log data pasted into aspreadsheet

5.1.7 SD Cards

The Control Panel can create SD cards for all types of Director-based shows. This includes all
generations of MP3 Directors, including the 4th generation (G4) directors that can be linked together.

To get started, go the SD Cards section of the Control Panel. You will go through a series of steps. After
entering the information for current step, click the "Next" button to move on to the next step. Once you
pass the first step, there will the "Cancel" and "Back" buttons to the left of the next button.

e "Back" will take you to the previous step, where you can make changes if needed.
e "Cancel" will take you all the way back to the first step.

If you remowve your SD card before finishing the last step, you will automatically be taken back to the first
step.

e Step 1 - Select SD Card
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e Step 2 - Create or Edit
e Step 3 - Select Show Number
e Step 4 - Select Your Device (only when creating a new show)

e Step 5 - Select Number of Director Ports and Generation (only when creating a new show)

e Step 6 - Select Sequences

e Step 7 - Select When Show Plays
e Step 8 - Select How Show Plays
e Step 9 - Port Assignments

e Step 10 - Final Options

e Step 11 - Write Show To The Card

Light-O-Rama Control Panel v6.0.9 Pro

Menu Create and Edit SD Cards for Directors

Controller Setup

0
E?E Networks Insert an SD card into your computer...

'I'i'!' Test Lights

Sequences

t.clt') Create Shows

* Settings

The initial step in the SD Cards section

Step 1 - Select SD Card
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Select the drive containing your SD card:

Dnive Letter Label Capacity Format

® EA\ sD 15.53 GB FAT32

If you haven't already done so, insert the SD card into your computer. It should be automatically
detected by the program and displayed on the screen as shown abowe.

Note that the last column shows how the SD card is formatted. Director units can only read cards
that are formatted as "FAT" or "FAT32". Cards with other formats will be displayed in red and you
will be unable to select them. If you have a card with the wrong format, you can reformat it in
Windows File Explorer.

If you are editing a Multi-Director SD card show, you must insert the FIRST card of the show.

The program does NOT make a distinction between SD cards and flash drives. So make sure you
don't pick a flash drive.
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SDcard inserted into aslot in computer

If your computer doesn't have an SD card slot, you can use a USB adapter:

SD Card USB Adapter

Step 2 - Create or Edit
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Create and Edit SD Cards for Directors

Cancl [<mac] [Nt> ]

Create New SD Card Show

Create a new show and write it to the card, potentially cverwriting an exiting show

O Edit Existing SD Card Show
Make changes to a show that already has been written to the card

Select whether you are creating a new show or editing an existing show.

Step 3 - Select Show Number

Create SD Card

Concl] <8

Select show number

Last modified: 8/3/2022 800 PM
Last modified: 8/3/2022 801 PM

Last modified: 8/3/2022 802 PM

Last modified: 8/3/2022 8:02 PM

A card where shows 1-4 already exist

Up to nine shows can be downloaded to an SD card, and each will be assigned a number between 1
and 9.
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If you are creating a new show and then pick a show number where a show already exists (as
indicated by the "Last modified" date), you will then be asked to confirm that you intend to overwrite
the existing show on the card.

If two shows are scheduled for the same time, the lower numbered show will be played. Mini

Directors do not hawve a time clock and so the lowest show number will always be played. For this
reason if you have a Mini Director, it is best to only ever create 'Show 1' to awid confusion.

Step 4 - Select Your Device (only when creating a new show)

Create SD Card

Concl] <]

Select your device:
Mini-Director
* Plastic case

Alidia * No clock
* Shows run when the unit has power

Light-Q-Rama

MFP3 Director

* Metal case
* Has a clock
* Shows can run on a schedule

If you are creating a new show, you will be asked to identify the type of device you are creating a
card for. See our List of Directors If you need help identifying your device.

Step 5 - Select Number of Director Ports and Generation (only when
creating a new show)
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Create SD Card

Concl] <8

Number of ports on the MP3 Director

Product Generation

O a1

If you are creating a new show, you will be asked to select the number of ports on your device and
the product's generation. See our List of Directors If you need help identifying your device.

If you are creating a set of SD cards for Linked directors, the number of ports here is the number of
total ports on your FIRST (Master) director. You will be able to add your additional directors in Step
9.

Step 6 - Select Sequences
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Create SD Card

‘Cancel‘ ‘ « Back‘

Show' [aoo] ()

Duration: 00:00.00

Here you add the sequences that will be in your show. Click the Add button to add your sequences
to the playlist. For additional help, see Create Shows > Edit Playlist.

Step 7 - Select When Show Plays

There are 3 choices for when the show will play:

o Whenever the Director has power

e According to a schedule (not available when using a mini-director)

e When a trigger is activated. This option is only available when the show number is less than
or equal to the number of trigger inputs on the device (3 for Mini-Directors, 6 for MP3
Directors).

Set a Schedule

© 2022 Light-O-Rama, Inc.



The Light-O-Rama Software Package 165

Create SD Card

o [k

Show 5 plays...

Whenever the MP3 Director has
power SCHEDULE

' ® According to the daily schedule [ ] |oav TIME RANGE
O When the shown trigger is activated Monday OFF
Tuesday OFF
Wednesday OFF
Thursday OFF
Friday OFF
Saturday OFF

Sunday OFF

Mew Start Time MNew End Time

o0

| UPDATE SELECTED DAYS | | CLEAR SELECTED DAYS |

When you select "According to the daily schedule", the schedule will appear on the right side.

To modify the schedule:

e Check the boxes next to the days you want modified. As a shortcut, you can click the check
box in the heading to toggle all check boxes on or off.

e Set the start and end times at the bottom of the table. Typing a time like "5pm" directly into the
box is faster than using the drop-down to select the time.

¢ Click the "Update Selected Days" button.

e If the show should not play on certain days, check the boxes next to those days, then click the
"Clear Selected Days" button.

Set Trigger
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Create SD Card

o [<nak] [

Show 5 plays...

O Whenever the MP3 Director has

o TRIGGER

O Accarding to the daily schedule Run when trigger 3 is activated [matches show number).

| ® When the shown trigger is activated TssrEns | ol Tpen

Most tnggers (like switches and pressure mats) are
‘normally open’ - they send a signal only when activated.
Others (for example motion detectors) are ‘normally
dlosed’ - they STOP sending a signal when activated.

Selecting "When the trigger is activated" will cause the show to start whenever some external trigger
happens (such as a circuit being closed or a motion detector being tripped). The input trigger for a
show is the same as the show number.You will be able to choose whether the switch is normally
open or normally closed.

Switches come in 2 different varieties - normally open and normally closed. For most switches, you
select 'Normally Open'. That means there is no signal sent to the MP3 director until the switch is
operated. There are some devices (usually motion detectors and other 'security’ type devices) that
are 'Normally Closed'. Normally Closed switches constantly send a signal back to the MP3 director,
and once they are activated STOP sending that signal.

Step 8 - Select How Show Plays
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Create SD Card

o] <]

When scheduled, Show 5 wiill...

O Loop continuously

O Play once from start to end then stop

Between shows the lights are...

O'Dn

@ Off

O Running a filler sequence

-

Optional startup sequence
| 5L

When this show plays it will...

The first section controls what will happen once the show has started. Not all of these options are
available for every type of show. For example, Round Robin play is only available for triggered
shows.

e Loop continuously
This show will continue to run until told to stop. For shows that run when the director is
powered, that would mean turning off the power. If you are using a schedule, the show will
stop at the end time. If you are using a trigger, once the trigger condition is met, the show
will continue to play until powered off.

e Play once from Start to End, then stop
The show will run once from top to bottom and then stop. Usually triggered shows use this
option, but it can be used with the other two options as well. When used with a triggered
show, the list plays and then stops at the end waiting again for the trigger signal.

e Repeat Every (10/15/30/60 minutes)
This option is only available for MP3 directors that have a real time clock. The show will
play from start to end and then stop. At the time selected the show will start and run again
from top to bottom. Note that the 'start’ time is based on the ‘clock’ time. That is to say

© 2022 Light-O-Rama, Inc.



168

Light-O-Rama v6.1.0

that a show that is set to run every 15 minutes will run on the hour and then at 15, 30, 45
past the hour. You should ensure that your show is no longer than the amount of time you
select here. For example, if you show is 11 minutes long and you select every 10 minutes,
the show will simply keep repeating.

e Play the next song in the list (Round Robin).
This option is only available for triggered shows. When the trigger is activated, the first
sequence in the list will be played and then the show will stop. Ewery time after that when
the trigger is activated the next sequence in the list will play and then will also stop. Once
the last sequence is reached, the next trigger will start over with the first sequence again.

Between Shows The Lights Are...

Depending on your selection above, you may also be able to control what happens with your lights
while the show is not playing. For every option except 'Loop Continuously' you can select if you
lights are ON, OFF, or Running a filler sequence. If you use a filler sequence, the sequence that you
select will loop continuously until the next event occurs. That could be a trigger, a repeat of the
show at X minutes, etc.

Optional Startup Sequence
When set, the very FIRST thing the director will do is play the 'starter sequence'. It is played one

time and one time only - at the very start of the show. Ewen if the show is set to loop, the starter
sequence will only be played once.

Step 9 - Port Assignments
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Create SD Card

o] <]

D | have MULTIPLE G4 Directors that are connected together using "Director Link”

NET/UNIV PROTOCOL

Director 1

Regular
Aux A
Aux B
Aux C

If you are using multiple Directors connected via "Director Link", click the box at the top. The will
open the ability to add more directors to the list. See How to Use Director Link for more information.

The networks needed by your show are determined by analyzing the first sequence in your show.
Those networks are then assigned to ports using a priority system. You can change a port
assignment or the network speed by double-clicking on an item. This will open the following dialog,

allowing you to make changes:
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¥ Port Settings — O

Director 1 - Port 2

Metwork / Universe

Aux A

Protocol

ELOR

In this example, the user double-clicked on port 2, which is indicated in the heading.

e Network/Universe: The LOR Network or DMX universe that this port will control. There is an
option for "None" here, Use this option when a port is not going to be used.

e Protocol: The data protocol in use: LOR, ELOR (Enhanced LOR) or DMX

e Speed: The speed of the network. DMX Universes run at a fixed speed and cannot be
changed. The 1000K speed can ONLY be used with networks that only contain PixCon16
controllers or Pixie family controllers. No other LOR controllers support 1000K.

e Comment: User comment if desired.

More information about the protocols and speeds supported by various Light-O-Rama controllers is
available on our web site.

Step 10 - Final Options
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Create SD Card

Concl] <8

Set Final Options

[ ] Lock Step — (Note: Not supported by CTBOS and MCP )
»" Strip MP3 Header Information (Allows Director hardware to load MP3 faster)

»" Turn used lights off at the end of each sequence

D Show cannot be interrupted by input triggers

D Add a file to the 5D card to set the MP3 Director's intemal clock

Next, we write to the card...

e Lock Step: If you have a very large display, selecting "lock step” may help the different controllers
used in the display react with a higher degree of synchronization. This is not supported on all
controller types, and the level of firmware in the controllers must be 3.0 or higher.

e Strip MP3 Header Information: Some MP3s may hawe a large data block before the actual
music data. For example, an MP3 may have seweral high-resolution pictures in its ID3 Tags. The
MP3 director will correctly ignore this data, however it does take time to find the actual start of the
music file. Stripping this data will allow the MP3 director to start playing the sequence faster.

e Turned used lights off at the end of each sequence: Checking this box will cause all lights
used by the sequence to be turned off when the sequence ends. If you leave a light on at the end
of a sequence, that light will remain on until the start of the next sequence.

e Show can not be interrupted by input triggers: Once this show has started on the MP3
director, pressing a trigger input will not interrupt the show - it will run to completion.

e Set MP3 player'sinternal clock: If you wish to add a file to the SD card to set the MP3
director's internal clock, check the box that says so. Note that there are also other ways to set
the director's clock.

e NOT YET AVAILABLE IN S6:
bring up an additional window

Step 11 - Write Show To The Card
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5171

Create SD Card

‘Cancel‘ ‘ « Back‘

Write Show To Card

About to write a single card...

At this point the Control Panel is ready to create your SD card show or SD card set. Press the
"Write Show To Card" button, and the Control Panel will start the process. It can take some time to
create an SD card show depending on the complexity of your sequences, number of networks, etc.
Once the process is complete, the Control Panel will let you know.

Multi-Director SD card sets

The Control Panel will tell you the total number of SD cards that are required for your show. Please
remember that these cards need to be placed into the correct directors and should be labeled to
awid confusion.

When it is time to change cards, the Control Panel will pause and let you know with a message on
screen.

SD Card Priority System

MP3g3 Directors can control DMX Devices

In addition to LOR Devices, G3 and newer Directors can also drive DMX devices on one or both
output ports. In order to control DMX devices, your G3 MP3 Director must have at least firmware
version 5.28.

Network and Universe Priorities

New advanced MP3 Directors, like the Dual Port GBAMP3 Director, or G4N4 4-Port can drive 2 or 4
separate physical networks of devices. These advanced directors can control LOR devices, DMX
devices, or a combination of them on separate ports. For single (non-linked) directors, LOR Hub will
automatically select which networks and/or universes in your sequence will be used by the director.

Only Advanced and Pro lewels of the LOR software will allow for the creation of DMX output for a
director. All other lewvels are limited to creating LOR output only.

Older Directors, like the DC-MP3-SHOWTIME, are limited to ONLY the LOR REGULAR network.

For Advanced Directors, LOR Hub uses a ‘priority system’ based on the contents of the FIRST
sequence added to the show list. In order to prevent confusion, all sequences that are part of a
single show should use the same preview. Shows that use Director Link use these rules as a
default however the user has the ability to change them as they see fit.
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apwd

o

If your license supports them, there is no difference between LOR Enhanced networks
and normal LOR networks. Both are treated the same when it comes to priority.

LOR networks have priority over DMX universes.

The LOR REGular network has the highest priority, followed by AUX A through AUX O.

A lower number DMX Universe is higher priority than a higher number.

If the sequence contains more than 2 (or 4) networks, universes, or a combination thereof,
those Networks and Universes are silently discarded.

If your director only has one port, then only the PORT 1 column applies. 4 port directors
use the same rules and simply extend the table to 4 columns.

Examples assuming that you have the ‘Advanced’ level of the software:

Your sequence PORT 1 on the PORT 2 on the Notes
contains.... director controls director controls
Only one network, so
* it is placed on port 1.
1. LORREG LOR REG a See note for port
2/3/4.
Two ports active with
LOR
Llowe,  lowes | LoRAe
' See note for port 3/4.
Aux B is silently
1. LOR REG discarded for two port
2. LOR AUXA LOR REG LOR AUX A directors. Used as
3. LOR AUXB port 3 on 4 port
directors.
1. DMXUniverse = pMX Universe 1 ) DMXon port 1. See
1 note for port 2..
LOR devices have
1. LOR AUXA _ priority over DMX, so
2. DMX Universe LOR AUXA DMX Universe 1 AUXA is on port 1.
1 See note for port 3/4
1. DMX Universe DMX Universes are
1 . ) assigned in ascending
2. DMX Universe DMX Universe 1 DMX Universe 99 order.
99

See note for port 3/4
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PORT 1 on the
director controls

LOR REG

PORT 2 on the

director controls NEES

LOR Devices hawe
priority over DMX
REG has highest
priority followed by
AUXA. For 2 port
directors all others are
discarded. For 4 port
directors, AUXB is on
port 3, DMX Universe
1lis on port 4. All
others are discarded.

LOR AUXA

* Please note that the dual network and 4 network directors will mirror the output of Port 1 onto
Port 2 on a per-sequence basis - as well as any other empty ports. If you wish to hawe all controllers
on port 2 stay dark during certain sequences, ensure that ALL of the sequences in that show use
the same preview. That is to say, ensure all of your sequences contain channels for BOTH ports,
even if those channels are all OFF for the duration of the sequence.

'Startup’ sequences as well as 'Filler' sequences can also use LOR or DMX devices on advanced

174 Light-O-Rama v6.1.0
Your sequence
contains....
1. LOR REG
2. LOR AUXA
3. LOR AUXB
4. DMX Uniwverse
1
5. DMX Universe
99
directors and the same rules apply to them.
5.1.7.2 Differences Between MP3 Directors

Ovwer the years, Light-O-Rama has released seweral different versions of MP3 directors. Here are some
pictures and descriptions to help you determine which MP3 director you have and what it's functionality:

Generation 1 LOR MP3 Directors

Generation 1 MP3 directors include the DC-MP3 and the original mDM-MP3 director.

Your DC-MP3 director may be just a plain circuit board, in a metal case that only contains the director,

or as part of an LOR1602 controller:
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DC-MP3 Board

DC-MP3 in Case. Some cases were labeled DC-MP3 rather than LOR1602MP3.

175
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DC-MP3 as part of an LOR1602

The mDM-MP3 Mini Director is in a black plastic case. The mDM-MP3 and the uMP3g3 look similar.
Be sure you carefully check the front of the unit. the uMP3g3 will explicitly say it is a uMP3g3, while the
older mDM-MP3 will not. The uMP3g3 also has a power input connector that the mDM-MP3 does not.
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The Front and Back of an mDM-MP3 Mini Director. Carefully compare these pictures to the uMP3g3to ensure
you have identified the correct version that you have.

Generation 3 LOR MP3 Directors

Light-O-Rama did not manufacture any Generation 2 MP3 directors. Generation 3 MP3 directors include
the G3-MP3 and the uMP3g3 Mini Director

The G3 MP3 director was sold in a metal case, or as part of an LOR160xMP3g3 controller.

Stand Alone G3MP3 Director
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G3 MP3 Director as part of an LOR1602MP3g3. LOR1600MP3g3 similar. Note: the LOR160xg3 looks
similar but does NOT have an MP3 Director

. [—— :
This is an LOR160xG3 that does not have an MP3 director.

The uMP3g3 was sold in a black plastic case. It looks similar to the older mDM-MP3 director but has
significant differences.
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Light-O-Rama s

The Front and Back of the uMP3g3 Mini Director. To identify if you have auMP3g3 or a mDM-MP3: the front of
the uMP3g3identifies it as such. On the back of the uMP3g3there is apower socket, while on the m DM-MP3
there is none.

Generation 4 LOR MP3 Directors

G4 MP3 Directors come in several variants, including the N4-G4-MP3 a metal case 4 port MP3 director
with Director Link, 1 and 2 port black plastic directors without Director Link, and a 2 port adapter with
Director Link will be available in the future.

Lights! AuEict. ll.dafl'dr!

Light-O-Rama

Summary of Differences Between Directors
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Director Name |Gen Real |Nu[Supp| Sup|Sup Has
erat| Time [mb| orts |ports|port|Displ
ion|Clock| er |LOR|LOR| s | ay
(Can | of [Enhal 500 |Dire
have [Por|nced|K/10|ctor
sched| ts [Protg 00K | Lin
ules) col |spee| k
d
DCMP3/LOR160 1 | Yes | 1 | No | No [No| No
2MP3
mDM-MP3 1| No [ 1] No | No|[Nof No
(Mini)
G3MP3/LOR160| 3 | Yes | 2 [ Yes|Yes|No| Yes
xMP3g3
uMP3-G3 (Mini)[ 3 | No | 1 |[Yes|Yes|No| No
N1uMP3G4 4| No | 1 |Yes|Yes|No| No
(mini)
N4-G4-MP3 4 | Yes | 4|Yes|Yes|Yes Yes
5.1.7.3 How to Use Director-Link

4th Generation (G4) Directors have the ability to link up and control many more networks or DMX
universes. These directors have a feature called 'Director Link'. To use Director Link you need:

1. Two or more directors that support Director Link. Only directors that specifically say they support
director link can be used. No exceptions.

2. CAT 5/6 wired connections between all directors

3. A show that was created specifically for Linked Directors using multiple SD cards

In a multi-Director setup, the first director is considered the 'Master' director. In this director is placed
the first card of the multi-card set. All other directors are considered secondary directors and while they
can be connected in any order we strongly recommend you hawe a logical system in place. It can
become very confusing remembering which director needs which SD card. The best way to do this
would be to sketch out all your directors and all the networks you want attached to them. Label
everything to reduce the confusion.

Linking up directors physically is very simple: They daisy-chain the same way that LOR lighting
controllers do with a CAT 5 cable. From your first (master) director, run a cat 5 from Net 1 (Labeled G4
Link or just Link) to the next (secondary) MP3 director 's port 1. For a third director, connect to the
OTHER jack on the secondary director labeled 'Link' or 'Net 1' to the third controller's Net 1/Link port.
Continue on that way for any additional directors.

When using MP3 Directors in Link mode remember that NET 1 is reserverd ONLY for linking directors
together. You can only attach other linkable directors to the link port, not lighting controllers. If you do
attach a lighting controller while the director is being used in link mode, the controller will not work or will
light random channels.

The connection between 2 directors' link ports can use ELLs. Please ensure that the ELLs that you use
are on a different channel than any other ELL that may be in use for your show.

Assigning Ports
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When you get to the port assignment step in SD card creation, it is important to check the box at
the top: "I have MULTIPLE G4 Directors...". This gives you access to buttons that will add 2 and 4
port Directors to the configuration. You may add any number or combination of 2 and 4 port linkable
directors to a show.

Please be aware that ALL directors MUST be Director-Link capable. You can not mix linkable
and older non-linkable directors in the same show.

Create SD Card

o, <ok

" | have MULTIPLE G4 Directors that are connected together using 'Director Link”

|Annz-mmm|m:rm| |ADD-I—PDRTDIRECI’DI1| |K| ||_|:|| |m|

NET/UNIV PROTOCOL
Director 1

Link to other directors
Regular

Aux A

Aux B

One 4-port Director

Clicking "Add 4-Port Director" results in this:
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Create SD Card

o, [tk

s | have MULTIPLE G4 Directors that are connected together using “Director Link'

(002 rorr mecron| X O @
MET/UNIV PROTOCOL

Director 1
Link to other directors
Regular

Aux A
Aux B

Director 2 |i|

Link to other directors
Aux C

Unassigned
Unassigned

After adding a second 4-port Director
To remowe a Director, click the trash can icon to the right of the Director name.
You easily move networks to other ports using cut, copy, and paste.
e Cut copies the network setting for the port to the clipboard and then sets the port to
unassigned.
e Copy copies the network setting for the port to the clipboard without changing the port.
e Paste copies the clipboard settings to the selected port.

There are 2 ways to perform cut, copy, and paste operations:

¢ You can select a row in the grid and then click the cut, copy, or paste button above the grid, or
¢ You can right-click on a row and select cut, copy, or paste from the pop-up menu

So in screen shown abowe, if we want to move Aux B from Director 1 to Director 2:

e Select the row for Director 1, port 4. Perform a cut (either using the right-click menu or clicking
the Cut button). Port 4 will change to "unassigned".

e Select the row for Director 2, port 3. Perform a paste (either using the right-click menu or
clicking the Cut button).
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You should end up with the following assignments:

Create SD Card

o [tk

»" | have MULTIPLE G4 Directors that are connected together using "Director Link'

| ADD 2-PORT DIRECTOR | | ADD 4-FORT MRECTOR |

NET/UMIV PROTOCOL COMMENT
Director 1

Link to other directors

Regular

Aux A

Unassigned
Director 2 |?|

Link to other directors

Aux C

Aux B

Unassigned
Aux B moved to Director 2, port 3

If you want to manually configure a port, double-click on its row to bring up the settings. Please
remember that since Port 1 is the 'Link' connection between MP3 directors, you can not assign or
change any of it's parameters.
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¥ Port Settings — O

Director 1 - Port 2

Metwork / Universe

Aux A

Protocol

ELOR

In this example, the user double-clicked on port 2, which is indicated in the heading.

e Network/Universe: The LOR Network or DMX universe that this port will control. There is an
option for "None" here, Use this option when a port is not going to be used.

e Protocol: The data protocol in use: LOR, ELOR (Enhanced LOR) or DMX

e Speed: The speed of the network. DMX Universes run at a fixed speed and cannot be
changed. The 1000K speed can ONLY be used with networks that only contain PixCon16
controllers or Pixie family controllers. No other LOR controllers support 1000K.

e Comment: User comment if desired.

More information about the protocols and speeds supported by various Light-O-Rama controllers is
available on our web site.

5.1.7.4 Throttle Parameters

While writing your show to the SD card for an MP3 player,LOR Hub will automatically monitor how
much bandwidth is required by your sequence every centi-second. When the bandwidth is
exceeded, the program can '‘compress' your data so that your music and lights stay better in sync.
The advanced options window allows you to turn this functionality on/off or adjust its parameters.

Please note that changing these parameters can cause your show to fall out of sync, have
unacceptable delays, or cause other issues. You should only change these if you are
having issues with the defaults, and even then be prepared to restore to the defaults should
your show fail. For 99.9% of shows, these defaults are already optimized.
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Advanced Parameters n

v Throttle MP3 Data Output for Improved
W
Performance

1

Minimum throttle time in C5. The director must
be this far behind before throttling is started
[Default = 1 C5)

I
Buffer Flush Time in C5. Higher flush times
reduce network load but increase the likelihood
of commands being compressed. [Default=2 C5)

MP3 Director Metwork Efficiency. MP3 Directors
typically use 1008 of bandwidth available.
Setting this lower causes more throttling to
happen by reducing the throughput. [Default =

100%g)
oK Cancel

The Advanced Parameters window

e Throttle Data Output for Improved Performance: It is recommended that this option remain
ON (checked). When checked, your sequence is monitored. For each centi-second that passes,
the program will compute the amount of bandwidth required and compare it to the amount
available. If unchecked, no throttling is done - this is the same mode as versions previous to
3.12.0.

e Minimum Throttle Time in CS: If throttling is enabled, this is the minimum amount that the
sequence must be behind before compression starts. For example, if this is set to 5 CS, then
once the sequence is 5 or more centi-seconds behind the audio, compression will begin. Setting
this higher will allow for more complex areas of your sequence to remain uncompressed at the
expense of lagging further behind your audio. The default value is 1, and this means that as soon
as the sequence falls behind, compression should begin.

e Buffer Flush Time in CS: This can be thought of as the ‘resolution’ that your MP3 Director will
run at. Setting the value lower will increase resolution as well as network load. Setting the value
higher will decrease network load at the expense of having more commands be compressed. The
default value of 2 most closely emulates what a computer produces for output, either in the
Sequencer or the Show Player, when running a sequence on your hardware. For versions before
3.12.0, this value was 1.

e MP3 Director Network Efficiency: MP3 directors will typically use 100% of the bandwidth that
is available for a port. Setting this to a lower percentage reduces the amount of throughput, which
will cause more throttling to happen. It may be best to think of this option as a reduction in the
network speed. For example, if you set a port to 57.6K speed, and set this option to 70%, then
the hardware utility will throttle the sequence as if it was for a network that runs at approximately
40.3K (57.6 * 70%).
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5.1.8 License
The Light-O-Rama Software Package must be registered, with a valid license, before it can be used to its

full potential. Without a license, Light-O-Rama can be used as a demo, but it will not actually control
your lights.

There are several different license lewels, each having different features available; please see the feature
comparison for details.

To register Light-O-Rama first visit the Light-O-Rama store, and purchase a license. You will then be
able to enter your license information:

¢ By going to the Sequencer's Help menu and selecting Register Or Upgrade Light-O-Rama, or
¢ By selecting the License section in the Control Panel

Both methods work similarly. The Control Panel's screen is shown below:
Light-O-Rama Control Panel v6.0.9 Pro
Menu Light-O-Rama License Information

You are licensed for the Pro Edition with SuperStar 60_CCR
Controller Setup pe -

To upgrade, please purchase a higher level license and then click the register button below.

0
% Networks You can purchase a license or upgrade at the Light-O-Rama web store:

lh.! Test Ligh ts https://store.lightorama.com

Go to the store, and then look for the link to Software Products.
Sequences

- Registrati
t.@) Create Shows egistration

Have Intemet? | REGISTER ONLINE | No connection? | REGISTER OFFLINE |

Your name is considered case-sensitive, so please type uppercase and lowercase letters exactly as they are in
your registration information. If you received a license information email, then you can copy the fields, one at
a time from the email, and paste into the fields above.

L Set ngs

The Control Panel's license section

If your computer is connected to the internet, you can register simply by entering the name and license
key from your license information, and clicking "Register Online" (the license name and key can be
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copied and pasted from the email in which they were sent to you). Light-O-Rama will then automatically
verify your license information, and, if it is valid, register your computer.

You may then have to close any Light-O-Rama programs that are running, and then restart them, before
all of your newly available features will be available.

If your computer is not connected to the internet, click on the "Register Offline" button in order to register
offline.
5.1.8.1 Registering Offline

If your computer is connected to the internet, you can register Light-O-Rama directly in the Registration
dialog. If not, though, you can still register while offline. Open the Registration dialog and click the link
at its bottom ("Need to register offline? Click here.").

Doing so will open the Offline Registration dialog:

P o

o Offline Registration @

Firzt, pleaze enter your regiztration infarmation. Nate that pour name iz considered case-senzitive,
z0 pleaze ppe all uppercase and lowercase lethers exactly as they are in vour registration
information:

Mame: ||

License Key: |

When you have entered them, please click the "Show Offline Registration Key" buthan:

Show Offline
R egistration F.ey

Your OFfline Registration Key:

Mext, you will need an offline authonzation key. |fF pou have another computer, with LOR installed,
which haz internet access, you can get one by running the LOR Offline Beaistration tility on that
computer, and entering vour license name, license key, and offline regiztration key into it.

|f you da niot have anather computer, with LOR installed, with internet access, please call
Light-0-F ama at 518-533-3000, and a person there will create an offline authanization key for pou,
Yau will heed to provide the persan with your licenze name, license key, and offline regiztration
key.

After you have received your offline autharization key, pleaze enter it below, and click the
"Reqister'' buttor;

If & bow turne red, that means that LOR has detected an ermor in that box, 20 pleaze double-check

what pou have typed in it.
Beqister Cancel

The Offline Registration Dialog

Once this dialog is opened, follow the instructions on it to register offline. A brief summary:
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First, enter your license name and license key (these can be copied and pasted from the email in which
they are sent to you).

Next,click "Show Offline Registration Key".

At this point, you will need to use your offline registration key to get an offline authorization key. There
are two ways to do this:

First, if you have another computer, which is connected to the internet and which has Light-O-Rama
installed, you can run the Offline Registration Utility on that computer. Make sure to hawve your license
name, license key, and offline registration key available to enter onto that computer; the Offline
Registration Utility will use them to create an offline authorization key.

If you do not have another computer that you can use to run the Offline Registration Utility, then you can
obtain an offline authorization key by calling Light-O-Rama, at the telephone number shown on the form.
Provide the person you speak to with your license name, license key, and offline registration key, and

they will provide an offline authorization key to you.

After you have obtained an offline authorization key, type it into the boxes near the bottom of the form,
and click "Register".

After you have successfully registered, you may need to close any Light-O-Rama programs that are
running and restart them before all of your newly available features can be used.

5.1.9 Settings

Settings is listed at the bottom of the Control Panel's main menu. Here you can set values that control
the look or behavior of the program, but items you should seldom need to change.
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Menu

Controller Setup

%ﬁ Networks

'I'i'!' Test Lights

Sequences

t.é, Create Shows

l:l Settings

Launch At Start-up

If you wish, you can set it up so that the Control Panel will automatically be run whenever your
computer starts up (and therefore you won't have to start it via the Start menu anymore). To do this,
select "Launch at Startup” in the Settings section header.

ama Control Panel v6.0.5 &y (? O

Setti ngs v’ Launch at startup

Launch at Startup

Settings Tabs
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D Launch at startup

The Settings tabs
Settings are divided into 6 categories. Click on a tab to mowe to the desired category.

Theme

Communications (Comm)
Mabile App

Video

Folders

About

Theme

Select a theme from the list. it will be applied immediately.

Dark
Dark.Amber .
Dark.Blue
DarkBrown
Dark.Cobalt
Dark.Crimson

Dark.Cyan

Dark.Emerald

Theme selection

Themes are grouped into 2 categories: Dark and Light. Dark themes have a gray background with
white text. Light themes have a white background with black text. Every theme has a highlight color.
So "Dark.Blue" is a dark theme with a blue highlight. Click on the theme you want and the change
will be applied immediately.

Communications
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Comm Listener

The Comm Listener port is used internally by the Light-O-Rama software. Only change it if the value
conflicts with ancther software application.

Port: Ba37

MC-P Controllers

D I am using LOR MC-P controllers (manufactured 2005 or earlier).
ONLY CHECK THIS BOX IF DIRECTED TO DO 50 BY LIGHT-O-RAMA SUPPORT.

OSC (Open Sound Control)

IP Address 192.168.0.22 Realtek PCle GBE Family Controller =
o]

D Respond to incoming O5C messages

Communication tab

Comm Listener Port

This section can be used to configure the IP port that the Control Panel listens on for lighting
commands from the Sequencer and Hardware Utility. The default port of 8837 should work for nearly
all users, but can be changed here if it conflicts with other software on your computer.

MC-P Controllers

If you are using Light-O-Rama MC-P controllers purchased prior to 2005, then you should enable
MC-P compatibility mode by checking this box. If you do not check this box, then you will see odd
behavior on circuits 9 through 16 of such controllers.

Old MC-P compatibility mode only affects controllers on the Regular LOR network; those on Aux
networks are unaffected. Therefore, make sure to put all such controllers on your Regular network.

NOTE: Enabling Old MC-P compatibility mode may have a significant effect on
communications speed for the regular network. It is therefore strongly recommended that you
do not enable it without reason, and that if you do enable it, you should consider moving any other
Light-O-Rama controllers (which do not need Old MC-P compatibility mode) off of the Regular
network, and onto one or more auxiliary networks.

OSC (Open Sound Control)
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Open Sound Control (OSC) is a protocol for networking sound synthesizers, computers, and other
multimedia devices for purposes such as musical performance or show control. Learn more in the
Wikipedia article. This is an optional feature meant for advanced users. It is not required to
make you show run.

The Control Panel can listen for incoming OSC messages that will control certain aspects of your
show. A complete list of messages can be found in the OSC Messages topic.

In this section you need to specify which network (IP address) and on which port the Control Panel
will listen. The port listed here must match the OSC application that is sending the messages.

The "Respond to incoming OSC messages" check box turns this function on or off.

Mobile App

Display Number

This value must match the display number you choose in the mobile app. After changing this value, disable

the cloud connection and then re-enable it. Ctherwise, the change will take effect the next ime this
program is started.

Mobile App tab

Here you set the "Display Number". If you want to use your Light-O-Rama license to control 2
separate displays, each display controlled by its own computer, then you will need to designate one
display as "Display 1" and the other as "Display 2". Then in the mobile app, you specify which
display you want to control.

If you only have 1 display, then leave this setting at "1".

Video

When playing shows with video media (e.g. AVI, WMV, or MP4 files), how should the video be displayed?

o Display videos in a window. You control the size and placement of the window.

Display videos full screen. If you have multiple monitors, use the mode above to first place the
window on the desired monitor.

O Only play the audio track for sequences with video media (no video display)

Video tab

This setting controls how sequences with video media (e.g. AVI, WMV, or MP4) should be handled.
If you want video displayed full screen on a certain monitor or projector, follow these steps:
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Set the video setting to play in a window (first option)

Use Show on Demand to start your show with video media

Move the window to the desired monitor

Stop the show. The video window should still be open

Go to Settings > Video and select full screen. The existing window should immediately go full
screen on the monitor it was on.

agrODE

Ewverything should be saved automatically.

Folders

Sequences should be placed in this folder:

CAUsers\Matt\Documents\Light-O-RamalSequences)

Audic and video files (MP3, WAV, MP4, etc) used by your sequences should be placed in this folder:
Chlsers\MattDocumentsilight-O-RamahAudiol,

Previews, palettes, and motion effect favorites are stored in this folder:

CAUsers\Matt\DocumentshLight-O-RamayCommonData',

CHANGE LIGHT-0-RAMA FOLDER LOCATION

Folder tab

This tab lists key folders where your Light-O-Rama files are stored: sequences, audio/video, and
previews. Clicking any of the underlined directories will open a new Windows File Explorer window
displaying that directory.

Click the "Change Light-O-Rama Folder Location" button to change the default directory where your

audio and sequence files are stored. You should back up your existing Light-O-Rama directory
before initiating this action. Use with caution!

About
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Light-O-Rama 56 Control Panel (64-bit)
Version 6.0.9
Copyright 2022 Light-O-Rama, Inc.
Pro Edibon
Registered to: Matt Brown
Microsoft Windows 10 Pro 64-bit
AMD Ryzen 7 1700 Eight-Core Processor
NVIDIA GeForce GTX 1050
About tab
The About tab shows information about the Control Panel program and some information about your
computer. The "Copy" button can be used to copy this information to the clipboard. When creating a
ticket with the Light-O-Rama Help Desk, copying and then pasting this information into your ticket
can help Light-O-Rama personnel resolve your issue more quickly.
5.1.9.1 OSC Messages
When OSC message reception is enabled, the Light-O-Rama Control Panel will take action on the
following messages.
Message Parameters Action
"/playindex n" n is the cue number shown in Live Player mode |starts playing the specified cue
"/stop" stops playback
"/dimmer n" n is a floating point number between 0 and 1 controls the master dimmer
"/volume n" n is a floating point number between 0 and 1 controls the playback volume
5.2 Sequencer

The Light-O-Rama Sequencer is a tool used to create sequences, which are files that contain
commands to be sent to controllers to produce various lighting effects - to turn lights on and off,
make them twinkle or shimmer, fade up or down, and so forth.

There are several keys steps in the sequence process as shown in the flowchart below:

e Create a preview

e Create a sequence
e Save a sequence
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S5 Process Flowchart
If upgrading (optional)
Create a PREVIEW which import from online
. . prop libraries
channels in your display

M
~
Create a new S5 A single preview can be used
sequence to create many sequences
[ ]
N
[]
N~

Import Visualizer file

Import SE animation

Upgrade a sequence | >
from a prior version

Save 55 Sequence
Create show

pompd Using LOR Hub or
Show Editor

.LOREDIT file L
=
o using LOR Hub
The main Sequencer window is divided into several sub-windows. In the following picture it is shown with
the sub-windows in their default positions; however, the layout of the sub-windows can be easily
customized. Also, the Sequencer comes with several themes that control the background and text
colors in the main window. In the configuration that is shown, the Playback Window is pinned, meaning it
stays open (notice the pin icon in the upper right corner of the window). The Preview Management
Window and Control Lights Window on the right side are all unpinned, meaning you can click on the
name of the window to open it temporarily, but once you click on something else the window will close.

To change a window from pinned mode to unpinned mode (or vice versa), just click the pin icon for that
window.

The Start Page gives you links to quickly start a new animation or musical sequence, and to open
sequences that have been recently viewed.

© 2022 Light-O-Rama, Inc.



196

Light-O-Rama v6.1.0

Version License

Number Level

E‘i Light-0-Rama 55 Sequencer v5.5.19 Pro .
Preview

Management
Window
{unpinned)

File Tools Window Help

Mo Motion Effect Selected

[ NN N NERE &, [ | LD

SMBIAR

Control
Lights
Window
(unpinned)

syB17 joquos

Effect
Samples
Window

{unpinned)

Tabs provide
access to the

sajduiesg 133447

RET LT * 02 - Music Box Dancer (Radi...

Start Page @ How Do | Get Started?
and all open

sequences Start A New Sequence

Audio
Settings
Start Page @ Mew Musical Sequence Window
provides links (unpinned)
to create new Q New Animation Sequence
sequences or Light bulb is
open ones yellow when
that were Recent Sequences “Control

- ij " i
accessed C:\Users\Matt\Documents)Light-0-Rama\ Sequences\ Samples\LOR 5.6.0 Motion Effects.loredit Lights” is
recently i enabled

sbumes eipny

Sequences are displayed in the S5 Sequencer as a grid. Rows represent regular channels, RGB
channels, motion effect rows, subsequences, beat channels or loops, and columns represent timings.
Cells in the grid therefore represent the lighting effects that will happen on props at various points in time
while the sequence is being played.

Regular channels, RGB channels, and motion effect rows are associated with props in the preview or
with archived props. Motion effect rows can also be used with preview groups.

As an example, the following sequence has four props, each with a single channel. At the start of the
sequence, the first prop's channel turns on. It stays on for half a second, then turns off, and the second
prop's channel then turns on. Then it turns off, and the third turns on, and then the third turns off and the
fourth turns on. This brings us two seconds into the sequence, at which point all four channels fade
down, for a second. After that, the first and fourth channels start shimmering, while the second and third
fade up:

ot - 0 001 002 0:03 0:04

Channels 1-4

£ Channel 1
& Channel 2
& Channel 3
3 Channel 4

A sequence with four channels, and various lighting effects

Notice that one cell is highlighted with a thick yellow box - the cell of the first channel from 3 seconds to
3.5 seconds. That is the currently selected cell. Various tools can be applied to the selected cell (or
cells), for example to change the lighting effect used on that channel at that time.

Before proceeding, you should understand what a sequence is and what a preview is.
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For more detailed information about using the S5 Sequencer, please see the following topics:

The Main Menu

The Start Page

The Previews Window

Preview Design

The Sequence Tab (editing a sequence)
Motion Effect Generator

Playback Window

Control Lights Window

Customizing Window Layouts

¥ Light-O-Rama

File Sequence Tools Window Help
@ Timing - f | Fixed Gri: 010 - LOR-TypicalHouse-C68P32-1280-RevA g
Save Cut Paste Std Clipboard s e & ¥ Shorter Time Qut Playback Window
W e |20 B O repent | ISR | DREE L E X S Shoter O B oo .
4 Undo 53 Copy E Paste Special PasteBy Cell  ~ .! ,! (i1} @ >3> 3> |$| Taller @ Time In iﬂ ‘Waveform =
Clipboard Paste Mode Play Nudge Zoom Wisibility ::'j
On Mouse Click Intensity Range & Slope Effect Type Channel Effect %
A B B Ma & o cwze O M uRe ® ® = &8 o B ¥ &
Select | Create Toggle Fill Chase  Intensity Presets | Max | Min Up Down Drag Fade Channel | Color Shimmer Twinkle DMX =
P
.00 0:00.50 0:01.00 0:01.50 0:02.00 0:02.50 0:03.00 0:03.50 0:04.00 0:04.50 &
E
=
Track 1 -h- 2
£301.13-Bush A
©01.14-Bush B z
€2 01.15-Bush C g
€2 01.16-Bush D ﬁ'
Unit ID 02 =
Unit ID 03 =
Unit ID 04
Unit ID 06
=] = 07-Window 1 RGB
= 07-Window 2 RGB
= 07-Window 3 RGB
= 07-Window 4 RGB
= 07-Window 5 RGB
= 07-Window 6 RGB
= 07-Window 7 RGB
< b R

Total Time: 20.35 | Selected Time: 2.70 - 3.30 | Selected Duration: 0.60 | Select - cells

The Sequencer with an open sequence

5.2.1 Menu Bar

The Light-O-Rama S5 Sequencer’'s menu bar gives access to all of the program's major functionality.
For detailed help, please refer to the help pages for each individual menu on the menu bar:

File Menu
Sequence Menu
Tools Menu
Window Menu

Help Menu

55 Light-O-Rama 55 Sequencer v3.0.13 Pro

File  Sequence Tools Window Help
The S5 Sequencer's menu bar
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5.2.1.1

File Menu

The Light-O-Rama Sequencer's File menu has menu items related to creating, opening, and saving
sequences, as well as exiting the program.

Several of these menu items operate on the "currently selected sequence”. Many sequences can be
open simultaneously in the Sequencer, but only one is the currently selected sequence. Each open
sequence has a tab that displays the sequence's name. The currently selected sequence's tab will be
highlighted (the highlight color depends are which theme you are using). To select a sequence, simply
click on its tab.

Open
Recent Files

Save A Copy

Export as LMS/LAS

Export as Protected

Export as FSEQ File

Close
Close All
Exit

File = Sequence Tools Window  Help

Save As...  Ctrl+5hift+5
Save A Copy Ctrl+Alt+5
Export as LMS/LAS

Mew k Musical Sequence Ctrl+M
Open... Ctrl+0 Animation Sequence  Alt+N
Recent Files 3
g sove s Paste ) Repest g’ 5td Clipk
Paste Special | Paste By Cell

Clipboard | Paste Mo

In

rh 0 [2100 {2 u

Sopes i esien jse Intensity Presei

Export as FSEC File | 10

Close Ctrl+W .

Close All  Ctrl+5Shift+W e

Exit Alt+F4 A E
ST T The Fii.g?Menu

New

Selecting "New" on the Sequencer's File menu opens a sub-menu which gives you a choice between
creating a new animation sequence or a new musical sequence. You can also initiate the creation of
a new musical or animation sequence from the Start Page, or by right-clicking on a preview in the
Previews Window.
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"New Musical Sequence” has a
keyboard hotkey: Ctl'l N

"New Animation Sequence" has a
keyboard hotkey: Alt N

Open

Selecting "Open" on the Sequencer's File menu opens a dialog that allows you to select a sequence
file.

If you select an S5 sequence file (.LOREDIT file extension) the preview for the sequence will be
checked. If the preview has been changed since the last time the sequence was opened, the Map
New Preview To Sequence Dialog will open; and once you finish that dialog the sequence will open. If
the preview has not changed, the sequence will immediately open on a new tab within the
Sequencer.

If you choose a sequence file created in an older version like S4 (.LMS or .LAS file extension), then
the Upgrade Legacy Sequence dialog will open, guiding you through the sequence upgrade process.

"Open" has a keyboard hotkey: Ctrl ||O

Recent Files

Selecting "Recent Files" on the Sequencer's File menu opens a sub-menu which lets you select
from a list of the most recently opened sequences. The list of files on the "Recent Files" sub-menu
are the same ones listed on the Start Page.

Save
Selecting "Sawe" from the Sequencer's File menu saves the changes that you have made to the
currently selected sequence. If the sequence was newly created and has never been saved before,

Sawve will also prompt you for a file name to use for the new sequence.

The Save function will be followed by a Save A Copy function if specified in Save Copy Preferences.

"Sawe" has a keyboard hotkey: Ctrl S

Save As

Selecting "Sawve As" from the Sequencer's File menu saves the current sequence to a new file name.
The old file will still exist, but will not include any of the changes that you made to the sequence
since the last time that you saved it.
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Save A Copy

Selecting "Save A Copy" from the Sequencer's File menu saves the current sequence to a new file
name. The old file will still exist, but will not include any of the changes that you made to the

sequence since the last time that you sawed it.

This function has a several options that control its behavior. See the Save Copy Preferences topic for
details. In particular, this function can be used to make backup copies of the sequence when the

"Date and Time" suffix is specified.

Export as LMS/LAS

Selecting "Export as LMS/LAS" from the Sequencer's File menu exports the current sequence to the
legacy LMS/LAS format. A file with an LMS extension will be created for musical sequences; an
LAS extension will be used for sequences without music. You will be prompted for the location of the
export file. Files produced using this function are compatible with Light-O-Rama software versions

3.8.2 and later.

Data included in the export file:

e Reqular channels
e RGB channels

e Beat channels
e Subsequences
e Loops in animation sequences

e All timing grids
e The "Show All ltems" grid view -- converted to "Track 1" in the export file

Data NOT included:
e Motion effect rows
e Archived props

e Any grid view other than "Show All ltems"

If you have a license that allows the creation of protected sequences, you can change the file type in
the sawve dialog to a protected sequence if desired.

File name: | A Holly Jolly Christmas-Michael Buble-CE2P32-YCM.Ims w

Save as type [LOR Legacy Musical Sequence (*.Ims)

LOR. Protected Musical Sequence (*.Ims)

—SO%C 1 L

Setting the file type during the Legacy Export

Export as Protected
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Selecting "Export as Protected" from the Sequencer's File menu can be used to create a protected
sequence based upon the current sequence. You will be prompted to enter some supplementary text
that will be displayed to the user when they open the protected sequence in the Sequencer. The
supplementary text is optional.

Export As Protected *

Enter text that will be displayed when the protected sequence is opened in the Sequencer:

Licensed to John Doe for personal use only.
Selling the sequence is forbidden.

Cancel

The supplementary text entry screen with some sample text

-t -0 0:0 0:02 0:03 0:04

Protected Sequence
(click for more information)

Licensed to John Doe for personal use only.
Selling the sequence is forbidden.

What the user sees when they open the protected sequence
(with the supplementary text entered above)

Export as FSEQ File

Selecting "Export as FSEQ" from the Sequencer's File menu exports the current sequence to the
FSEQ file format (version 1). The function is only available at the PRO license lewel. The export only
includes props with device type DMX in the export file. It finds the highest numbered DMX universe in
your preview, and then includes universe 1 through that number. So if the highest numbered DMX
universe in your preview is 36, the file will include universes 1 through 36; which is 36 * 512 = 18,432
channels. This is true even if there are some universes in that range that are not used. If you transfer
the file to FPP, then what was universe 1 in your sequence will be channels 1-512 in FPP, universe 2
will be channels 513-1024, etc.
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Close

Selecting "Close" from the Sequencer's File menu closes the currently selected sequence.

If the sequence has unsaved changes, you will be prompted on whether you wish to save the
changes or not; if the sequence has never been saved before, and you choose to sawe it, you will
also be prompted to select a filename for the new sequence.

Close All

Selecting "Close All" from the Sequencer's File menu closes all open sequences.

If any of the sequences have unsaved changes, you will be prompted on whether you wish to save
them or not; if any of the sequences have never been saved before, and you choose to save them,
you will also be prompted to select filenames for the new sequences.

Exit

Selecting "Exit" from the Sequencer's File menu closes the Sequencer. If any currently open
sequences have changes that have not yet been saved, you will be prompted for whether or not you
want to save them.

5.2.1.1.1 New Animation Sequence Dialog

The Sequencer's New Animation dialog is used to create a new animation sequence (a sequence with no
music). The New Animation dialog can be reached several ways:

e Selecting File > New > Animation Sequence from the main menu

¢ Clicking the "New Animation Sequence" link on the Start Page

¢ Right-clicking on a preview in the Previews window and selecting "New Animation Sequence" from
the pop-up menu

e Using the keyboard shortcut Alt-N

For detailed help, please refer to the following sections:

Sequence Author

Preview

Sequence Length

Use Loops

Initial Timing Grids

Number Of Motion Effect Rows For Pixel Props
Sawe these choices as defaults.

© 2022 Light-O-Rama, Inc.



The Light-O-Rama Software Package 203

Mew Animation Sequence >

Sequence Author (cannot be changed later):

lane Doe

- Select Preview

A preview defines all of the display elements and channels in your sequence

Cluick Preview

2017 class sample w

Length of animaticn (not including loops):

|1:DD.DD 1 minute

[] UseLoops

r Initial Timing
[] Tenth second intervals
Half second intervals
[] One cecond intervals

[] Custom interval

A NE e

-

[] Create an empty freeform timing grid

Default number of motion effect rows for pixel props: 4 x
(requires PRO license)

Save these choices as defaults Create Cancel

The New Animation Sequence dialog

Sequence Author

If you wish, you can put your name here. It will be saved with the sequence, and will be displayed
on the Sequence Information screen. Once set, even if set to a blank value, it cannot be changed.

Preview
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A preview is a representation of your light display. It specifies all of the props that you can apply
effects to in your sequence. It also specifies all of the channels your sequence will be able to
control.

Normally, you will select a preview that you have already created on the "Existing Previews" tab.
Howewer, you can use the Quick Preview feature to create a new preview on the fly.

After assigning a preview here, you may continue to update the preview and those updates will be
automatically reflected in the sequence (for example, adding a new prop). You can also later assign
a different preview to the sequence; although if you do that, the new preview should be substantially
similar to the originally assigned preview.

Sequence Length

This allows you to specify the duration of the sequence. You will be able to change the value later,
using Change Sequence Length in the Sequence menu.

The time can include hours, minutes, seconds, and hundredths of a second. For details on the
format used to specify various lengths of time, please see Time Format.

Use Loops

If you check the "Use Loops" check box, the newly created sequence will automatically include a
loop level, which can be used to insert loops into the sequence.

If you create an animation sequence without having selected "Use Loops", and you later decide that
you do want loops in the sequence, you can add a loop level by selecting "Loop Lewel" from the Add
New menu, available on the Sequence menu and the Grid View menu.

Initial Timing Grids

This allows you to tell the Sequencer to automatically insert timings into the new sequence.
Timings are the spots in time where you can easily place lighting effects - for example, turn a string
of lights on, or hawe it twinkle, or hawe it fade down.

If you don't know how far apart you want timings to be, just take a guess. You can always insert,
delete, or mowe timings later. Note that although the New Animation dialog only allows you to set
timings up at equal lengths from each other, timings in general can be any length from each other.
For example, you could later add a timing three seconds away from another, and a third timing half a
second away from that one.

If you select "Custom Interval”, you can enter any length you want, rather than one of the defaults.
This value must be entered using the standard Time Format.

Number Of Motion Effect Rows For Pixel Props

If you have a Pro level license, then you can use motion effects to sequence your props that utilize
RGB pixels. You can also have multiple motion effects playing on a prop at the same time. This
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setting specifies how many motion effect rows should be created for every pixel-based prop.
Typically 1 or 2 is a good choice to start. And then you can add more rows to specific props as your
sequencing needs dictate.

Save These Choices As Defaults

If you turn this check box on, your answers to the questions in this dialog will be saved so that
whenever you create a new animation sequence in the future, those answers will automatically show
up in this dialog as the default answers.

5.2.1.1.2 New Musical Sequence Dialog

The Sequencer's New Musical Sequence dialog is used to create a new musical sequence (a sequence
with an associated audio or video file). The New Animation dialog can be reached several ways:

e Selecting File > New > Musical Sequence from the main menu

¢ Clicking the "New Musical Sequence” link on the Start Page

¢ Right-clicking on a preview in the Previews window and selecting "New Musical Sequence" from
the pop-up menu

¢ Using the keyboard shortcut Ctrl-N

After doing one of these things, but before the New Musical Sequence dialog opens, you will be
prompted to select the audio or video file that will be used to build the new sequence. After you select
the file, then the New Musical Sequence dialog will open.

Behind the scenes, the Sequencer will open the media file to determine its length. When the new
sequence is created, its length will match that of the media file.

For detailed help, please refer to the following sections:

e Sequence Author
e Preview

e Music Information

e Initial Timing Grids

e Number Of Motion Effect Rows For Pixel Props
e Audio Information

e Sawe These Choices As Defaults
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Mew Musical Sequence X

Sequence Author (cannot be changed later):

Jane Doe

rSelect Preview
A preview defines all of the display elements and channels in your sequence

Existing Preview  Quick Preview

LOR Store Sequences-House-C68P32 (2020-07) w

r Music

File name |Wizards In Winter-T50.mp3

Title |Wizard5 In Winter (Instrumental] (Album Version)

|
Artist |Tran5-Sil:Jerian Orchestra |
|
|

Album |The Lost Christmas Eve

rInitial Timing
Use a Wizard to create timings Create equally spaced timings
® Mot now, maybe later [ Tenth second intervals
Half second intervals
() Use the Tapper Wizard [] One second intervals
(O Use the Beat Wizard [] Custom interval
(O Use the VU Wizard 0.0 c
Mumber of motion effect rows for pixel props without [, Py

-

defaults set in the preview (requires PRO license)

Audic Infermation Waveform Only ~

Save these choices as defaults Cancel

The New Musical Sequence dialog

Seqguence Author
If you wish, you can put your name here. It will be saved with the sequence, and will be displayed
on the Sequence Information screen. Once set, even if set to a blank value, it cannot be changed.
Preview

A preview is a representation of your light display. It specifies all of the props that you can apply
effects to in your sequence. It also specifies all of the channels your sequence will be able to
control.
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Normally, you will select a preview that you have already created on the "Existing Previews" tab.
Howewer, you can use the Quick Preview feature to create a new preview on the fly.

After assigning a preview here, you may continue to update the preview and those updates will be
automatically reflected in the sequence (for example, adding a new prop). You can also later assign
a different preview to the sequence; although if you do that, the new preview should be substantially
similar to the originally assigned preview.

Music Information

If you wish, you can put the name of the artist, song, and album of the associated song here. It will
be saved with the sequence, and will be displayed in the Sequence Information dialog.

Some media files have already been tagged with this information. If you utilize such a media file, the
Sequencer will automatically discover those tags and populate the fields in this section (though you
can still change or delete it if you wish).

You can change this information later in the Sequence Information dialog.

Initial Timing Grids

This allows you to tell the Sequencer to automatically insert timings into the new seguence.
Timings are the spots in time where you can easily place lighting effects - for example, turn a string
of lights on, or hawe it twinkle, or hawe it fade down.

In addition to placing timings a certain length of time apart (a tenth of a second, a half second, a
second, or "Custom Intenal"), add adding no timings at all ("Don't add any timings"), you can
instruct the Sequencer to use various wizards to insert timings based upon the song itself:

e The MIDI File Wizard can insert timings and effects based upon the beat of a MIDI song, as
well as based on the individual notes played by different instruments in the song.

e The Tapper Wizard allows you to tap the keyboard or mouse while the song plays, and will
record the times at which you tap.

e The Beat Wizard attempts to determine the tempo of the song, and insert timings and effects
based upon it.

e The VU Wizard looks for peaks in the song, much like a VU meter, and inserts timings and
effects based upon them.

Not all of these wizards are available for every type of media file; for example, the MIDI File Wizard
can only be used with MIDI files. Any wizards that cannot be used with the type of media file being
used will be greyed out.

If you select "Custom Interval", you can enter any length you want, rather than one of the defaults.
For details on the format used to specify various lengths of time, please see Time Format.

If you choose to have equally spaced timings, then you will be given the option to use a fixed timing
arid or a freeform timing grid, by checking or unchecking the "Use a fixed timing grid" box.
Otherwise, a freeform timing grid will be used.
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Note that you can always insert, delete or move timings later, in a variety of ways.

Number Of Motion Effect Rows For Pixel Props

If you have a Pro level license, then you can use motion effects to sequence your props that utilize
RGB pixels. You can also have multiple motion effects playing on a prop at the same time. This
setting specifies how many motion effect rows should be created for every pixel-based prop.
Typically 1 or 2 is a good choice to start. And then you can add more rows to specific props as your
sequencing needs dictate.

Audio Information

Wawveform Only w

Spectrograrn Low Res
Spectrogram Medium Res
Spectrogram High Res

If your license level is below Pro, then "Waveform Only" will be your only choice here. With any
media file except MIDI, you will see a waveform displayed when the sequence is opened.

If you have a Pro license, you can also choose to see the audio as a spectrogram (see the Audio
Settings topic for examples). The spectrogram takes some extra time to calculate, so sequences
will take a little longer to load (the amount of time depends on the speed of your computer and the
length of the media file). For a 3 minute song on a fast computer, it should only add a few seconds
to the load time.

This setting also impacts the Audio motion effect. If you choose "Waveform Only", then many of the
options in the Audio effect will not work.

You can change this setting later using the Sequence Information dialog.

Save These Choices As Defaults

If you turn this checkbox on, your answers to most of the questions in this dialog will be saved so
that whenewver you create a new musical sequence in the future, those answers will automatically
show up in this dialog as the default answers.

The artist name, album name, and song name will not be saved as defaults (though if you use an
MP3 tagged with this information, it will automatically be placed into that section).

5.2.1.1.3 Quick Preview

When creating a new sequence, you have the option of associating that sequence with an existing
preview, or creating a "Quick Preview". To create a Quick Preview, click on the "Quick Preview" tab in

the New Musical Sequence or New Animation Sequence dialog. It only requires 3 pieces of information:

© 2022 Light-O-Rama, Inc.


https://en.wikipedia.org/wiki/Spectrogram

The Light-O-Rama Software Package 209

1. Sequence Name. This defaults to today's date, but you can change it to whatever you want;
however, it cannot be blank.
2. Tell it what kind of devices you are connecting to. This can be either be:
¢ Light-O-Rama devices, or
e DMX devices, or
¢ "l do not know what | am connecting to yet". If you choose this option, the sequence you
create will not control any lights; but allows you to defer your decision for later. When you
come to a decision and are ready to control lights, you will need to open this preview in
Preview Design and change the props to another Device Type.
3. The number of channels the sequence will control.

Mew Animation Sequence >

Sequence Author (cannot be changed later):
Light-O-Rama

- Select Preview

A preview defines all of the display elements and channels in your sequence

Existing Preview CQuick Preview

Name: |2018-10-19

| am connecting to Light-0-Rama devices W Channels: |16 -

The Quick Preview tab

Using the choices shown above would result in the following sequence. The 16 channels are listed down
the left side. The name of the preview is shown to the right of the green check mark.
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55 Light-0-Rama 55 Sequencer v5.1.5 Pro

File  Sequence Tools Window  Help

@ 2018-10-19 - [g] o’ 5td Clipboard Paste by Cell -

AE0m %R e E

0 002

¥ Unit 01:02
¥ Unit 01:03
TF Unit 01:04
¥ Unit 01:05
¥ Unit 01:06
TF Unit 01:07
TF Unit 01:08
¥ Unit 01:09
¥ Unit 01:10
¥ Unit 01:11
T Unit 01:12
¥ Unit 01:13
TF Unit 01:14
T Unit 01:15
T Unit 01:16

A sequence grid created using Quick Preview

Using the choices shown above would result in the preview shown below. The 16 stars represent the 16
channels. If the Playback Window is \visible when the sequence is played in the Sequencer, then the
stars will turn on and off according to the effects in your sequence. The preview will be listed on the
Previews Window just like any other the preview.

© 2022 Light-O-Rama, Inc.



The Light-O-Rama Software Package 211

Preview Design - 2018-10-19 [m| X

Design Channel Conflicts / Bulk Change Teol Other Warnings  String Summary  Statistics

Add ltem ' @,

Item + Format v Gk~

Unit 01:01 ~
Unit 01:02
Unit 01:03
Unit 01:04
Unit 01:05
Unit 01:06
Unit 01:07
Unit 01:08
Unit 01:09
Unit 01:10
Unit 01:11 W

Bulb Scale  Background

Shape Square ~

Size

: y

Transparency '

0% * ok ok ok ok ok A ok ok ok Kk ok ok ok ok X

£ >

A preview created using Quick Preview

5.2.1.2 Sequence Menu

The Light-O-Rama Sequencer's Sequence Menu gives you access to a set of functions that operate on
the currently selected sequence (the highlighted tab). If there is not any file open, then the Sequence
Menu is disabled.

e Sequence Information
¢ File References

e View Sequence Folder

e Media File

e Convert Media to WAV file
e Conwert to Animation

e Change Sequence Length
e Skew All

e Windows Command

e Preview Design

¢ Assign Different Preview
e Manage Archived Props

e Manage RGB Aggregates

e Manage Picture Effects
e Delete Grid Rows

e Add New
e Smooth To Fades Lewel

e Grid Configuration
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Sequence | Tools Window  Help
Sequence Informaticn
File References
=1 View Sequence Folder
Media File
Convert Media to WAV file

L=

Convert to Animation
Change Sequence Length
Skew All
B Windows Command
Preview Design
Assign Different Preview
@ Manage Archived Props
Manage RGE Aggregates
Manage Picture Effects

?( Delete Grid Rows

gf  Add New 3
Srooth To Fades Level *
Grid Configuration 2

The Sequence Menu

Sequence Information
This menu item opens the Sequence Information dialog, giving you visibility to key information about

the current sequence, This includes who created the sequence and when, as well as information
about the music (artist, title, and album).

File References

This menu item opens the FEile References dialog, giving you Visibility to all files referenced by the
current sequence.

View Sequence Folder

This menu item will open a Windows Explorer window with the current folder set to the folder
containing the current sequence.

This might be of use if you want to see the file size of the current sequence, or to make a copy the
sequence file. If you are going to make a copy, make sure and sawe it first!

Media File
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This menu item allows you to specify the audio or video file that should be used with the current
sequence. This may be useful, for example, if you have changed the directory that you store your
media files in.

When used on an animation sequence, it will convert the animation sequence to a musical
seqguence.

Convert Media to WAV file

This menu item converts the media file associated with the sequence to the wave format (which has
a WAV file extension).

Some media file formats do not position accurately when play back is started in the middle of the
file. This can cause inaccuracies in sequencing - your lights would turn on at slightly different times
depending on whether play back was started from the beginning of the sequence or the middle. MPG

video files and variable bit rate MP3 files are most susceptible to this issue. Converting to a wave file
can eliminate this problem.

Convert to Animation

This menu item will convert the current sequence from a musical sequence to an animation
seguence.

Perhaps someone has sent you a sequence, but you don't have the media file to go with it. By
conwerting the sequence to an animation, you can still play it back and watch the preview.

To convert an animation sequence to a musical sequence, use the Media File menu item.
Change Sequence Length
This menu item allows you to change the duration of the current sequence.

For information on the format used to specify an amount of time, please see the Time Format topic.

Change Sequence Length >

The sequence currently lasts 20.35.
Please enter the new value:

| 0.3

] Cancel

The Change Sequence Length dialog

Skew All
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Skewing a sequence will mowe all of its events, timings, and loops by some specified amount of
time. A sequence can be skewed either to the left - i.e. shifting its events (and such) earlier in time -

or to the right - i.e. shifting them later in time.

After selecting "Skew All" from the Sequence menu, a window will open up, allowing you to choose

the size and direction of the skewing:

Skew Entire Sequence

- Direction to Skew

(®) Skew to the left (earlier)

() Skew to the right (later)

rAmount to Skew (seconds)

0.05 =

rAction

Skew effects

Skew timing marks

(®) All freeform timing grids

() Just the currently selected timing grid

OK

Cancel

The Skew All dialog

In most cases, you should leave the "Action" section with the default choices. Howewer, if you have a
special situation, you can turn off skewing of effects or timing marks as needed.

After completing this dialog, the sequence will be skewed by the amount, and in the direction, that

you chose.

Here is an example of a simple sequence, before and after skewing to the right by one-quarter

second:
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0:02.00 0:02.50 0:03.00 0:03.50 0:04.00 0:0

Track 1
B = 3 01.01-Roof A
£+ 01.02-Roof B

43 01.03-Roof C

41 01.04-Roof D

= £+ 01.05-Window &

£+ 01.06-Window B

A simple sequence, before skewing

0:02.00 0:02.50 0:03.00 0:03.50 0:04.00 0:0

Track 1
== (3 01.01-Roof A
€3 01.02-Roof B

€3 01.03-Roof C

1 01.04-Roof D

= £ 01.05-Window &

¥ 01.06-Window B

The same sequence, after skewing to the right by 1/4 second

Windows Command

This menu item will open the Windows Shell Command dialog which allows a command to be
executed whenewer the current sequence is run (whether by the Sequencer or by the Show Player).

Preview Design

This menu item opens the Preview Design window for the current sequence.

Assign Different Preview

This menu item allows you to associate a different preview to the current sequence. This function
works best if the new preview started out as a copy of the original preview. However, the function will
also look for matching prop names between the old preview and the new preview. Effects will be
preserved for props and groups that match. Where there is no match, those items and their effects
will be archived.

Manage Archived Props

This menu item will open the Manage Archived Props dialog which allows you to change archived
props in the current sequence: delete them, turn them into preview props, or turn them into beat
channels.

Manage RGB Aggregates

This menu item will open the Manage RGB Agagregates dialog which allows you to add, modify, and
delete RGB aggregate channels. RGB aggregates allow you to combine any 3 existing channels (the

© 2022 Light-O-Rama, Inc.




216 Light-O-Rama v6.1.0

colors don't need to be red, green, and blue necessarily), and the combination of the 3 is treated as
an RGB channel for sequencing purposes.

Manage Picture Effects

This menu item will open the Manage Picture Effects dialog, which allows you to control where the
image files used in the sequence's Picture motion effects are stored. The images can be stored
inside the sequence file (making it easier to move your sequence from one computer to another), or
they can be stored separately from the sequence.

Delete Grid Rows

This menu item will open the Delete Grid Rows dialog which allows you to permanently remove
certain types of unused grid rows from the sequence. This menu item is only available to users with
a Pro license.

Delete Grid Rows

Pixel Props
[] Remove empty motion effect rows, unless it is the only one

[] Disable channel mode if not used

Traditional Props

[] Remaove empty motion effect rows

Groups

[] Remove empty motion effect rows, unless it is the only one

QK Cancel

The Delete Grid Rows dialog
Add New

This menu item opens a sub-menu, allowing you to add a new loop lewel, beat channel,
subsequence, or RGB aggregate. "Add New" is also available on the Grid View menu.

Smooth To Fades Level

The "Smooth To Fades Lewel" sub-menu allows you to control whether adjacent effects are merged
with one another. Being more aggressive may reduce the number of commands sent to your
controllers. On the other hand, if you are sequencing DMX fixtures that require specific DMX values
to control their functions, then you should probably set this to "None". Changing this setting only
applies to new effects, it does not change effects already in the sequence. So you can change the
setting back and forth as needed over the course of creating a sequence.
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Smooth To Fades Level 3 Mone

Grid Configuration k Mild
Moderate
Aggressive

Grid Configuration

This item opens a sub-menu allowing you import or export the user-defined grid views in the
sequence. The system-generated "Show All ltems" grid view is not included in the export.

Show All ltems B:-

Grid Views in asample
sequence

So in the example shown abowe, "View 1", "View 2", "View 3", and "View 4" would be included in the
export file.

For Pro users, the export file will also include the properties of each motion effect row. This is useful
if you have created motion rows for subsections of a prop or group.

The "Grid Configuration" sub-menu is also accessible from on the Grid View menu.

5.2.1.2.1 Sequence Information Dialog

Selecting "Sequence Information” from the Sequencer's Sequence menu opens a dialog that displays
key information about the sequence, allowing you to change some of it:

e Audio Information
Created By
Created At
Modified By
Music Artist
Music Title
Music Album
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Type

Media File

Audio Info

Preview

Created By

Muadified By

Music Artist

Music Title

Music Album

Sequence Information X

|Musica| Sequence Length 3:06.01

Sequence File | |

| ChlUsers\Matth Documents\Light- O-Ramat\Audio\Wizards In Winter-T50.mp3 |

Waveform Only ~ Sample Rate

|LOR Store Sequences-House-CB8P32 (2020-07) | Revision o7

|Jane Doe | Date |3;w;zoz1 5:11 PM |

|Trar15-Siberiar1 Orchestra |

|Wizard5 In Winter (Instrumental} (Album VYersion) |

|The Lost Christmas Eve |

Save Cancel

The Sequence Information dialog

Audio Information

Waveform Only w

Spectrogram Low Res
Spectrogram Medium Res
Spectrogram High Res

If your license level is below Pro, then "Wawveform Only" will be your only choice here. With any
media file except MIDI, you will see a waveform displayed when the sequence is opened.

If you have a Pro license, you can also choose to see the audio as a spectrogram (see the Audio
Settings topic for examples). The spectrogram takes some extra time to calculate, so sequences
will take a little longer to load (the amount of time depends on the speed of your computer and the
length of the media file). For a 3 minute song on a fast computer, it should only add a few seconds
to the load time.

This setting also impacts the Audio motion effect. If you choose "Waweform Only", then many of the
options in the Audio effect will not work.

Created By

The creator of the sequence as specified in the New Animation dialog or the New Musical Sequence
dialog. This value cannot be edited.

Created At
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The date and time at which the sequence was created. This value cannot be edited.

Modified By

If you modify a file that was created by someone else, you can enter your name here, if you wish.

Music Artist

For musical sequences, the artist who performed the song.

Music Title

For musical sequences, the name of the song.

Music Album

For musical sequences, the name of the album that the song is from.

5.2.1.2.2 File References Dialog

Selecting "File References" from the Sequencer's Sequence menu opens a dialog that lists all files
referenced by the sequence. This includes the media file, the background image for the preview,
subsequences, and files used by motion effects (e.g. Movie and Picture effects).

Files that don't exist at the specified location are listed with a prefix of “*** missing ***". This is an
indication that the file reference should be fixed.

You can resize this window, if needed, so you can more easily view the information.
The media file can be fixed using the Media File item on the Sequence menu. The Preview Background

file can be fixed in Preview Design. Subsequence and motion effect references can be fixed using the
Change Directory and Change File commands described below.
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File References x
Sequence: ChUsers\Matt\DocumentsiLight-O-Rama'Sequences\ 2016\ Wizard sinWinter-201 6.l oredit
Media File: ChChristmas Display\MediaFiles\MP4'\Wizards in Winter_x264.mp4

Preview Background: CChristmas Display' 2014\ Pre-Christmas House Photos\combinedd.jpg

Files used by Select All Ch Direct
Subsequences L] Selec es TRy

Files used by : .
Motion Effects [ ] Select Al Change Directory Change File | | Where Used | | 53 Copy

M\Christmas Display'.2013\5equences' bw-guitar.gif

Close

The File References dialog

Change Directory

To specify a new location for one or more files, click the check box next to the filename(s), then
click the Change Directory button. You will be prompted for the new location. Note that this function
does not actually mowe the file(s), rather it updates the effects that reference those file(s). This can
be useful if you move your sequence directory, or open the sequence on a different computer.

Change File

In some cases, your file hasn't moved, but rather has changed names. In the screen shot abowe,
perhaps you edited "bw-guitar.gif' and the new version is "bw-guitar-2.gif". In that case, you will want
to select the check box select to the file name, then click the "Change File" button. This will prompt
you for the new file location (folder and file name).

Where Used

If you want to know where a file is used in the sequence, click the check box next to the file name,
then click the "Where Used" button. A pop up message will show where the file is first used (not
everywhere it is used). In the example below, "Raindrops.gif' is first used on the prop "candy cane2",
on motion effects row "Effects 01", starting at 42.30 seconds and continuing until 1 minute, 0.60
seconds.
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Where Used hod

Search result for file:
ChUsers\user\Picturesichristmas clipart\Raindrops. gif

First used at:

candy cane2: Effects 01
Time: 42,30 - 1:00,60

Copy

Clicking the "Copy" button will place a copy of the list of files used by motion effects onto the
clipboard, so you can then paste the information into another document.

5.2.1.2.3 Window s Shell Command Dialog

When a sequence is started, Light-O-Rama can optionally also execute an arbitrary Windows command,
running any program that you specify.

For example, some people broadcast the songs that play during their shows over radio, and would like
the name of the song to be broadcast along with it, using the RDS ("Radio Data System") protocol,
allowing people with RDS-enabled radios to see the name of the song that they are listening to. RDS is
not directly supported by Light-O-Rama, but you could set up your musical sequences so that,
whenever one of them is played, Light-O-Rama will tell Windows to tell your RDS program to broadcast
the name of the song for that sequence.

To set up a sequence to execute a Windows command, select "Windows Command" from the
Sequencer's Sequence menu. After that, whenewver that sequence is played by the Show Player, the
command will be executed. You can also choose whether the command is run when played in the
Sequencer.

Important notes:
¢ the command will not be executed if the sequence it is associated with is used as a subsequence
of another sequence.
e if the Show Player is running when you change the command associated with a sequence, you
may have to stop and start the Show Player in order for this change to be picked up.
e This feature is available only at the Advanced feature level and higher.

Topics:
e Control Whether Commands Are Run When Played in the Sequencer

e Reuse Existing Command
e Create New Command

Shell Command Variables
Sharing Sequences between Computers, and Security
Examples
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Windows Shell Command pd

r Command

Please enter the Windows shell cornmand that you want executed whenever this sequence runs.

() Mo command
(®) Existing Cormmand
cmnd /k echo testing123 v |qal (X

() Mew Cormmand

Please select the window style you want to use when the command is executed.

(") Hidden: The window is hidden, and the focus is passed to it

() Mormal, Focus: The window is displayed normally, and the focus is passed to it.

(® Minimized, Focus: The window is minimized, and the focus is passed to it.

() Maximized, Focus: The window is maximized, and the focus is passed to it.

() Mormal, Mo Focus: The window is displayed normally, but the focus is not passed to it.

() Minimized, Mo Focus: The window is minimized, but the focus is not passed to it

Help oK Cancel

The Windows Shell Command dialog

Control Whether Commands Are Run When Played in the Sequencer

The commands you enter on this screen will be run when the sequence is played by the Show Player.
Depending on your situation, you may or may not want these commands to run when they are played in
the Sequencer. You can control this behavior on the Sequencer Preferences Playback tab.

Reuse Existing Command

Select the "Existing Command" radio button and choose a command from the drop-down list to use a
command that was already set up for another sequence. Both sequences will run the same command
when they start.

e The =2/ button copies the selected existing command to the "new command" box so you can
use an existing command as the basis for a new one.

e The X button deletes the selected command. This will affect all sequences that use the same
command; so be very certain that the command is no longer needed before deleting it. If your
intent is that the current sequence no longer run a command, use the "No command" radio button
instead.
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Create New Command

Select the "New Command" radio button for creating an entirely new command, not used by any other
sequence. If your command is an executable file or batch file (EXE, .BAT, or .CMD extension), you can
use the "Select" button to select the desired file and the full path to the file will be placed in the new
command text box. Your command can also include special shell command variables as noted below.

Shell Command Variables

For the most part, a shell command will be executed exactly as you type it. You can, howewer,
additionally use certain variables, which will be replaced at run-time with various information, such as the
title of the song associated with the sequence. The following variables can be used (note: the exact
result of using any of the date/time "DT_" variables may depend upon your computer system, so try
them out if you need to rely upon an exact format):

|Variab|e ||Meaning |
|%% ||A single percent character ("%") |
|%DT_a% || Day of week, abbreviated ("Mon") |
|%DT_A% || Day of week ("Monday") |
|%DT_b% || Month name, abbreviated ("Aug") |
|%DT_B% || Month name ("August") |
|96DT_c% || Date and time (“Sunday, March 09, 2008 4:05:07 PM") |
|%DT_d% || Day of month (01 through 31) |
|%DT_H% || Hour, 24 hour clock (00 through 23) |
|%DT_I% ||Hour, 12 hour clock (01 through 12) |
|%DTJ% || Day of year (001 through 366) |
|%DT_m% || Month number (01 through 12) |
|%6DT_M% | Minute (00 through 59) |
|96DT_p% ||AM or PM |
l%6DT_S% || second (00 through 61) |
|%DT_W% || Day of week, number (0 through 6, Sunday being 0) |
96DT_x% || Date ("12/29/107) |
l96DT % || Time ("16:32:37") |
|%DT_y% ||Year, two digit ("10") |
|%6DT_Y% || Year, four digit ("2010") |
%ENV_something% The value of your computer's environment variable "something”; for
example, use %ENV_PATH% to get the value of your computer's
PATH environment variable
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%MEDIA_ALBUM% The name of the album that this sequence's media file is from (if set
in your sequence)

%MEDIA_ARTIST% The name of the artist that this sequence's media file is by (if set in
your sequence)

|%M EDIA_FILENAME% ||The name of the sequence's media file, without path information |
|%MEDIA_FILENAME_FULL% ||The name of the sequence's media file, with path information |

%MEDIA_FILENAME_NO_EXT% || The name of the sequence's media file, without path information
and without the file extension (such as ".mp3")

%MEDIA_TITLE% The name of the song that this sequence's media file is (if set in
your sequence)
|%SEQUENCE_AUTHOR% ||The author of this sequence (if set in your sequence) |

|%SEQUENCE_CREATED_AT% ||The date and time at which the sequence was created |
|%SEQUENCE_FILENAME% ||The name of the sequence file, without path information |

%SEQUENCE_FILENAME_FULL|| The name of the sequence file, with path information
%

% The name of the sequence file, without path information and without
SEQUENCE_FILENAME_NO_EX||the file extension (such as ".Ims")
T%

%SEQUENCE_MODIFIED_BY% || The name of the person who has modified the sequence (if set in

your sequence)

These variables were supported in prior versions, but are no longer supported in S5

Variable ” Meaning |

%DT_U% Week of year, with the first Sunday of the year starting week 01 (00
through 53)

%DT_W% Week of year, with the first Monday of the year starting week 01 (00
through 53)

l96DT_2% || Time zone ("EST) |

Sharing Sequences between Computers, and Security

The ability to execute an arbitrary Windows command is very powerful, and even potentially harmful - for
example, you could execute a command which will install spyware on your machine. Therefore, it would
not be wise to execute whatever Windows command another person chose, unless you are absolutely
sure that the command they chose is safe and harmless.

For this reason, Light-O-Rama imposes a security measure: The command to be executed is not stored
directly in the sequence file itself. Instead, the sequence file contains a key for an entry in another file
("cmdmap.lcm”, located in your Light-O-Rama sequences directory); that entry specifies the Windows
command to be executed. If that file doesn't contain an entry for that key, Light-O-Rama simply does
not execute any command when the sequence plays.
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So, you can use sequences created by other people without fear of spyware or other harmful programs,
as long as you continue to use your own version of cmdmap.lcm, not a copy of the other person's
cmdmap.lcm.

Howeer, this means that if you yourself use Light-O-Rama on two separate machines - for example one
to create your sequences on, and another to run your shows on - you will have to copy your "real"
version of cmdmap.lcm from one machine to the other if you want your sequences to execute Windows
shell commands. You would typically do this at the same time that you copy your sequences
themselves over from one machine to the other.

Examples

Update a File

The following command will write the media file name to a file called "NowPlaying.txt" in the your
Documents folder.

cnmd /c echo %EDI A_FI LENAMVE% > %AJSERPROFI LE% docunent s\ NowPl ayi ng. t xt

r Command

Please enter the Windows shell cornmand that you want executed whenever this sequence runs.
i) Mo command
() Existing Command

cmd /k echo testing123 23| (X

(® Mew Command
|cr'r'||:| fc echo %MEDIA_FILEMAMES: = SUSERPROFILEZS, documents\ MowPlaying.txt Select...

Let's break this command down:

e "cmd /c" starts a Windows shell command processor. The "/c" is an option that tells the
command processor to run the command that follows it and then terminate.

e "echo" is a command that outputs the text that follows it.

e "%MEDIA_FILENAME%" is one of the Light-O-Rama command variables noted above.

e ">" redirects the output to a file.

¢ "%USERPROFILE%\documents\NowPlaying.txt" is the name of the file where the output gets
written. "% USERPROFILE%" is a Windows environment variable that usually points to "C:
\Users\Your-Account-Name".

Call a Batch File

In this example, we will pass the media title, artist, and album to a batch file for further processing.
First, create a new batch file using Microsoft Notepad or a similar text editor. We suggest putting it
in your Documents folder with the file name "NowPlaying.bat". Here is the contents, which you can
copy/paste into your text editor. Feel free to modify it to suit your own needs.

rem Li ght-O Rama batch file exanple
rem
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rem This batch file accepts the nedia title, artist, and al bum as paranetersg

rem CGet the path to this file
set MyPat h=%-dp0

rem CGet the paraneters that were passed in

rem The til de renoves the doubl e-quotes surroundi ng the paraneter
set title=%1

set artist=%2

set al bun¥%-3

echo Now playing %itle%by %rtist%fromthe al bum %l bun > " %4/ Pat h% NowH

This batch file accepts 3 parameters, formats the output nicely, and then saves it to a text file called
"NowPlaying.txt" (located in the same folder as the batch file itself).

To create a command in the Sequencer that calls this batch file, follow these steps:

1. Click the "New Command" radio button

2. Click the "Select..." button

3. Once the Select File dialog opens, navigate to your batch file and select it, and then click the
"Open" button.

4. The name of the batch file is now displayed in the text box. Append the following text to it
(including the double-quotes):

"OVEDI A _TI TLE% "%VEDI A_ARTI ST% " %vEDI A_ALBUM®

r Command

Please enter the Windows shell command that you want executed whenever this sequence runs,

() Me command
( Existing Command
crmnd fk echo testing123 33 (X

® Mew Coemmand
|C:\Users&MattKDu:ucumEnts\NDWPIa}ring.hat "SEMEDIA_TITLESS" "2EMEDIA_ARTISTS:" "M

Select...

5.2.1.2.4 Manage Archived Props Dialog

Selecting "Manage Archived Props" from the Sequence menu opens a dialog where you can view all of

the archived props in a sequence.
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Archived Props et
[] Select All Select Props With No Effects
Prop # of Effects
[] DM 1.1 2
[ ] Mew RGE 1
[ ] RGE Tree 1
[] star30 0
[] Unit 1.3 ]
[] Unit 01.7 ]
[] UnitD1.8 ]
Checked [tems
Add.TD Move To Delete
Preview Beats
Total: 0 Total: 0 Total: 0
Save Cancel

Check the boxes next to the archived props you want to take action on. You can use the "Select All"
button to set or clear all of the boxes at once.

After you hawve selected the desired props, take action by clicking one of the 3 big buttons:

¢ "Mowe to preview" will convert the archived prop to a preview prop (i.e. it adds the prop to the
preview). The prop is no longer archived and its sequencing will appear during preview playback
and will control real lights.

¢ "Mowe to beats" will convert the archived prop to beat channels. While upgrading a sequence, a
beat channel in the legacy sequence could get archived because it does not exist in the preview.
This command will allow that issue to be corrected. This button is only enabled when working on a
musical sequence.

o "Delete" permanently remowves the selected archive props from the sequence. A legacy sequence
might contain channels that were no longer used and those channels would get archived because
they don't exist in the preview. There is no reason to keep such channels in an S5 sequence, so
this command gives you an efficient way to remove them.

After you are done, click "Sawe" to close the dialog and make the actions permanent, or click "Cancel"
to revoke the changes.

5.2.1.2.5 Manage RGB Aggregates Dialog

Selecting "Manage RGB Aggregates” from the Sequencer's Sequence menu opens a dialog where you
can view all of the RGB aggregates in a sequence. From this dialog you can:
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¢ Add a new RGB aggregate
¢ Modify an existing RGB aggregate

e Delete an RGB aggregate

RGE Aggregates ot
»
RGE Aggregate # of Effects
Hoop 2 154
Close

The Manage RGB Aggregates dialog

Add a new RGB aggregate

f

Clicking the "+" icon will open a dialog allowing you to create a new RGB aggregate.

e Enter the name for the new aggregate.

e Use the filter box to narrow done the list of channels to choose from.

¢ Click on a channel name that will occupy the red slot in the aggregate, then click the "Set
Red" button. The name of the selected channel will appear below the button.

¢ Click on a channel name that will occupy the green slot in the aggregate, then click the "Set
Green" button. The name of the selected channel will appear below the button.

¢ Click on a channel name that will occupy the blue slot in the aggregate, then click the "Set
Blue" button. The name of the selected channel will appear below the button.

¢ Click the "Create" button to create the aggregate.

It is not required to set all 3 slots. Setting only 1 or 2 of the slots is fine.
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Create RGB Aggregate et

Aggregate Mame: |

| 5elect a channel on the left, then click

A= |h|:n:|p| one of the channel buttons on the right

Hoop Blue2 ~

- Hoop Blue 3

- Hoop Blued <not selected>

- Hoop Blue s
- Hoop Blue b

- Hoop Blue7
- Hoop Blue 2 <not selected=
- Hoop Blue Lt
- Hoop Blue Rt
- Hoop Red 2 Set Blue
- Hoop Red 3

- Hoop Red 4

- Hoop Red 3 o

<not selected>

Create Cancel

Creating anew RGB Aggregate

Modify an existing RGB aggregate

.

4

Double-clicking on an RGB aggregate name (or clicking a name to select it then clicking the pencil
icon) will open a dialog allowing you modify the selected RGB aggregate. Here you can change the
name, or change the channels assigned to any of the 3 slots. To change the channel assigned to a
slot, use the same procedure described in creating an aggregate.
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Medify RGE Aggregate

Channel Mame: |HDDFI 2

Filter: | |

™ Bay Star It

- Bay Star rt

- Garage Star 2
- Garage Star 4
- Garage Star Lt
- (Garage Star Rt
- Garage Star Top
- Hoop Blue 2
- Hoop Blue 3
- Hoop Blue 4
- Hoop Blue s
- Hoop Blue b
- Hoop Blue 7

5elect a channel on the left, then click
one of the channel buttons on the right

Hoop Red 2

Hoop Wh 2

5et Blue

Hoop Blue 2

Modify Cancel

Modifying an RGB Aggregate

Delete an RGB aggregate

X

Click on an aggregate name to select it then click the red "X" icon to delete it. You can also use
Shift-click and Ctrl-click to select multiple items before clicking the delete icon.

5.2.1.2.6 Manage Picture Effects Dialog

Picture motion effects display an image on your prop. You can use the Manage Picture Effects dialog to
control where the image files used in the sequence's Picture motion effects are stored. Image files can
either be stored within the sequence file (embedded), or stored on your computer's hard drive (external).

From this dialog you can:

e Embed external files
e Extract embedded files

Embed External Files
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Pressing the "Embed external files" button will copy all files listed in the "External picture files"
section into the sequence file itself. This can make it easier to move your sequence from one
computer to another -- since the images are stored inside the sequence file ((LOREDIT extension),
the image files no longer need to be copied separately.

As part of this operation, the Picture effects in the sequence are updated to point to the new
embedded file location.

You can also specify a maximum height and width in order to reduce the size of the embedded
image. This helps keep the total size of your sequence file down. When scaling down your image,
the image's aspect ratio is maintained. So if the maximum height/width is set to 256 (the default)
and you embed an image that is 1000 pixels tall by 2000 pixels wide, then the embedded image will
be 128 pixels tall and 256 pixels wide (in this example the image is wider than it is tall, so the width
controlled the amount of scaling).

Here is an example from a sequence with 2 Picture motion effects:

Picture Effect Files >

These picture files are used by motion effects in the sequence

External picture files

Picture Mame

ChUsers\Matth Documents' Light-0-Ramat Sequences\Pictures\angel-nocross_22x44.png
ChUsers\Matth Documentst Light-0-Ramat Sequences\Pictures\24px -young-shepherd-hi.png

Maxirmum height/width when embedding 236

Embed External Files

Embedded pictures (stored in sequence file)

Picture Mame Width Height

Extract Embedded Files

Cloze

Prior to embedding

Pressing the "Embed external files" button will embed the files and then update the dialog to reflect
the new file location:
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Picture Effect Files
These picture files are used by motion effects in the sequence

External picture files

Picture Mame

Maxirmum height/width when embedding 236

Embed External Files

Embedded pictures (stored in sequence file)

Picture Mame Width Height

*angel-nocross_22x44*bb3238cd-93f2-4b2c-9cbd-0b2733c7T71 " png 22 44
*2dpx-young-shepherd-hi*30251f2b-b461-4c1 c-bae3- 14462f cdd 798, png 24 40

Extract Embedded Files

Cloze

After embedding

The picture names are appended with a series of letters and numbers in order to ensure each name
is unique.

Extract Embedded Files

Pressing the "Extract embedded files" button will mowve all files listed in the "Embedded pictures™
section onto your computer's disk drive. This can allow you to use those files in other applications.

The files are placed in a new sub-folder, below the folder where the sequence is stored. For example,
if your sequence file is "\Light-O-Rama\Sequences\MySequence.LOREDIT", then the image files will
be placed in a folder called "\Light-O-Rama\Sequences\MySequence-Pictures”.

As part of this operation, the Picture effects in the sequence are updated to point to the new file
location.

Here is an example from a sequence with 2 Picture motion effects:
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Picture Effect Files

These picture files are used by motion effects in the sequence

External picture files

Picture Mame

Maxirmum height/width when embedding 236 -

Embed External Files

Embedded pictures (stored in sequence file)

Picture Mame Width Height

*angel-nocross_22x44*bb3238cd-93f2-4b2c-9cbd-0b2733c7T71 " png 22 44
*2dpx-young-shepherd-hi*30251f2b-b461-4c1 c-bae3- 14462f cdd 798, png 24 40

Extract Embedded Files

Cloze

Before extracting

Pressing the "Extract embedded files" button will start the process. After the files are extracted, you
will get a confirmation message. If a problem was encountered during the extraction, then this
message will include some information about the error.

Extract Picture Files o

2 picture files written to
CihUsersiMatt\DocumentsiLight-O-RamaiSequences\Christmas

Story-2019-Pictures

After clicking "OK" to close the message, the dialog will be updated to reflect the new location for
the files.

© 2022 Light-O-Rama, Inc.



234 Light-O-Rama v6.1.0

Picture Effect Files x
These picture files are used by motion effects in the sequence

External picture files

Picture Mame
ChUsers\MatthDocumentsiLight-0-Rama\Sequences\ Christmas Story-2019-Picturesiangel-nocross_22x44.png
ChUsers\Matt\DocumentsiLight- O-Rama\Sequences\Christmas Story-2019-Pictures\24px -young-shepherd-hi.png

Maximum height/width when embedding 236

Embed External Files

Embedded pictures (stored in sequence file)

Picture Mame Width Height

Extract Embedded Files

Close

After Extracting

5.2.1.3 Tools Menu

The Light-O-Rama S5 Sequencer's Tools Menu gives you access to a set of functions that are unrelated
to a specific sequence.

e Motion Effect Generator
e Beat Wizard

e MIDI File Wizard

e Tapper Wizard

e VU Wizard

e Sequencer Preferences

e Keyboard Preferences
e Theme

e Zoom Preferences
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Tools | Window  Help
E': Motion Effect Generator

Beat Wizard

Tapper Wizard
VU Wizard

& Sequencer Preferences
] Keyboard Preferences
Theme

4 Zoom Preferences 3

The Tools Menu

Motion Effect Generator
This option on the Tools menu opens the Motion Effect Generator window.

¢ When no sequences are open, this menu item can be used to create motion effects and
optionally save the one’s you like as favorites. In the Motion Effect Generator, you can freely
switch the preview and prop down-down selections to see how your effect looks on any display
element. You can do this at any license level.

e When a sequence is open, this menu item can be used to place a motion effect into the
current grid selection See the Sequencing topic for more information on how to use the Motion

Effect Generator when editing your sequences. Placing motion effects in a sequence requires
the Pro license level.

Beat Wizard

This option on the Tools menu opens the beat-detecting audio wizard.

MIDI File Wizard

This option on the Tools menu opens the MIDI file audio wizard. This option is only enabled if the
sequence's media file is a MIDI file (.MID file extension).

Tapper Wizard

This option on the Tools menu opens the Tapper audio wizard.

VU Wizard

This option on the Tools menu opens the VU audio wizard.
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Sequencer Preferences

This option on the Tools menu opens the Sequencer Preferences dialog, which allows you to
customize some of the look and behavior of the S5 Sequencer..

Keyboard Preferences

This option on the Tools menu opens the Keyboard Preferences dialog, which allows you to
customize which keys trigger which actions. For example, you assign the key that creates a new
"on" effect.

Theme

This option on the Tools menu allows you to choose among several themes (color schemes) for
displaying the main window of the Light-O-Rama Sequencer

Zoom Preferences

This option on the Tools menu allows you to customize zoom preferences (default row height and
time scale width) for new sequences.

5.2.1.3.1 Sequencer Preferences

The Sequencer Preferences menu item on the Light-O-Rama S5 Sequencer's Tools menu opens a dialog
that allows you to customize the behavior of certain functions in the Sequencer. The dialog has several
tabs:

Tooltips

Playback
Motion Effects

Channel Effects
Previews

Save Copy
Video

Cursors

Start Up
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Sequencer Preferences

ips | Playback Motion Effects Channel Effects Previews Save Copy Videe Editing Start Up

Enable Tooltips

Seconds before opening: (0.2 =

Closing Tooltips

[ Secqnds before . 30 -
closing automatically:

® Manually close tooltips on mouseover

(0 Manually close tooltips on click

OK Cancel

The Sequencer Preferences Dialog

5.2.1.3.1.1 Tooltip Preferences

The "Tooltips" tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools menu.
From here you can control how tool-tips are displayed on the sequence grid.

e Enable tooltips

Seconds before opening

Seconds before closing automatically
Manually close tooltips on mouseover
Manually close tooltips on click
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Sequencer Preferences X

i Playback Motion Effects Channel Effects Previews Save Copy Video  Editing  Start Up

Enable Tooltips

Seconds before opening: (0.2 =

Closing Tooltips

[ Secqnds before . 30 =
closing automatically:

® Manually close tooltips on mouseover

(0 Manually close tooltips on click

OK Cancel

Sequencer Preferences - Tooltips Tab

Enable tooltips

If this box is checked, when the mouse is over a sequence grid, a tool-tip displaying information
about the cell being pointed to can be displayed.

Seconds before opening

If tool-tips are enabled, this text box controls how many seconds it will take before the tool-tip pops
up, when the mouse is kept still over a sequence grid.

You do not have to specify a whole number; for example, you can set it to six tenths of a second by
entering "0.6".

Seconds before closing automatically

If tool-tips are enabled, this checkbox and text box control whether or not they will automatically
close themselves a certain amount of time after being opened. If the checkbox is checked, they will
automatically close after the number of seconds specified in the text box.

You do not have to specify a whole number; for example, you can set it to three-quarters of a second
by entering "0.75".

Manually close tool-tips on mouseover
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If tool-tips are enabled, selecting this option will make them close when you roll your mouse over
them. The other option is to make them close when you click on them.

Manually close tool-tips on click

If tool-tips are enabled, selecting this option will make them close when you click on them. The
other option is to make them close when you roll your mouse over them.

5.2.1.3.1.2 Playback Preferences

The "Playback" tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools menu.
From here you can control:

e How color samples are displayed during playback
e How progress is indicated during playback
e Whether Windows Shell Commands are run during playback in the Sequencer

Sequencer Preferences X
Tooltips  Playback Motion Effects  Channel Effects  Previews Save Copy Video  Editing Start Up
Show a color sample during sequence playback to the right of the channel names.

Medium color sample ~

Indicate playback progress:

With a moving marker ~

Windows Shell Commands

(®) Run Windows Cormmands in the Sequencer and the Show Player

(0) Run Windows Cormmands in the Show Player only

0K Cancel

Sequencer Preferences - Playback Tab

Color Sample Preferences

This option controls the width of the color sample area (just to the right of the channel names, as
shown in the picture below). Choose "No color sample" to not display color samples at all.
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Playback Progress Preferences
This option controls how the playback marker is displayed. The options are:

e Use a moving marker - this mode displays a marker at the current playback location, regardless
of timing marks.

e Highlight the current column - this mode highlights the timing marks immediately before and
after the current playback location.

e Highlight the current timing mark - this mode highlights a timing mark as the current playback
position reaches it. When the playback position is between timing marks, nothing is highlighted.
This mode is useful for verifying that your timing marks match the music.

e Use a moving marker and highlight the current timing mark - this mode displays the moving
marker until it reaches a timing mark, at which point the timing mark is highlighted.

e Use a moving marker and highlight the current column - this mode is a combination of the
first 2 modes.

E3 Light-0-Rama S5 Sequencer v5.3.3 Pro - O X
Window  Help
s
) -| @ Fixed Gric: 0.10 - .é’
= | # ‘E]‘ Std Clipboard |Paste By Cel - | P B b b B @ ¢ Normal - ‘ & X K X» <»l-z 3 bk [-l B ‘
| | I Play | | I |

53617 joquog

P lEaHE &P oz |(Deue R |[Reaa|[0ms 4
D10 d DIE R “Ilﬂ'l

-0
w0

: 0:11 0:12
dyDd e

Track 1 L
1 02.15-Minitree C - I [T | I | P
3 02.16-Minitree D - [ | | | I |
Unit ID 03 | |
Unit ID 04 | |
Unit ID 06
= 07-Window 1 RGB
07-Window 2 RGB
{="07-Window 3 RGB! v
< > < >

sajdiuueg 10343

oO®EE®

= = =

Total Time: 20.35 | Playback Time: 7.08 - 12.08 | Playback Duration: 5.00 | Playing Visible Area

Playback in Progress

Windows Shell Command Preference
This option controls whether Windows shell commands are run in:

e the Sequencer and Show Player, or
e only in the Show Player.

5.2.1.3.1.3 Motion Effect Preferences

The "Motion Effects" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can control:

¢ How motion effects are displayed in the sequence grid
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Sequencer Preferences

Tooltips  Playback Motion Effects  Channel Effects  Previews Save Copy Video  Editing  Start Up
Grid Display
Motion effects on any particular row in the sequence grid alternate colors in order to show

where one effect stops and the next effect starts. The colors shown on the grid have
nothing to do with the colors that are used in the effect.

Grid colar 1z
Grid Colar 2:

Show the first 4 |etters in each effect's name on the grid

Meotion Row Order
® Foreground layer on top

() Foreground layer on bottom

OK Cancel

The Sequencer Preferences - Motion Effects Tab

How motion effects are displayed in the sequence grid

Motion Effect Row Colors

Motion effects on any particular row in the sequence grid alternate colors in order to show where one
effect stops and the next effect starts. The colors shown on the grid have nothing to do with the
colors that are used in the effect. Use "Grid color 1" and "Grid color 2" to set the 2 colors displayed
on the sequence grid for motion effect rows.

The pictures in the next section demonstrate what this actually looks like in the sequence grid.

Motion Effect Names

The first 4 letters of the effect's name can be displayed on the sequencer grid. This can help identify
the effect.

Here is an example with name display disabled. The only ways to identify an effect are to either 1)
double-click on the effect to open it in the Motion Effects Generator, or 2) single-click on the effect
and it will be displayed in the playback window (assuming the playback window is not hidden).
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Show All ltems o 'E: - m

A Souza Eave UR2Z: mO1
+  Souza RGE Star Mested
A Souza RGE Tree: mO1

Motion effects with naming disabled

Here is the same example with name display enabled. You can see that the first row contains a
series of Colorwash effects, the second contains Bars effects, and the third row contains Spiral

effects.
1:18 1:20
L T T (N SN TN (RN U [N T [ T TR Y (N TR N . N T [N SR T T B B |
Show All ltems v 'l m
8 Souza Eave Rz mo1 WIS TEEETEEE [SEETaER [EEE]
+  Souza RGE Star Mested arsBarspgarsBargBarsBar
. FirSrirgrirSrinSrirsSri
A 5Souza RGE Tree: mO1 Fir3rirBpirGpinGrirari
Motion effects with naming enable

Motion Effect Row Order

This option controls whether motion rows are listed foreground layer to background layer (first option)
or background layer to foreground layer (second option). This is explained further in the section about
layers.

5.2.1.3.1.4 Channel Effect Preferences

The "Channel Effects"” tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools
menu. From here you can control how channel effects are displayed on the sequence grid.
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Sequencer Preferences X

Tooltips  Playback Motion Effects | ¢ Previews Save Copy Video Cursors Start Up

View fades as ramps
[ Split RGE channels into red / green / blue (takes effect when a sequence is opened)

Background celor in the sequence grid:

Dark Light

0K Cancel

The Sequencer Preferences - Channel Effects Tab

Fades

When fade or intensity lighting effects are displayed in the Sequencer, they are displayed in one of
two ways: "as ramps" or "as colors". You can use the "View fades as ramps" check box to control
which is used.

When viewed "as colors", fades and intensities will be displayed as gradually varying shades
between light grey (which indicates that the channel is off, i.e. the intensity is zero) and the color
assigned to the channel (which indicates an intensity of 100%, i.e. full brightness).

When viewed "as ramps", they are instead displayed as partially filling in their cells with the color of
the channel, to a degree based upon the intensity.

Neither of these settings have any effect on the behavior of your actual lights; they only affect how
the Sequencer displays these lighting effects in the sequence grid.

J0 0:01 0:02
LT E -

Show All ltems
3 01.01-Roof A
3 01.02-Roof B
3 01.03-Roof C

A sequence with fades viewed using colors
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a0 0:01 0:02
LT E -

Show All tems
3 01.01-Roof A
3 01.02-Roof B

3 01.03-Roof C
The same sequence, with fades viewed as ramps

Split RGB Channels

The "Split RGB Channels" check box controls whether RGB channels are displayed with their red /
green / blue sub-channels or not. Turning this option off can save memory, allowing larger sequences
to be loaded. Note that this option is applied when a sequence is opened. Changing the option with
sequences already open will not change the way the open sequences are displayed. To view those
sequences with the new setting, close the sequences and then reopen them.

ﬂ';lﬂﬂ';HEHZ
RGE ~h -
= =2 =07-Window 1 RGB
Red
Green
Blue
= =07-Window 2 RGE
Red
Green
Blue
= 07-Window 3 RGE
= 07-Window 4 RGE
= 07-Window 5 RGE
= 07-Window 6 RGE
= 07-Window 7 RGE
= 07-Window & RGB

Split RGB Channels is enabled

RGE -t
= = 07-Window 1 RGE
= 07-Window 2 RGE
= 07-Window 3 RGE
= 07-Window 4 RGE
= 07-Window 5 RGE
= 07-Window & RGE
= 07-Window 7 RGE
= 07-Window & RGE

Split RGB Channels is disabled

Channel Background Color
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Regular channels and beat channels are displayed with a gray background on the sequence grid.
Howewer, you can control how light or dark you want the gray background to be. Use the slider to
control the lightness. A sample is shown to the right of the slider.

5.2.1.3.1.5 Preview Preferences

The "Previews" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can control:

e How preview background images are handled
e The screen drawing quality

Sequencer Preferences x

Tooltips  Playback Motion Effects  Channel Effects :

Editing Start Up

Background Image

() Stretch the image to fill the preview window

(® Maintain the image's aspect ratio, so it always looks like the original image

Bulb Drawing Cuality

() Good quality, best performance
i) Better quality, graphics card recommended (4x anti-alias)

(® Best quality, graphics card recommended (2x anti-alias)

oK Cancel

The Sequencer Preferences - Previews Tab

How preview background images are handled

This option determines whether the background image will be stretched to completely fill the
playback window, or whether the image's aspect ratio (the ratio of the width to the height) will be
maintained. Note that props are drawn in relation to the background image; so if you choose the
option where the aspect ratio is maintained, then it will also be maintained for the all of the props in
the preview. Maintaining the image's aspect ratio is highly recommended.

The screen drawing quality
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If you are running the Sequencer on a game-rated computer (one that has a graphics card), then the
Sequencer can take advantage of that hardware in Preview Design and while playing a sequence in
the playback window. This is a performance versus display quality trade-off. If you choose a higher
quality setting and then notice that playback lags, then you will want to return to this tab and choose
a lower quality setting.

Changing the drawing quality will not take effect until the next time the Sequencer is started.

Hexagon-shaped bulbs at the lowest quality setting (enlarged to show detail):

Hexagon-shaped bulbs at the highest quality setting (enlarged to show detail):

5.2.1.3.1.6 Save Copy Preferences

The "Save Copy" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can customize the behavior of the Save A Copy item on the File
menu. The available options are:

e Sawe A Copy During Reqgular Save
e Sawe A Copy Location
e File Name Suffix
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Sequencer Preferences X

Tooltips  Playback Motion Effects  Channel Effects  Previews SEVEC':'F'Y Video  Cursors Start Up

Options for File » Save A Copy  (which creates a backup copy of a sequence)
[] save a copy whenever the reqular Save command is used

Save A Copy - Location

(®) Save to folder where sequence is located

() Saveto a different folder

| Choose Folder...

Save A Copy - Text to append to the file name

() Custom Text - Copy

(O) Date and Time Y MMDD-HHMMSS

(® Prompt for name

0K Cancel

The Sequencer Preferences - Save Copy Tab

Save A Copy During Regular Save
If this box is checked, then ewvery time the user performs a regular Save operation it will be

automatically followed by a Save A Copy operation. If unchecked, then Save A Copy will only be
performed when the user selects it from the Eile menu.

Save A Copy Location

This option allows the user to specify the folder for Save A Copy operations.

File Name Suffix

This option allows you to customize the default suffix that is applied. Choosing the “Date and Time”
option is particularly useful for making multiple backup copies of your sequence.

If you enter custom text, you can only use characters that are valid in Windows file names. These
characters are forbidden: *. " /\[]:;|=,

5.2.1.3.1.7 Video Preferences

Musical sequences are associated with a song or other sound effect, from either an audio file (such as
an MP3) or a \video file (such as an AVI, WMV, or MP4 file). If a musical sequence is associated with a
video file, Light-O-Rama can display the video during play.
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The "Video" tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools menu and
can be used to control whether and how video is displayed during playback. It only controls playback
from the Sequencer. There is a similar setting in the Control Panel which determines how video playback
is performed during a show.

You hawe these options:
¢ Display Videos in a Window

e Display Videos in Full Screen Mode
e Use Audio Track Only When Sequencing With Video Media

Not all modes are supported at all license lewels. See the Eeature Comparison page for more
information.

Sequencer Preferences

Tooltips  Playback Motion Effects Channel Effects Previews Save Copy Editing Start Up

When sequencing with video media (e.g. AV], WMV, or MP4 files), how should the video be displayed?
Setting video playback for shows is done in the Contrel Panel,

While Sequencing

{®) Display videos in a window. You control the size and placement of the window.
() Display videos full screen, If you have multiple monitors, use the mode above to first place the window on the

desired monitor.

() Use audio track anly when sequencing with video media (no video display)

OK Cancel

The Sequencer Preferences - Video Tab

Display Videos in a Window

In this mode, video will be displayed in a window. You can move the window and resize it as needed.

Display Videos in Full Screen Mode

In this mode, video will be displayed full screen. If you have multiple monitors, first select the Display
Vidoes in a Window option. Play a sequence and position the video window on the desired monitor.
Stop playback. Go back into Video Preferences and change the option to Full Screen Mode.
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Use Audio Track Only When Sequencing With Video Media

In this mode, when a musical sequence with a video is played, only the audio track of the video will
be played. There will be no video window.

5.2.1.3.1.8 Editing Preferences

The "Editing" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can control the:

e Double-click method

e Cursor style when editing
e Drag effect edges default

Sequencer Preferences X

Tooltips  Playback Motion Effects Channel Effects  Previews Save Copy Video g} Start Up

Double-Click to Edit Edit Cursor Drag Effect Edges

(0 Double-clicking on an g:cisting @ Vellow Pencil [] Enable the "Drag Edges" tool
effect always opens a dialog ., when a sequence is opened
that allows you to modify the
effect, regardless of the chosen (7)) White Pencil x
"Select Action” on the toolbar.

) Up Arrow TT

{®) Use control-shift double-click to
modify existing effects, When
the "Select Action” is set to
Select, holding the Control and
Shift keys down is opticnal, The
sequence grid is slightly more

responsive in this mode versus
the first option.

0K Cancel

Sequencer Preferences - Editing Tab

Double-Click Method

You can double-click on any effect on the sequence grid in order to modify it. There are 2 choices for
making the double-click:

¢ Double-click with no extra keys. This is the easiest to use and the easiest to remember.

o Ctrl-Shift double-click. This requires holding the Ctrl and Shift keys down when you double-click.
This is obviously a little more work, but the program is slightly more responsive in this mode. It
should only be needed by users who do a lot of clicking very quickly.
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When using the first option, make sure the "mouse double-click speed" value is set properly in Windows
(you don't want it too slow). In Windows 10, open the Mouse Settings screen, then click on "Additional

mouse options".

Settings

i Home

Find a setting

Devices

Bluetooth & other devices
=&y Printers & scanners

(1 Mouse

Typing

&~ Pen & Windows Ink

() AutoPlay

f use

B

Mouse

Scroll inactive windows when | hover over them

@ on

Related settings

Adjust mouse & cursor size

Additional mouse options

Help from the web

Troubleshooting my mouse

@ Get help

& Give feedback

Windows 10 Mouse Settings
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== Mouse Properties >

Buttons  Pointers Pointer Options  Wheel  Hardware

Button configuration
[ ] Switch primary and secondarny buttons

Select this check box to make the button on the
right the one you use for primary functions such
as selecting and dragging.

Doubleclick speed

Doubleclick the folderto test your setting. i the
folder does not open or close, try using a slower
setting.

Speed:  Slow : ' Fast

Click Lock
[]Tum on Click Lock Seftings...

Enables you to highlight or drag without holding down the mouse
button. To set, briefly press the mouse button. To release, click the
mouse button again.

Corcad | [ owl

The double-click speed setting

Cursor Style When Editing
From here you can customize the cursor that is displayed when:

e drawing light strings in Preview Design
¢ creating effects in the sequence grid -- when the toolbar "Select Action” is anything other than
Select.

You have your choice of:

e Yellow pencil (default). Some users say the black tip of the pencil makes the exact location of the
cursor hard to determine. Therefore, you can also choose...

e White pencil, or

e Up Arrow. This cursor is built into Windows. So if you have custom cursors loaded onto your
system, the arrow may look slightly different than what is shown in the dialog.

The intent is that the Sequencer uses the default Windows arrow cursor for selection and a different
cursor when drawing.

Drag Effect Edges Default
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This option allows the Drag Effect Edges tool to be enabled by default when a sequence is opened.

5.2.1.3.1.9 Start Up Preferences

The "Start Up" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama Sequencer's
Tools menu. From here you can control:

e Whether Control Lights is automatically enabled if the Control Panel is already running when the
Sequencer is started.

¢ Normally, when the Sequencer starts, it will restore the various windows to their last location.
However, for some users with multiple monitors the Sequencer refuses to startup in that case.
Deleting the file "\Light-O-Rama\LORInternal\sequencerlayout.xml" will allow the Sequencer to
reopen. If this issue happens repeatedly, check the "Use default window arrangement at startup"
button. If the box is checked, the Sequencer will no longer restore windows to their last location.

e The paste mode that is selected when a sequence is opened.

e The maximum number files to display on the Start Page.

Sequencer Preferences

Tooltips  Playback Motion Effects  Channel Effects  Previews Save Copy Video  Editing

When the Sequencer starts, enable Contrel Lights if the Light-0-Rama Contrel Panel is running

[] Use default window arrangement at startup

Default paste mode:
Paste By Cell v

Maximum number of files to display on the Start Page:
30 =

*

oK Cancel

The Sequencer Preferences - Start Up Tab

5.2.1.3.2 Keyboard Preferences

The Keyboard Preferences menu item on the Light-O-Rama S5 Sequencer's Tools menu opens a dialog
that allows you to customize the actions that take place when you type a key on your keyboard. The
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built-in (default) mapping of keys to actions is listed in the Keyboard Shortcut Summary. Here are some
examples where you might want to use this dialog to create a customized keyboard mapping:

e There might be some keys in the default mapping that don't seem intuitive to you.

¢ You frequently use a program that uses different keys to mowe and take action and you want the
Sequencer to follow a similar behavior when those keys are struck.

¢ You want to make a single key perform multiple functions - for example, you could set up the "N"
key to expand the selection to the right by three cells and down by two cells, and then turn the
entire (newly expanded) selection on.

Keyboard Preferences | >
Active Keyboard Map Maps Keys

(®) Use the default keyboard map Duplicate Map

() Use a customn keyboard map: New Empty Map

My Custom Mapping

Ctrl Alt Shift Key Op Count  First Operation G
Enter 1 Apply Current Tool
Space 1 Playback Start Stop
Shift Space 2 Clear Freeform Range
PageUp 1 Move Page Up
Ctrl Pagellp 1 Move Page Up
Alt Pagellp 1 Zoom Rows Out Fully
Shift Pagelp 1 Expand Page Up

=3 Copy Print oK

The Keyboard Preferences dialog

This dialog is resizable. In particular, you can make it taller so that you can see more key mappings at a
time.

The Keyboard Preferences dialog has several sections:

e The "Active Keyboard Map" section allows you to choose what set of keyboard operations should
be used.

e The "Maps" section allows you to define new sets of keyboard operations, or to delete existing
sets.

e The "Keys" section allows you to define what keys should perform what operations in the currently
active set of keyboard operations.

e Under that is displayed a list all keys in the current set of keyboard operations, and the operations
that they perform. Click on a column heading to sort the list by that column. Double-click on a row
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to edit that entry. Only entries for custom maps are editable; howewer, you can double click on
entries for the default mapping and see a read-only view of that map entry.
¢ Buttons at the bottom allow you to copy the list to the clipboard or to print the list.

Active Keyboard Map

The "Active Keyboard Map" section allows you to choose which keyboard map should currently be

used. You can choose to use the default keyboard map for the current version of software, or to use
a custom keyboard map that you have defined.

Use the Default Keyboard Map

Choosing this option will cause the Sequencer to use its default keyboard map. Moreower, if you
hawve this option selected, and later upgrade to a new version of software which has a different default
keyboard map, the Sequencer will then use that new default keyboard map.

Use a Custom Keyboard Map

Choosing this option will cause the Sequencer to use a keyboard map that you yourself have
defined. Moreower, if you have this option selected, and later upgrade to a new version of software
which has a different default keyboard map, the Sequencer will then continue to use the custom map
that you have selected.

Your custom keyboard maps are automatically saved to your Light-O-Rama data directory, in the
"CommonData\CustomKeyMaps.xml" file. If you would like to share your custom maps with another
user, you can simply give them a copy of your "CustomKeyMaps.xml" file. When they place it into
their own "CommonData" directory, it will be available for them as a custom keyboard map.

Note that this option is not available until you have defined at least one custom keyboard map, which
you can do through either "Duplicate Map" or "New Empty Map".

Maps

The "Maps" section allows you to create new custom keyboard maps (either duplicating the current
map or else creating an empty map), or to remove maps that you have previously created.

Duplicate Map

Using this button, you can create a new custom keyboard map which uses the exact same key
mappings as the currently selected map does. You can then modify the key mappings as you

desire, using "New Key", "Edit Key", or "Remove Key".

The new map will show up in the drop-down list under "Use a Custom Keyboard Map", and in fact
will automatically be selected when you create it.

New Empty Map
Using this button, you can create a new custom keyboard map which does not contain any key

mappings at all - that is, no key will cause anything to happen when you press it. You can then add
keys to it via "New Key", and later edit or remove them via "Edit Key" or "Remove Key".
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The new map will show up in the drop-down list under "Use a Custom Keyboard Map", and in fact
will automatically be selected when you create it.

Remove Map

If you have currently selected a custom keyboard map (Ma "Use a Custom Keyboard Map"), pressing
this key will delete the map.

Note that if there is a chance that you will want to use the custom keyboard map again in the future,
you should not remowe it. Instead, simply switch to using a different custom map, or to a default
map, leaving the map in the "Use a Custom Keyboard Map" list, thus enabling you to switch back to
it when you desire. If you remowe it, you will not be able to switch back to it in the future.

Keys

If you have specified that a custom keyboard map should be used (va "Use a Custom Keyboard
Map"), then the "Keys" section allows you to add new keys to it, edit existing keys within it, and
remove existing keys from it.

New Key

This button (which is available only when a custom keyboard map has been selected, via "Use a
Custom Keyboard Map™) opens up the New Key Mapping dialog, which allows you to choose a key
and set its operation or operations:

Mew Key Mapping >
Key

Press the key that you want to create the mapping for
(you can also hold down the Alt, Ctrl, and Shift keys):

Operations

5P Add Row € Delete Checked Rows

O Apply Chase w

Cancel

The New Key Mapping dialog
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To use the New Key Mapping dialog, press the key that you want to use (and, if you want, the Alt,
Ctrl, and/or Shift keys), and then select the operation that you want it to perform from the dropdown
list:

Mew Key Mapping et

Key

Press the key that you want to create the mapping for
(you can also hold down the Alt, Ctrl, and Shift keys):

|(A|t-5hiﬁ) F7 key

Operations

5F Add Row 3 Delete Checked Rows

Ll Move Right R

QK Cancel

The New Key Mapping dialog, having selected akey and an
operation

In the above example, Alt-Shift-F7 has been mapped to "Mowve Right" - that is, to move the selection
to the right one cell.

You can use the "Add Row" button to assign multiple operations to a single key. They will be
executed in the order that you list them. In the following example, Alt-Shift-F7 has been mapped to
"Mowe Right, Move Down, Apply Shimmer". That is, the selection will be moved one square to the
right, then one square down, and then the Shimmer effect will be applied to the new selection.
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Mew Key Mapping et
Key

Press the key that you want to create the mapping for
(you can also hold down the Alt, Ctrl, and Shift keys):

|(A|t-5hiﬁ) F7 key

Operations

5F Add Row 3 Delete Checked Rows

[ Mawe Right o

[ Mawe Down w

[ Bpply Shimmer P
OK Cancel

The New Key Mapping dialog, having selected a key and multiple
operations

To remowve operations, click the check box next to each operation you want to delete, then click the
"Delete Checked Rows" button.

Edit Key

This button allows you to change the operation or operations that are in use for a certain key. 1t is
available only when a custom keyboard map has been selected (va "Use a Custom Keyboard Map")
and a particular key mapping from that map has been selected (by clicking on it in the list of key
mappings at the bottom of the Keyboard Preferences dialoq).

Pressing the button (or double-clicking on a row) brings up the Edit Key Mapping dialog:
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Edit Key Mapping

Key

Press the key that you want to create the mapping for
(you can also hold down the Alt, Ctrl, and Shift keys):

e ciey

Operations

5F Add Row 3 Delete Checked Rows

L] Copy

QK Cancel

The Edit Key Mapping dialog

The Edit Key Mapping dialog can be used similarly to the New Key Mapping dialog.

Remove Key

This button allows you to remowe a certain key from the current keyboard map. It is available only
when a custom keyboard map has been selected (via "Use a Custom Keyboard Map") and a
particular key mapping from that map has been selected (by clicking on it in the list of key mappings

at the bottom of the Keyboard Preferences dialog).

Sorting the List

To sort the list of displayed key map entries, simply on a column heading. This sorting applies not
only to the list as displayed on the screen, but also to the results of the Copy and Print buttons.

Copy

This button allows you to copy the list of keys and operations to your Windows text clipboard, so
that you could (for example) paste it into a text document in Notepad. The list will be sorted as you

specified in the "Sort By" section.

Print

This button allows you to print the list of keys and operations. The list will be sorted as you

specified in the "Sort By" section.
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Operations

The following operations can be assigned to keys in a custom keyboard map:

Operation

Description

Apply Chase

Apply the Chase tool to the current selection

Apply Chase Custom

Prompt the user for custom options and then apply the Chase tool to the
current selection

Apply Current Tool

Apply the current tool to the current selection

Apply Fade Down

Insert the current effect into the selection as a Fade Down.

Apply Fade Up

Insert the current effect into the selection as a Fade Up.

Apply Fill

Apply the Fill tool to the current selection

Apply Intelligent Fade

Create a fade up if the selection was created in a left to right direction;
otherwise create a fade down. Effects are create using the current effect
and intensity range shown on the tool bar.

Apply Maximum

Insert the current effect into the selection at maximum intensity

Apply Minimum Insert the current effect into the selection at minimum intensity
Apply Off Delete any effects in the current selection
Apply On Turn the current selection on using the Intensity effect.

Apply Shimmer

Apply the Shimmer effect to the current selection

Apply Superstar

Apply the SuperStar tool to the current selection

Apply Toggle

Apply the Toggle tool to the current selection

Apply Twinkle

Apply the Twinkle effect to the current selection when not playing back.
Insert a timing mark when playback is running.

Audio Beats Wizard

Opens the Beat Wizard

Audio MIDI Wizard

Opens the MIDI Wizard (only valid if the audio file is in MIDI format

Audio Tapper Wizard

Opens the Tapper Wizard

Audio VU Wizard

Opens the VU Wizard

Clear Freeform Range

Clear the freeform play range (if one exists)

Copy Copy the effects from the current selection

Copy Timing Copy the timings from the current selection

Cut Cut the effects from the current selection

Expand All Expands the selection to encompass the entire grid

Expand Column

Expands the selection to encompass the entire column

Expand Down

Expand the current selection down one channel
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Operation

Description

Expand Effect

Select the entire effect

Expand End

Expand the current selection to the last cell in the sequence.

Expand Left

Expand the current selection left one cell

Expand Page Down

Expand the current selection down one screen

Expand Page Left

Expand the current selection left one page

Expand Page Right

Expand the current selection right one page

Expand Page Up

Expand the current selection up one screen

Expand Right

Expand the current selection right one cell

Expand Row

Expands the selection to encompass the entire row

Expand Start

Expand the current selection to the first cell in the sequence.

Expand Up Expand the current selection up one channel
File Close Closes the current sequence
File Close All Closes all open sequences

File Export Legacy

Exports the current sequence in legacy (LMS/LAS) format

File New Animation

Starts a new animation sequence

File New Musical

Starts a new musical sequence

File Open Starts the file open dialog

File Save Sawves the current sequence

File Save As Sawves the current sequence under a new name
File Save Copy Makes a backup copy of the current sequence
Help Open the help file

Modify Effect Apply the current effect to the current selection

Modify FadeDown

Applies a fade down intensity profile over the current selection

Modify FadeUp

Applies a fade up intensity profile over the current selection

Motion Effect

Opens the Motion Effect Generator

Generator

Move Down Mowe the current selection down one channel. During sequence playback,
this will mark the current time as the start of a freeform play range.

Move End Mowe the current selection to the last cell in the sequence.

Mowe Left Mowe the current selection left one cell

Move Page Down

Move the current selection down one screen

Mowve Page Left

Mowe the current selection left one screen
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Operation

Description

Mowve Page Right

Move the current selection right one screen

Mowve Page Up Move the current selection up one screen

Mowe Right Mowe the current selection right one cell

Mowe Start Mowe the current selection to the first cell in the sequence.

Move Up Movwe the current selection up one channel. During sequence playback, this
will mark the current time as the end of a freeform play range.

Paste Paste from the current clipboard to the current selection

Paste Special

Paste clipboard contents using the Paste Special dialog

Paste Timing

Paste timings to the current selection

Playback Start Pause

Starts playback. If playback is already going, then playback is paused.

Playback Start Stop

Start/stop playback. Uses the freeform play range if one is defined.

Playback Stop

Stops playback

Prompt Effect
FadeDown

Prompts for a new effect and inserts it into the current selection as a fade
down

Prompt Effect FadeUp

Prompts for a new effect and inserts it into the current selection as a fade
up

Prompt Effect
Maximum

Prompts for a new effect and inserts it into the current selection at
maximum intensity

Prompt Effect
Minimum

Prompts for a new effect and inserts it into the current selection at
minimum intensity

Prompt Effect Modify

Prompts for a new effect and applies it to existing effects in the current
selection

Redo

Redo the last operation that was undone

Repeat

Apply the Repeat tool

Select Change
Intensity

Make the Change Intensity tool be the current tool

Select Channel Effect

Make channel effects active

Select Chase

Make the Chase tool be the current tool

Select Color Fade

Make the Color Fade tool be the current tool

Select Create

Make the Create tool be the current tool

Select DMX Intensity

Make DMX Intensity the current effect

Select Fade Down

Make the Fade Down the current slope

Select Fade Up

Make the Fade Up the current slope

Select Fill

Make the Fill tool be the current tool

Select Intelligent Fade

Make the Intelligent Fade tool be the current tool
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Operation

Description

Select Intensity

Make Intensity the current effect

Select Maximum

Make the maximum the current slope

Select Minimum

Make the minimum the current slope

Select Motion Effect

Make Motion Effects effects active

Select Select

Make the Select tool be the current tool

Select Shimmer

Make shimmer the current effect

Select Superstar
Effect

Make SuperStar effects active

Select Toggle

Make the Toggle tool be the current tool

Select Twinkle

Make twinkle the current effect

Sequencer
Preferences

Opens the Sequencer Preferences dialog

Toggle Drag Edges

Toggles "drag edges" mode

Toggle Play Loops

Toggle looping playback

Toggle Playback
Window

Toggles visibility of the playback window

Toggle View Fades

Toggle viewing fades as ramps

As Ramps

Tooltip Open up a tooltip appropriate to where the mouse cursor is currently
pointing on the sequence grid

Undo Undo the last operation

Zoom Rows In

Zoom in on rows (channels)

Zoom Rows In Fully

Zoom in on rows (channels) as far as possible

Zoom Rows Out

Zoom out on rows (channels)

Zoom Rows Out Fully

Zoom out on rows (channels) as far as possible

Zoom Time In

Zoom in on time (columns)

Zoom Time In Fully

Zoom in on time (columns) as far as possible

Zoom Time Out

Zoom out on time (columns)

Zoom Time Out Fully

Zoom out on time (columns) as far as possible

5.2.1.3.3 Themes

The Themes menu item on the Light-O-Rama S5 Sequencer's Tools menu opens a dialog that allows you
to select a color scheme for the main Sequencer window.
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5et Theme ot

Mew theme (color scheme):

light v

QK Cancel

Theme Selection Dialog

There are 3 themes to choose from:
e Light

ar

lu

O
=

o
D

After selecting a theme, the Sequencer will need to be restarted in order for the new theme to take effect.

Light Theme
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5.2.1.3.4 Zoom Preferences

When a sequence is displayed in the Sequencer, it is represented as a grid. You can zoom in or out of

the grid in either the horizontal and vertical direction at any time. See the Scrolling and Zooming topic for
more information.

Whenewver save your sequence the zoom lewel is saved too. And when you re-open that sequence, the
zoom level will be restored. However, whenewer the Sequencer creates a new sequence, it will use some
default zoom level settings. If you prefer some particular zoom level, you probably do not want to zoom
in or out every time that you create a sequence. So, the Zoom Preferences sub-menu (of the Tools
menu) allows you to save your current zoom level settings as defaults, by selecting "Save Zoom
Preferences".

Later, when you create a new sequence, it will default to the zoom lewel settings that you had saved.

If you change the zoom level on a sequence and want to get back to your saved default zoom level
settings, the Zoom Preferences sub-menu also provides a way to do this: by selecting "Apply Saved
Preferences".

There is also a system default zoom level, and selecting "Apply System Defaults” will apply that to the
active sequence.

[Ty

|, Zoom Preferences » Save Zoom Preferences
Apply Saved Preferences
Apply System Defaults

Zoom Preferences Sub-menu

5.2.1.4 Window Menu

The Window menu of the Light-O-Rama Sequencer enables you to hide or show certain Sequencer
windows on your screen. Most importantly, it allows you to reset the position of all windows to their
default locations.

The following menu items are available:

e View Start Page

e View Playback Window

e View Previews Window

e View Control Lights Window
o View Effect Samples Window
e View Audio Settings Window
e Float Current Window

e Reset Window Layout
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Window | Help
View Start Page
View Playback Window
View Previews Window
View Control Lights Window
View Effect Sarnples Window
View Audio Settings Window

Reset Window Layout

View Start Page

Selecting this option on the Window menu unhides the Start Page. This menu item is only shown if
the Start Page is currently hidden.

View Playback Window

Selecting this option on the Window menu unhides the Playback window. This menu item is only
shown if the Playback window is currently hidden.

View Previews Window

Selecting this option on the Window menu unhides the Preview Management window. This menu
item is only shown if the Preview Management window is currently hidden.

View Control Lights Window

Selecting this option on the Window menu unhides the Control Lights window. This menu item is
only shown if the Control Lights window is currently hidden.

View Effect Samples Window

Selecting this option on the Window menu unhides the Effect Samples window. This menu item is
only shown if the Effect Samples window is currently hidden.

View Audio Settings Window

Selecting this option on the Window menu unhides the Audio Settings window. This menu item is
only shown if the Audio Settings window is currently hidden.

Float Current Window

This option on the Window menu floats the current window so that it can be moved and sized
independently of the main Sequencer window. If you have multiple display monitors, you can mowe a
floating window to a separate monitor. Only the Start Page, Playback, Preview, Motion Effects,
Control Lights, Effect Samples, and Audio Settings windows can float. Sequence windows cannot
float.
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Reset Window Layout

This option on the Window menu resets the position of all windows to their default locations, as
shown below.

Version

Number

3 Light-0-Rama 55 Sequencer v5.5.19 Pro .
Preview

Management
Window
(unpinned)

File Tools Window Help

Mo Motion Effect Selected

NN N N NERE &, @ | o LD

SABIAR |

Playback
Window
{pinned)

Control
Lights
Window
{unpinned)

ayi [oueD

Effect
Samples
Window

(unpinned)

Tabs provide
access to the

Start Page @ How Do | Get Started?
and all open

sajduieg 39947

FEL AT * 02 - Music Box Dancer (Radi...

sBups oipny

sequences Start A New Sequence Audio
Settings
Start Page Mew Musical Sequence Window

provides links

to create new Q Mew Animation Sequence

sequences or Light bulb is
open ones yellow when
that were Recent Sequences “Control

- i) 7 i
accessed C:\Users\Matt\Documents)Light-0-Rama\ Sequences\Samples\LOR 5.6.0 Motion Effects.loredit Lights” is
recently ) enabled

{unpinned)

5.2.1.5 Help Menu

The Help menu of the Light-O-Rama Sequencer brings up help and other information about Light-O-
Rama.

The following options are available on the Help menu:

Contents

Index

Search

Shortcut Keys

Visit Light-O-Rama on the Web
About the Light-O-Rama Editor
Regqister or Upgrade Light-O-Rama
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Help
Contents
Index
Search

1 Shortcut Keys

Y Visit Light-O-Rama on the Web
About the Light-0-Rama Sequencer
Register or Upgrade Light-0O-Rama

Contents
This option on the Help menu opens up the main Sequencer topic in the Light-O-Rama help file.
It has a keyboard hotkey: F1

Index
This option on the Help menu opens up the index of the Light-O-Rama help file.

Search

This option on the Help menu opens up the search menu of the Light-O-Rama help file.

Shortcut Keys

This option on the Help menu opens up the Keyboard Shortcut Summary in the Light-O-Rama help
file.

Visit Light-O-Rama on the Web
This option on the Help menu opens the Light-O-Rama website in your web browser.

About the Light-O-Rama Editor

This option on the Help menu brings up the Sequencer's About box, which displays some
information about the program and your computer.

Register or Upgrade Light-O-Rama

Use this item on the Help menu to register your Light-O-Rama software, or to upgrade to a higher
level license, unlocking various features.

5.2.1.5.1 About

Selecting "About" from the Light-O-Rama Sequencer's Help menu displays the version of the Sequencer
that you are running, your Light-O-Rama license information, and information about your computer. When
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contacting Light-O-Rama for help with the Sequencer, being ready with the information displayed in the
“About” window can assist in getting your problem resolved faster.

If you create a ticket with the Light-O-Rama Help Desk, you can use the "Copy to Clipboard" button to
copy the information shown in the window so that your can paste it into your ticket. This will assist in
getting your issue resolved faster.

About Sequencer >

Light--Rama
-—s

Light-0-Rama 55 Sequencer (32-bit], Version 5.1.3
Pro Edition

Copyright 2016-2018 Light-0-Rama, Inc.
Registered to: Matt Brown

Microsoft Windows 10 Pro 84-bit
AMD Ryzen 71700 Eight-Core Processor
MVIDIA GeForce GTX 1050
OpenGL version: 4.6.0 NVIDIA 358,82

=2 Copy to Clipboard Close

The S5 Sequencer's About Box

5.2.2 Start Page

The Start Page provides you with some useful links to help you get started quickly. The Start Page can
be docked in any location, floated, or hidden. If you don't see the Start Page, you can make it \visible by
selecting Window > View Start Page from the main menu.
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Start Page X

|\_,) How Do | Get Started?

Start A New Sequence

Mew Musical Sequence

Mew Animation Sequence

Recent Sequences Clean Up

ChUsersyMatth DocumentshLight-0-Rama\Sequencesh Samplesi| OF 5.6.0 Motion Effects.loredit

ChUsersyMatth Documentsh Light-0-Rama'\Sequencesh Samplesi L OR 5.4.0 Motion Effects.loredit

The Start Page

How Do | Get Started?

If you are new to the Light-O-Rama software, click the "How Do | Get Started?" link. It will open the
help file where you can learn what a sequence is, and then start learning how to use the Sequencer.

Start A New Sequence

In the second section, you can click the links to quickly start a new animation or musical sequence.

Recent Sequences

At the bottom of the page is a list of sequences that have been recently viewed. Click on a link to
open the sequence. The recent sequences shown on the Start Page are the same ones listed on the
File > Recent Files sub-menu, plus more (if you work with a lot of sequences).

You can control the number of recent sequences shown on the Start Page by going to Startup tab of
Sequencer Preferences.

Cleanup

Sometimes you have sequences on the Recent Sequences list that you no longer use. You can
remove these entries by clicking the "Clean Up" button.
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Clean Up Recently Used File List

Check the tems to be rermnoved from the list

[] ChlUsers\MattDocumentshLight-0-Ramat\Sequencest Samples\ LOR 3.6.0 Motion Effects.loredit
[] ChAlUsers\MattDocumentshLight-0-Ramat\Sequencest Samples\ LOR 5.4.0 Motion Effects.loredit

Cancel

The Clean Up Dialog

The Clean Up dialog will list all of the files shown under Recent Sequences. Simply check the boxes
next to the files you want removed from the list, then click OK.

52.3 Previews Window

A preview is a representation of your light display. It defines the lighting elements, how they are
arranged, and what channels they use. From the "Previews" window you can create, modify, delete, and
import/export previews. The "Previews" window is normally docked on the right side of the main Light-O-
Rama S5 Sequencer. To keep the window open, click the pin icon in the upper right corner of the
window.

e Add a New Preview

¢ Modify an Existing Preview

e Delete a Preview

e Copy a Preview

e Import or Export a Preview

¢ Right-Click on a Preview Name
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Previews A X F-?
F —_ %'

+ /7 XSS @
Christrmas 2018 e
Christrnas 2019 S
Default S
Halloween 2018 =
Halloween 2019 =
F

&

3

=

Add a New Preview

-

Click the "+" icon to start a new preview. This will open an empty Preview Design window ready for
you to create a preview from scratch.

Modify an Existing Preview

-

4

Click on a preview name and then click the pencil icon. This will open a Preview Design window with
the selected preview loaded.

N

Alternatively, you can double-click on a preview name to edit it.

B

Alternatively, you can right-click on a preview name and select "Modify" from the pop-up menu.

© 2022 Light-O-Rama, Inc.



The Light-O-Rama Software Package 273

Delete a Preview

X

Click on a preview name and then click the red “X’ button. You will be prompted to confirm that you
want to proceed with the deletion. Click “Yes” to delete or click “No” to cancel. If after deleting it you
find that you want to get it back, assuming you have a sequence associated with that preview you
can just open that sequence and the preview will be imported from it.

49

Alternatively, you can right-click on a preview name and select "Delete" from the pop-up menu.

Copy a Preview

-

H #

Lt

Click on a preview name and then click the “Copy” button. You will be prompted for the name of the
new preview. If you keep a copy of a preview for each year of your display (recommended), then this
is the command you should use to copy one year's preview to the next (e.g. 2018 to 2019).

(49

Alternatively, you can right-click on a preview name and select "Copy" from the pop-up menu.

Import or Export a Preview
K ML
Irmport Visualizer File

s
F
Z

Import SE Animation
Export Preview

Import Preview

The Import/Export menu
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Click the Import icon to open a menu that allows you to:

e Import a Visualizer (LEE) file. You will prompted to select an LEE file and it will then be
imported into a new preview. During the import process, Visualizer fixtures will be converted to
props, and Visualizer props will be imported as preview groups.

¢ Import a Sequence Editor Animation. You will be prompted to select the LMS or LAS
sequence file that contains the animation.

e Export an S5 preview. You will be prompted for the file name. This creates a file with an
LORPREYV extension. You can also perform this action by right-clicking on a preview name
and selecting "Export" from the pop-up menu.

¢ Import an S5 preview. You will prompted to a select a file with an LORPREV extension.

Right-Click on a Preview Name

Previews E
P i
e 4ISIPIONE
Christmas 2017
De Modify
Hs Delete
H: Copy
Export
Mew Musical Sequence
Mew Animation Sequence

The right-click menu
Right-click on a preview name to open a menu that allows you to:

¢ Modify the selected preview in a Preview Design window.

¢ Delete the selected preview. You will be prompted to confirm that you want to proceed with the
deletion.

e Copy the selected preview. You will be prompted for the name of the new preview.

e Export the selected preview. You will be prompted for the file name. This creates a file with an
LORPREYV extension.

¢ Create a new musical sequence using the selected preview.

¢ Create a new animation sequence using the selected preview.

5.2.4 Preview Design

Creating a preview is the first step in using the Light-O-Rama S5 Sequencer. No sequencing can be done
without a preview. While it is possible to create a preview outside of the Preview Design window (via
import, or using the Quick Preview feature when creating a new sequence), any editing of a preview must
be done in Preview Design.

A preview defines the lighting elements in your display and how they are arranged. It allows your
sequences to be simulated during playback. A preview can be a quick rough sketch, or a detailed, highly
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realistic depiction of your display. It is up to you to decide how much effort you want to put in to it. In any
case, the preview must accurately define every channel that will be controlled by your sequences.

You can access the Preview Design window from the Previews Window or by clicking the preview name
on the sequence toolbar.

Props and Groups

The display elements in a preview are referred to as 'props'’. You must add a prop to the preview for every
display element that you want to control. A prop can be as simple as a single channel string of
traditional lights, or as complex as a big pixel tree or matrix. When you create a prop, you define the
type and color of lights that it uses, its shape, and the channels assigned to it. If one of the built-in
shapes doesn't meet your needs, then you can define a custom shape.

Y
Lo

A sample of some of the shapes that come built-in to S5
Props can be grouped together.
¢ You might do this so that the props appear together in the sequence grid.

¢ You might also create a group so that you can apply an effect to the group instead of individual
props. This enables things like sweeping a color across your entire display.

One Preview > Multiple Sequences

One preview can be associated with multiple sequences. Update the preview once, and the next time
you open any sequence associated with that preview, the update will automatically be applied.

Preview: Christmas 2018

Prop: Window Prop: Door Prop: Eaves Prop: Gutter
Channels Channels Channels Channels
Unit 01 Circuit 1 Unit 01 Circuit 2 Unit 01 Circuit 3 Unit 01 Circuit 4
Sequence: Sequence: Sequence:

Jingle Bells Let It Snow Joy to the World
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Using Preview Design

Preview Design - LOR Store Sequences-House-CB8P32 (2020-07) O X
Cancel ) Name |LORStoreSequences-House-C68P32(2020-0?} | Revision
Design |74 Channel Conflicts & Bulk Changes |4 Other Warnings String Summary  Statistics

071.01-Roof & A | P Add |+ | Edit - Format ~ . [ | o & B & o
01.02-Roof B

01.03-Reof C

01.04-Roof D

01.05-Window A
01.06-Window B
01.07-Window C

01.08-Window D

01.09-Column A

01.10-Column B

01.11-Column C i

01.12-Column D u n
OI.I-ON . '

01.13-Bush A
01.14-Bush B
01.15-Bush C v

- '.'..O‘o.o-.-

Bulb Scale  Background

Shape Square ~
Size '

1

Transparency '
0%

< >

The Preview Design window showing asample preview
At the top of the Preview Design window are:

e Save button - saves any changes to the preview and closes the window. This also increments the
revision number by 1.

e Cancel button - closes the window without saving any changes.

e Help button - opens the help file to the Preview Design topic.

e The Preview Name field. The name must be unique -- having 2 previews with the same name is
not allowed. If a preview is already associated with one or more sequences and you change the
preview name, the association with sequences will be preserved. See the topic on Naming
Strateqies for a deeper discussion of how to name previews.

e The Revision Number field. The number is maintained by the system and incremented by 1 every
time the preview is saved. You cannot change it manually.

Below this there are 5 tabs:

¢ Design - this is where you will do most of your work, creating props and arranging them so that
they match your display.

e Channel Conflicts & Bulk Changes - this tab will show a green check mark if everything is OK, or a
warning sign if there are problems with the channels you have assigned to your props. The tab
allows you to quickly identify the issues and resolve them. It can also be used to make changes
that affect multiple props, such as when you change a controller's unit id (e.g. 01 to 11) or network
(e.g. Regular to Aux A).
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e Other Warnings - this tab will show a green check mark if everything is OK, or a warning sign if
there are problems with prop definitions (e.g. a sub-prop is not assigned the same channels as its
master prop).

e String Summary - this tab displays a table of all strings defined by every prop in the preview. If you
want a print-out of your props and channel assignments to carry with you as you wire up your
display, you can use this table, copy it to the clipboard, and paste it into any spreadsheet
program. In the spreadsheet you can sort and filter the data, add and remove columns, and print it
out.

¢ Statistics - this tab displays statistics about the preview: nhumber of props, groups, pixels,
channels, etc.

5.2.4.1 Design Tab

The Design tab of the Preview Design window is where you create props (display elements) and arrange
them so that they match your display.

This is the first of 5 tabs on the Preview Design window. The others are:

Channel Conflicts & Bulk Changes
Other Warnings
String Summary

e Statistics
Preview Design a ®
Cancel W, Name ‘ Revision D
Design Channel Conflicts & Bulk Changes Other Warnings  String Summary  Statistics

2p Add |~/ | Edit ~ Format - [ ] €, i &~

Prop and Group List

Bub  Scale  Background Design Canvas
Shape Square
Size '

1

Transparency '
0%
0%

The Design Tab
The Design Tab is divided into 2 main sections:

On the left side:
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o At the top is the list of props and groups that are in the preview.

¢ The bulb tab allows you to control the shape, size, and transparency of the bulbs that make up a
prop.

e There are several ways to modify the size of a prop; the scale tab is one of those ways.

e The background tab allows you to choose a background image for your display.

On the right side:

¢ At the top is a toolbar that allows you to add and modify elements of your display.
¢ Below the toolbar is the visual design canvas - a representation of your display that will be used to
simulate your lights during sequence playback.

Selecting ltems

Items in the Prop and Group List can be selected by clicking on them. The prop or group that is
selected will then be displayed in yellow on the design canvas to the right. You can also do the
reverse: you can click on a prop on the design canvas and its name will be highlighted in the Prop

and Group List.

You can also select more than one item at a time. This is often useful for moving several props at the
same time or for creating groups. In the Prop and Group List, Ctrl-click on an item to select it in
addition to items already selected. Use Shift-click to select a range of items in the list. When
selecting items using the mouse on the design canvas, hold the Shift button down on the keyboard
while clicking the mouse and that prop will be added to the ones already selected.

In the picture below, the “Gutter” prop has been selected — it is highlighted in the Prop and Group
List and displayed in yellow on the design canvas.

Preview Design - Simple House O X

Save Cancel / Mame |Simple House |
&y

Design Channel Conflicts & Bulk Changes Other Warnings  String Summary  Statistics
Door Add | =" | Edit - Format - [ ] @, B -

Eaves

Window

Bulb Scale  Background

Shape Square ~
Size '

Transparency '
0%
0%
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The following keyboard shortcuts can be used on the design tab:

279

Shortcut Action
Delete Deletes the selected prop or group. If you delete a prop by mistake,
just click the Undo button (or use the Ctrl-Z shortcut).

Ctrl ||A

Selects all props and groups

T

<4

Mowes the selected props by a small amount

Ctrl

Makes the selected items larger. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

Ctrl

Makes the selected items smaller. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

Ctrl

Rotates the selected props counterclockwise

Ctrl

Rotates the selected props clockwise

Ctrl

Control-zero resets prop rotation to its default value (fixed prop
shapes only)

Ctrl

undo the last operation

<J[INJle)LILTIE=)L

Ctrl

redo the last operation

Prop and Group List

The Prop and Group List is displayed on the left side of the design tab. Every prop and group in your
preview will be listed here in alphabetical order. To help distinguish groups from props, groups will be

listed with blue text. In the picture below, "01.Group 1 (roof)", "01.Group 2 (windows)", "01.Group 3
(columns)”, and "01.Group 4 (bushes)" are groups, and the others are props. Props "02-Minitree A"
through "02-Minitree D" are selected.

To select an item in the list, just click on it with the left mouse button. You can use shift-click to
extend the selection, and ctrl-click to select additional items. More information is available in the

Selecting ltems section.
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01.14-Bush B
01.15-Bush €
01.16-Bush D
01.Group 1 {roof)
01.Group 2 (windows)
01.Group 3 (columns)
01.Group 4 (bushes)

03.01-Arch &
03.08-Arch B
04.01-Megatree &
04.09-Megatree B

The Prop and Group List

After selecting 1 or more items in the list, you can use the toolbar to select actions to perform, or
you can right-click on them to view a menu that has many of the same options as the Edit menu.

01.01-Roof A
01.02-Roof B
01.03-Roof C
01.04-Roof D
01.06-W Modify
oo
ol09-cg Dot
01.10-Co Create Group
01.11-Ce Layout View
01.12-Cq
01.13-BL Export Selected ltems
01.14-Bush B
01.15-Bush C
The Prop and Group List with right-click menu
displayed
Bulb Tab
Bulb  Scale  Background
shape Square w
Size '
2
Transparency '
0%
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After selecting 1 or more props, you can change the bulb settings for the selected props. The default
bulb shape is square, which uses the least amount of computer resources; however there are a
variety of shapes available.

There are some specialized bulb shapes:

e Strobe 1 - a strobe that flashes about once per second

e Strobe 3 - a strobe that flashes about 3 times per second

¢ Snowfall Tube - simulates single color snowfall tubes (also known has drip tubes and meteor
tubes).

¢ Flood - use for flood lights, single color or RGB.

Making the bulb size larger can make the prop easier to see on the computer screen. For strobes
and floods you will almost always want to make the bulb size larger than the default in order to make
them look realistic.

For most props, you will want to leave the bulb transparency setting at 0%. For floods, you may
want something more transparent (> 0%). Adjust the transparency slider until you achieve the
desired appearance.

An example of strobes on a megatree along with the associated prop definition:

Prop Definition

Save Cancel Mame Mea Strobes
rLights rShape
Dimming Curve | StrobeCurve - Lines-Connected w
# of segments 2 =

Traditional
RGE Preview # of lights |8

Type: | Multicolor string 1 ch w total

Select Caolor(s) Crder

White White Starting n/a
Location

[ Green

Il Elue Q’
[] orange
[ vellow

(] Warm White e

Ll Custom

Scale Tab
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| Background
W' | W | ChangeHeight

W' | W | Change Width

Change Height

W | W | .ndwidth

After selecting one or more props or groups, you can use the buttons on this tab to increase or
decrease the size of the selected items. This can be useful for fine-tuning the size of an item. It also
the best way to resize freeform prop shapes, as they do not display resize handles on the design
canvas.

Click a button once to perform a small change, or hold the button down to continuously scale the
selected items.

The "Change height and width" buttons have the following keyboard shortcuts:

Shortcut Action

Ctl"l T Makes the selected items larger. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

Ctl"l l Makes the selected items smaller. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

Background Tab

Bulb  Scale ?Eackgraundé

Set Image Clear Image

[] Save image with preview

Using a background image (such as a picture of your house) can be a great help in creating a
realistic preview. Click the “Set Image” button to choose the image file. Clicking the “Clear Image”
button will remove the image from the preview. You can adjust the brightness of the image from the
toolbar.

Save Image with Preview
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If this box is unchecked, then the image file will remain separate from your preview, and the
sequences that use the preview.

If this box is checked, then the image file is stored with the preview. If you export such a preview and
send the export file (LORPREV extension) to someone else, the background image will be included.
The background image will also be included if you send a sequence to another user and the
sequence uses such a preview.

Toolbar

2hAdd | =/ | Edit + Format = | & ¢ | @ | o (& 9 @ & o

The toolbar consists of (in order):

Add button

Draw string button

Edit menu

Format menu

Undo and Redo buttons

Background image brightness control (this will be disabled if a background image hasn't been
assigned to the preview)

Zoom control

e Capture the design canvas as a picture file button

o Options menu: * icon

Toolbar - Add

Click the Add button to add Props and Groups to your preview. After saving the new prop or group, it
will be added to the Prop and Group List and displayed on the design canvas on the right.
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Add MNew Item

Select the method for creating the new item

Create a new GROUP from existing props anu:l gru:uups

Add a Light-O-Rama device (AC controller, Cosmic, Pixie, Pixcon, Flood, etc)
Add a DMX device

Add an RGE device (generic)

Import an 55 prop file

Import a Visualizer file (fixture, prop, or complete visualization)
Import an xLights model file (xmodel)

Light-0O-Rarma Props (onling)

SuperStar (online)

Boscoyo Studie (onling)

WowlLights Productiens (onling)

Gilbert Engineering USA (onling)

Generic Props (onling)

Cancel

Create anew prop using one of the built-in shapes, or define a cus

This option opens the Prop Definition window, allowing you to create a prop from s

tom shape

cratch. The wide

variety of built-in shapes makes it easy to create many common display elements.

Some of the shapes that can be selected in the Prop Def|n|t|on wmdow

Create a new group from existing props and groups

This option opens the Group Definition window, allowing to create a new group. Any props and
groups that are currently selected on the Design tab will be preselected on the Group Definition
you are in the

window as members of new group. Of course you can change the selections once
Group Definition window.

Add a Light-O-Rama device (AC controller, Cosmic, Pixie, Pixcon, Flood, etc)

This option will create props according to the Light-O-Rama controller and unit id you specify. It is a
good way to quickly create props that have accurate channel assignments. Flood lights created with
this option will look realistic, but you may need to change the shape for props created for other

controllers if you are going for realism in your preview.
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Add Light-0-Rama Device *

Marme: |Unit

Include base unit II¥ in channel names

Device: | LORSCTE (16 Channel) e

1-AC Controllers
Add2 | OR/CTR (4 Channel)

LOR/CT LOR/CTE ( & Channel)
Metwar| LORSCTE (32 Channel)
2-RGB Pixel Controllers
Unit ID:  cCC-ll/Pixie 2
Cosmic Color Ribbon/Bulb
Color | pixConl6

Pixie 4

Pixie 2

Pixie 16
3-Other

CF300 Flood

CMB16D

CMB24D

D32

i 1000

Servo Dog

QK Cancel

Add a DMX device

This option can be used to create a generic DMX device that uses regular (single) or RGB channels.
It is a quick way to create props that have accurate channel assignments; but if you are going for
realism, use "Create a new prop" or one of the "online" options instead.

Add an RGB device (generic)

This option can be used to create RGB floods and "dumb RGB" props attached to Light-O-Rama
controllers. Each prop will be created as single RGB bulb with a star shape. It is a good way to
quickly create RGB props that have accurate channel assignments; but if you are going for realism,
use "Create a new prop" or one of the "online" options instead.

Import an S5 prop file
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This option loads props and groups into your preview from a file that had previously been exported.
These files have an “.Ipeprop” extension. You should review the channel assignments on any
imported props to make sure they match your controllers — this can be done by double-clicking on
the name of an imported prop to open the Prop Definition window. By default, an imported prop will
be assigned the name that it had when it was exported. However, if that name is already being used
in the preview, then a numeric suffix will be added to the name in order to make it unique.

Import a Visualizer file (fixture, prop, or complete visualization)

This option imports a file created with the S4 Visualizer. You will be prompted to select a Visualizer
fixture file (LFF extension), prop file (.LPF extension), or complete visualization file (.LEE
extension). All of the fixtures and props defined in the selected file will then be loaded into the
preview. Visualizer fixtures will become S5 props. Visualizer props will become S5 groups. You
should review the channel assignments on any imported props to make sure they match your
controllers.

Import an xLights model file (xmodel)

This option allows you to import model files created by the xLights program. This feature only
supports models that use the Custom and Star shapes. Most commercial props are modeled using
the Custom shape.

Light-O-Rama props (online)

This option will open the Online Prop Import screen, allowing you to import props for items sold in
the Light-O-Rama store, such as pixel trees and singing faces. It is recommended that you have
internet access when using this option so that you see the latest available content (content will likely
change over time). You should review the channel assignments on any imported props to make sure
they match your controllers.

SuperStar (online)

This option will open the Online Prop Import screen, allowing you to import props that match
sequences sold by SuperStar Lights. It is recommended that you have internet access when using
this option so that you see the latest available content (content will likely change over time). You
should review the channel assignments on any imported props to make sure they match your
controllers.

Boscoyo Studio (online)

This option will open the Online Prop Import screen, allowing you to import props for items sold by
Boscoyo Studio. You will need internet access when using this option so that you can retrieve the
content. You should review the channel assignments on any imported props to make sure they
match your controllers.

Prop definitions imported from this link were created by Boscoyo Studio. Light-O-Rama provides a
connection to the data in order to make our software easier to use, but is not responsible for the
content.

WowLights Productions (online)
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This option will open the Online Prop Import screen, allowing you to import props for items sold by
Wowlights Productions. You will need internet access when using this option so that you can
retrieve the content. You should review the channel assignments on any imported props to make
sure they match your controllers.

Prop definitions imported from this link were created by WowlLights Productions. Light-O-Rama
provides a connection to the data in order to make our software easier to use, but is not responsible
for the content.

Generic Props (online)

This option will open the Online Prop Import screen, allowing you to import props for some
commonly used lights. It is recommended that you have internet access when using this option so
that you see the latest available content (content will likely change over time). You should review the
channel assignments on any imported props to make sure they match your controllers.

Toolbar - Draw String

s clicking this icon allows you to draw a light string directly on the design canvas.

When you click the icon, the cursor will change to the edit cursor when moved over the design
canvas. Click on the design canvas to start drawing your string. A single click of the left mouse
button will insert a node (vertex) into the line and allow you to continue drawing the next segment. To
stop drawing, double-click the left mouse button or use the ESC key. When you stop drawing, the
Prop Definition window will open so you can adjust the number of bulbs in the string and also assign
a channel.

Toolbar - Edit Menu

Edit | Format -

Export Selected ltems
Copy Prop to Advanced Shape
Delete Groups With Mo Members

Layout View

Wiring View

Most of the choices on the Edit menu are also available when you right-click on the Prop and Group
List and also when you right-click on the design canvas.

Modify
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You can double-click on an item’s name, or you can single-click on it and select “Modify” from the
Edit Menu. Either method will open the Prop Definition window if a prop is selected, or the Group
Definition window if a group is selected.

Copy

This command opens the Copy Prop Dialog, which is very helpful in creating a collection of props
that all look the same, such as a series of arches or mini-trees.

Delete

Use this command to delete the selected props and groups. You will be asked to confirm before the
delete actually takes place.

Export selected items

This command exports the selected props and groups to a file. You might do this so they can be
imported into another preview or so they can be shared with other users. You will be prompted for a
location to save the export file. Export files have the extension ".Ipeprop". To import props, see the
Add Item button.

Copy prop to advanced shape

This command is used to copy a pixel-based prop to a new prop with the same channel
assignments and pixel locations but with the Advanced shape. This allows you to presene the look
of the prop, but rearrange each pixel's virtual location in the effect buffer (as shown in the Layout
View).

Delete Groups With No Members
After making a lot of changes to your preview, you may end up with groups that no longer contain

any members. This function will open a window listing all such groups and allow you to delete them
with a single click. If you delete a group by mistake, you can always click the Undo button.
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Groups With Mo Members ot

Groups in the preview with no members

Checked itemns will be deleted. Uncheck any groups
you wish to keep.

Group 1
p
Group 2
p
Group 3
b1 p
Group 4
2]

Deleted Selected Groups Cancel

Layout View

Use this command open the Layout View window - a printable layout of the selected prop or group
with channel information for every string or pixel. It is very useful for pixel-based props because it
shows how the pixels are arranged when motion effects are applied. The layout view can be quite
large depending on the number of channels/pixels involved.

Wiring View
This command opens the Wiring View window. It displays how pixel-based props are wired together -

with every pixel labeled with its string and pixel number. This is particularly useful for props that have
a "custom" shape.

Toolbar - Format Menu

Format -] s« ¥ QW
| Align b2 Lefts
Make Same Size b | &  Centers
Horizontal Spacing * | 5| Rights
Vertical Spacing ] T Tops
Reotation 3 4 Middles
— d it  Bottoms

All items on the Format menu are also available on the Design Canvas's right-click menu.
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Align

If multiple props are selected, the items on this sub-menu allow you to align those props in various
ways.

Make same size

If multiple props are selected, the items on this sub-menu allow you to resize the selected items
such that they all have the same width, height, or both.

Horizontal spacing

If multiple props are selected, the items on this sub-menu allow you to make the horizontal spacing
between them equal, or to remove any space between them (so they abut one another).

Vertical spacing

If multiple props are selected, the items on this sub-menu allow you to make the vertical spacing
between them equal, or to remove any space between them (so they abut one another).

Rotation

After selecting 1 or more props, the actions listed under the “Rotation” menu allow you to rotate the
selected items back to their default orientation (O degrees), to 90 degrees right, or 90 degrees left.
Selected props and/or groups can be rotated to any angle by dragging the rotation handle that is
displayed when they are selected or using the keyboard shortcuts Ctrl-LeftArrow and Citrl-
RightArrow. Ctrl-0 (control key + zero key) is a shortcut for resetting rotation back to the default
orientation (0O degrees). Note that freeform prop shapes do not have a default orientation, so the
Rotation > 0 command has no effect on them.

Reset
After selecting 1 or more props, the actions listed under the “Reset” sub-menu allow you to reset the
selected items back to their default position (centered), or default size (half of the canvas size), or
both. Resetting the position is particularly useful because it is possible to drag items off the edge of

the design canvas. When this happens, select the prop from the Prop and Group List, then choose
Format > Reset > Position from the menu to make it visible again.

Toolbar - Undo/Redo

Prop adds, deletes, movement, scaling, and rotation can be undone and redone. Undo/redo does not
apply to modifying props or groups.

@ clicking this icon undoes the last operation, and has the keyboard shortcut Ctrl-Z.

[ clicking this icon reapplies an operation that was previously undone, and has the keyboard
shortcut Ctrl-Y.

Toolbar - Background Image Brightness
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. [ | o

If you have assigned a background image to your preview, you can use this slider to adjust the
brightness of the image. Move the Brightness slider to the left to dim the background image,
simulating the view of your display during nighttime. The buttons on the left and right will modify
brightness up or down one step at a time. Image brightness can also be changed from other areas of

the program.

Toolbar - Zoom

N @
You can zoom in on your props to make fine adjustments. The buttons on the left and right will zoom
in or out one step at a time. Or you can use the slider to quickly mowe to the desired zoom lewel. If

you are zoomed in, clicking on a prop in the Prop and Group List will cause the canvas to scroll so
the selected prop becomes \isible.

Toolbar - Capture Design As A Picture File

O] clicking this icon captures a snapshot of the design canvas and prompts you for a file name
where the image can be saved (PNG format).

Toolbar - Options Menu

" -

.
W

Mew prop defaults

Picel labels 2

E Mone

Picel numbers

Row / Column

Set l[abel colar

New prop defaults

This option allows you to set some defaults when the Prop Definition screen is used to create new
props.
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Preview Design Preferences >

Specify the defaults to be used when creating a new prop.

Device Type LOR e

Type of lights: Traditional (non-RGE) w

Custom Color for I:|

traditional lights:

QK Cancel

Preview Design Preferences

Pixel labels
This sub-menu controls how pixels are labeled on props that have a light type of "RGB Pixels."
Labels are only displayed when a prop is selected. The labels are small, so you will need to zoom in
to read them.

The sub-menu gives you 3 choices for pixel labels:

¢ None - don' display pixel labels.

Pixel labels set to: None

e Pixel numbers - displays a number which indicates the order in which the pixels are (or
should be) wired; however, it does not indicate which string the pixel is on.
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Pixel labels set to: Pixel Numbers

e Row / Column - pixels are labels using RC notation, where "R" precedes the row number,
and "C" precedes the column number. These numbers match the row and column numbers

displayed in RGB channel names for pixel-based props, and also on the Layout View.

Pixel labels set to: Row / Column

Set label color

This option allows you to change the color used to display pixel labels.

Design Canvas
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In the picture abowe, there is 1 blue string, 2 red strings, and 5 RGB arches. The second arch is
selected.

In the preview design window, traditional strings (incandescents, LEDs, strobes) are displayed with
the color of the string (e.g. a string of red LEDs will show as red). RGB pixels and dumb RGB strings
are displayed in white. Any string that has been selected, traditional or RGB, is shown in yellow.

The selected item is always shown in yellow and has 4 red scaling “handles” at the corners (lines
just have 2 handles) and a rotation handle to the right. You can select multiple props using Shift-
click on the design canvas, or Ctrl-click or Shift-click in the Prop and Group List. The selected
prop(s) can be dragged around the design canvas using the mouse. They can be resized by dragging
any one of the 4 red handles in the corners, or by using the Ctrl-UpArrow and Ctrl-DownArrow
keyboard shortcuts. You can rotate them by dragging the handle on the right side, by using the
Format > Rotation menu, or by using the Ctrl-LeftArrow and Ctrl-RightArrow keyboard shortcuts. If
you have multiple props selected, you can align them in many ways using the Eormat menu.

You can double-click on a prop to open its Prop Definition.

Any movement, scaling, or rotation action can be undone by clicking the undo button or using the
Ctrl-Z keyboard shortcut.

Right-Click Menu

Right-clicking on the design canvas opens the following menu:
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Add ltemn

Draw new string

Modify

Copy

Delete

Align *
Make Same Size 3
Horizontal Spacing *
Vertical Spacing 3
Rotation >
Reset »

Save as picture
Layout view

Wiring view

Export Selected ltems

ltems in the top section of the menu allow you to:

Add an item - this has the same effect as clicking the toolbar's Add ltem button.

Draw a new string - this has the same effect as clicking on the toolbar's Draw String button.
Madify the selected prop (hidden if no prop is selected)

Copy the selected prop (hidden if no prop is selected)

Delete the selected props (hidden if no prop is selected)

ltems in the middle section of the menu allow you to perform any of the operations available on the
toolbar's Eormat menu.

ltems in the bottom section of the menu allow you to:

Capture a snapshot of the design canvas and sawe it as a picture file - same as clicking on the
toolbar's E icon

Display the Layout View for the selected prop

Display the Wiring View for the selected prop

Export the selected props

Right-Click on Lines-Connected Vertex

Insert vertex

Delete vertex
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5.24.2

With these menu options, you can add and remowe line segments without opening the Prop

Definition window.

Channel Conflicts & Bulk Changes Tab

The Channel Conflicts & Bulk Changes tab of the Preview Design window has 2 functions:

1. It can be used to quickly identify and resolve props with conflicting channel assignments
2. It can be used change the channel assignments for multiple props at once (i.e. bulk change); for
example, moving multiple props from the Aux A network to the Aux B network, or from one DMX

universe to another.

The tab will show a green check mark if everything is OK, and a warning sign if there are channels
conflicts. A filtered list of props is displayed down the left side. Clicking on a prop will list its channel
assignments in the "Channels" area, where they can be changed. When clicking on a prop with a

channel conflict, the list of conflicts will be shown in the "Prop Warnings" area.

This is the second of 5 tabs on the Preview Design window. The others are:

¢ Design
Other Warnings

String Summary
Statistics

Preview Design - 0-Sample Props

O X

Save Cancel \Z) Mame |0-5ample Props

Revisicn

r Preview Props
Use this page to quickly resolve channel conflicts or to make large changes like
reassigning unit ids or DM universes. Props with channel conflicts will have a
warning icon next to their name. Click on a prop for more information and to
change its channel assignments.

Show: Props With Channel Conflicts = [] Select &ll Change ~
MName: >( Channel: X
Mame Start Channel
&Arch LOR-Regular-unit 01-circuit 1
&Candycane LOR-Regular-unit 01-circuit 1

Design & Channel CU”ﬂiCtS&BU'kChE”QESE "4 OtherWarnings String Summary Statistics

r Prop Warnings

rChannels

Undetermined

The Channel Conflicts & Bulk Changes tab

Sorting The List

© 2022 Light-O-Rama, Inc.



The Light-O-Rama Software Package 297

The list of props can be sorted by Name or Start Channel by clicking the column heading. Clicking the
column heading a second time will reverse the direction of the sort.
Filtering The List

There are 3 filters that can be applied to the list of props. By default, the list is filtered to show only
channel conflicts.

The "Show" Filter

Show: | Props With Channel Conflicts
All Props

Marl Props with Device Type: LOR

Props with Device Type: DMX

Props with Device Type: Undetermined
Text starts with

Text ends with

Text contains

Mame:

From this drop-down box you can choose to display:

All props in the preview

All props with channel conflicts

All props with device type "LOR" (as shown in the channel section of the Prop Definition window)

All props with device type "DMX'

All props with device type "Undetermined"

Text starts with -- when using the Prop Name or Channel filters, compare the entered text with the

start of the name or channel

e Text ends with -- when using the Prop Name or Channel filters, compare the entered text with the
end of the name or channel

e Text contains -- when using the Prop Name or Channel filters, select the prop if the entered text

appears anywhere within the name or channel. This is also the text comparison method used

when any of the first 5 drop-down options is selected.

Prop Name Filter

Type some text into the "Name" box to filter the list by prop name. In the example below, only props
with the word "star" in their name are shown. If the "Show" filter is set to "Text starts with" or "Text
ends with", then only that part of the prop name will be matched; otherwise any prop name that
contains the text that was entered will be matched.
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Show: | All Props

-

[] Select Al Change -

Mame: |star X Channel: X
Mame Start Channel
MEGA STAR DMX-131-channel 79
MIMI STAR 1 Dhx-131-channel 93
MIMI STAR 2 DMX-131-channel 34
MIMI STAR 3 DMx-131-channel 93
MIMI STAR 4 DMX-131-channel %6

Channel Filter

Type some text into the "Channel" box to filter the list by start channel. In the example below, only
LOR props with the word "aux b" in their channel name are shown. If the "Show" filter is set to "Text
starts with" or "Text ends with", then only that part of the channel name will be matched; otherwise

any channel name that contains the text that was entered will be matched.

Show: Pr:}ps with Device Type: LOR |v||:| Select All Change -

Mame: ?( Channel: auxb
Mame Start Channel
ribbons 1-8 LOR-Aux B-unit 01 -circuit 1

ribbons 3-16

Resolving Channel Conflicts

LOR-Aux B-unit 09-circuit 1
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Preview Design - 0-5ample Props [m] F.e

Save Canecel Mame |0-Sample Props

Design [\ Channel Conflicts & Bulk Changes B otherWamings String Summary  Statistics

r Preview Props r Prop Wamings
Lkse this page to quickly resoboe channel conflicts or to make large changes like LOR Regular Unit201 Circuit®1 is shared with Candycans
reassagning unit ids or DMVEC universes. Props with channel conflicts will have a
waming ican next to thewr name. Click on a prog for more information and to = - .
e Harmetse e iirTne) Brstomuriend =) 2. Conflict details shown here
Show:  Props With Channel Conflicts = [ Select Al Change ~
Name: | Channel: " r Channels
Hame Start Channed LOR w Max Cireuit |16 =
LOR-Regular-unit 01-circuit 1
&Candyﬂne LOR-Regular-unit 01-circuit 1 (®) Enter channel on first now, auta-nurmber the rest

() Enter a channel on every row
1. Click a row here aparate Uit # for each RGB strir

e a Start  End
i | Uit Corcuit  Circust

Reg... |~| o1 1 1 |Custom

3. Modify channel assignment here

Color

4, Save channel update

Steps for resolving a channel conflict

1. Click on a row with a & warning sign.

2. Note that conflict details shown in the "Prop Warnings" area. Multiple conflicts may be listed
here if multiple props all have the same channel assigned, or the prop uses multiple channels
and those channels conflict with other props.

3. Determine the new channel that should be assigned to this prop and make the changes in the
"Channels" area. You might find a quick review of the information shown on the String Summary
tab helpful in determining the correct channel. Alternatively, you could go back to the Design tab,
double click on the prop name, and change the channel information in the Prop Definition screen
(but that would take longer).

4. After changing the assigned channel, click the "Save Update" button to commit the change. If
you go back to step 1 without performing this step, your changes will be lost.

Making Bulk Changes

"Bulk changes" means that you want to modify the channels assignments of many props at once.
To do this, you first need to select all of the props that you are going to change. You could do this
by clicking on the first prop, then Ctrl-Clicking on all of the other props that you want to change.
Howe\er, it is often faster to use the Eilter Tools to narrow the list of props to just those that need to
change, then clicking the "Select All" check box to select them all.

After selecting the desired props, then you can select an action from the "Change" menu (these
actions can also be accessed by right-clicking on the selected props). From the Change menu you
can:
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Set the LOR Network
Set the LOR Unit ID

Delete Props

Show: All Props

Set the DMX Universe

Add L eading Zeros To Numbered Prop Names
Replace Text In Prop Names

Reorder Circuit/Channel Numbers

= [] Select All | Change ~ | |
Mame |arch X Channel:

MName
Arch 1-Lt
Arch 2
Arch 3
Arch 4
Arch 3
Arch &
Arch 7
Arch &
Arch 9-Rt

Reorder Circuit/Channel Numbers

Start Channel

DMX-
DMX-
DMX-
DMX-
DMX-
DMX-
DMX-
DMX-
DMX-

S-channel
S-channel
S-channel
S-channel
S-channel
S-channel
S-channel
S-channel

3-channel

Reorder Circuit/Channel Numbers
Set LOR MNetwork
&5 Set LOR Unit Id
52 Set DMX Universe .
7 Add Leading Zeros To Numbered Prop Mames
74 Replace Text In Prop Mames
7
Delete Props
21
24
4
7

The Change menu

Selecting "Reorder Circuit/Channel Numbers" from the Change menu (or right-clicking on the prop
list and selecting "Reorder Circuit/Channel Numbers") will open a dialog that will allow you to
consecutively renumber the LOR circuits (or DMX channels) on the selected props. At the same
time, you can change the selected props from LOR to DMX or vice versa.

When you renumber, the number of channels used by each prop is taken into account. For example,
if you are renumbering 3 props and props 1 and 3 each require 1 channel, but the second prop
requires 6 channels; then if you renumber starting at channel 9, the new channel numbers will be:

e First prop - channel 9

e Second prop - channels 10-15

e Third prop - channel 16
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Reorder Circuit/Channel Mumbers ot

Use this function to consecutively renumber strings across multiple props. At the same time,
you can change props from LOR to DMK or vice versa,

Undetermined

Regular e
Start Unit Id 1 =
Start Circuit 1 -
Circuits per UnitId 312 =

[] Separate unit id for each pixel string

Props that will be renumbered. Renumbering will be done from top to bottom. You can drag
props up or down to change the order.

Renumber Channels Reverse Order

Mame Start Channel &
Arch 1-Lt LOR-Regular-unit 01-circuit 1

Arch 2 LOR-Regular-unit 01-circuit 10

Arch 3 LOR-Regular-unit 01-circuit 11

Arch 4 LOR-Regular-unit 01-circuit 12

Arch 5 LOR-Regular-unit 01-circuit 13

Arch & LOR-Regular-unit 01-circuit 14

Arch 7 LOR-Regular-unit 01-circuit 7

Arch 2 LOR-Regular-unit 01-circuit 2

Arch 9-Rt LOR-Reqular-unit 01-circuit 9 e

Save Changes Cancel

In this example, the wiring order of the arches is about to be made consecutive

© 2022 Light-O-Rama, Inc.



302

Light-O-Rama v6.1.0

Reorder Circuit/Channel Mumbers

Undetermined

Regular
Start Unit Id 1
Start Circuit 1

Circuits per UnitId 312

[] Separate unit id for each pixel string

Renumber Channels Reverse Order

Use this function to consecutively renumber strings across multiple props. At the same time,
you can change props from LOR to DMK or vice versa,

Props that will be renumbered. Renumbering will be done from top to bottom. You can drag
props up or down to change the order.

et

Mame

Arch 1-Lt
Arch 2
Arch 3
Arch 4
Arch 5
Arch 6
Arch 7
Arch 8
Arch 9-Rt

Start Channel

LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit
LOR-Regular-unit 01-circuit

L= = = e = R

Save Changes

Cancel

After pressing the Renumber Channels button

Set the LOR Network

The selected props will be moved to the LOR network you specify. For example, you could use this
function to mowve props from the Regular network to Aux A.

Set LOR Metwork

Mew LOR network:

Regular -

OK

Cancel

pod
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Setthe LOR Unit ID

The selected props will be moved to the LOR unit id you specify. For example, you could use this
function to mowve props from unit 10 to unit 11.

Set LOR Unit [D

Mew LOR Unit 1D (01 to FO):

r

-

oK

Cancel

Pt

Set the DMX Universe

The selected props will be moved to the DMX universe you specify. For example, you could use this
function to mowve props from Universe 2 to Universe 12.

Set DMX Universe

Mew DMK universe number (1-999):

r

-

oK

Cancel

Pt

Add Leading Zeros To Numbered Prop Names

Any selected props that have a number in their name will have leading zeros added to the number.
This can aid in sorting the props in the desired order on the sequence grid. For example, here are 12
arches sorted alphabetically -- the same order they would be displayed by default in the sequence

grid.
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Show: All Props = [] Select Al Change -
Mame: &Arch }( Channel: )(
Marne Start Channel

Arch 10 LOR-Regular-unit 01-circuit 10
Arch 11 LOR-Regular-unit 07-circuit 11
Arch 12-Right LOR-Regular-unit 01-circuit 12
Arch 1-Left LOR-Regular-unit 01-circuit 1
Arch 2 LOR-Regular-unit 01-circuit 2
Arch 3 LOR-Regular-unit 01-circuit 3
Arch 4 LOR-Regular-unit 01-circuit 4
Arch 5 LOR-Regular-unit 01-circuit 5
Arch & LOR-Regular-unit 01-circuit &
Arch 7 LOR-Regular-unit 01-circuit 7
Arch 8 LOR-Regular-unit 01-circuit &
Arch 9@ LOR-Regular-unit 01-circuit @

Props not listed in the desired order

Now click the "Select All" box, then select Change > Add Leading Zeros To Numbered Prop Names.

You will be prompted for the number format to be used:

Add Leading Zeros To Numbered Prop Ma... X

Mew number style:

01 o

001 Cancel
000

Choose number style

After clicking the OK button, the props now sort in the desired order:
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Show: All Props i Change -
Mame: &Arch )( Channel: )(
Marne Start Channel

Arch 01-Left LOR-Regular-unit 01-circuit 1
Arch 02 LOR-Regular-unit 01-circuit 2
Arch 03 LOR-Regular-unit 01-circuit 3
Arch (4 LOR-Regular-unit 01-circuit 4
Arch 03 LOR-Regular-un